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This document is intended for the MY9 – MY12 – MY15 – MY19 running the TPSys software version 2.6.

A standard system and available options are covered by this document. Depending on your system configuration you may lack some 
of the features mentioned in the document.

Disclaimer
Hardware and software mentioned in this document are subjected to continuous development and improvement. Consequently, 
there may be minor discrepancies between the information in the document and the performance or design of the product. 
Specifications, dimensions and other statements mentioned in this document are subject to changes without prior notice.

Federal Communications Commission (FCC)
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own 
expense.

Do not start, operate or service the 
machine until you have read and 
understood the safety chapter.

MYDATA and its suppliers shall not be liable for any damages related to this software or hardware, or for any other damages whatsoever caused by the use of or inability 
to use any MYDATA product. This is applicable even if MYDATA has been advised of the damage risk. Under any circumstances, MYDATA’s entire liability shall be 

limited to replace such defective software or hardware that was originally purchased from MYDATA.

JetPrint, MYPlan, SYS2.9, TEX, TMFlex, TRAYWagon Magazine, TUBEFork, and YWagon are trademarks of MYDATA automation AB. TPSys, Agilis, HYDRA 
SpeedMount, MYLink, and TM8 are registered trademarks of MYDATA automation AB. The MY... and TP... machine names are either trademarks or registered 

trademarks of MYDATA automation AB. DOS is a trademark of Microsoft Corporation. Microsoft, Microsoft Windows and Microsoft Access are registered trademarks 
of Microsoft Corporation. Other trademarks mentioned in this document are trademarks or registered trademarks of their respective owners.

MYDATA automation AB, Box 20155, S-161 02 Bromma, Sweden.

Phone +46 8 475 55 00 – Fax +46 8 475 55 01 – Internet www.mydata.com

This document or parts of it may not be reproduced without a written permission of MYDATA automation AB. 
Infringements will be prosecuted. All rights reserved.

Copyright © MYDATA automation AB, Sweden, 1990–2008.
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Text Conventions
This document uses text conventions to present information in various 
situations. This is explained below.

Danger, Warning, Caution, and Note

In this document a particular text layout is used to make danger, warning, and 
caution information evident. A triangular icon identifies the type of risk and 
the text describes the risk.

Danger, warning, and caution information must be followed.

Assisting information, notes, have the same layout but never triangular icons.

Danger

 DANGER! Danger means a potentially dangerous situation that can cause 
death or severe bodily injury. The icon identifies the type of risk.

Warning

 WARNING! Warning means a potentially dangerous situation that can cause 
bodily injury or considerable damage to the system or equipment. The icon 
identifies the type of risk.

Caution

 CAUTION! Caution means that the system or equipment can be damaged or 
data be lost. To distinguish caution information from warning and danger 
information, this icon is always an empty triangle.

Note, example 1

 A note contains any type of assisting information.

Note, example 2

 One type of assisting information is tips, which normally have this icon.
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Italic Font

Italic font is used for software screen text (for example Parameter 1), names 
(for example Spare Parts Catalog), and for warning text (described in the 
previous section).

Bold Font

Bold font is used for particular important words (for example This must not 
be done in reverse order).

Menu Selections

When describing software handling, menu selections are described in the 
following format:

File > Page Setup > Paper Size > Portrait > OK

This example describes to open the File menu and select the Page Setup, 
Paper Size, and Portrait options, and finally click the OK button.
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Lists

Lists of items, points to consider, or procedures that have no relative order 
appear in bulleted or hyphenated format like this:

• Item 1.

• Item 2.

or

– Item 1.

– Item 2.

Procedures that must be performed in a specific order appear in numbered lists 
like this:

1. Perform this step first.

2. Perform this step second.

Icons

Throughout the manual the icons are used to draw your attention to, or 
complement, the information.

Navigation

These icons will help you navigate on the screen when TPSys windows are 
described. They point to the area in the window that the information is 
referring to.

Camera view

This icon show that you are working in a camera view.

TPSys web interface

This icon indicates that you can also use is the TPSys web interface.

Barcode scan

This indicates that you can use a barcode scanner.
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1. Safety
Before starting the machine, it is necessary that the operator, foreman and any 
other personnel involved in machine operation, maintenance or service 
understand and follow these points:

• This machine is designed to pick components from their packaging and 
place them onto printed circuit boards, and to apply glue. The machine must 
be used exclusively for these two purposes and nothing else.

• The machine must be operated by qualified personnel only. Qualified 
personnel should meet the following qualifications:

– Be above 18 years of age.

– Have normal depth perception, field of vision, reaction time, manual 
dexterity, coordination, and no tendency to dizziness.

– Completed operators training.

• All personnel involved in machine operation must understand the use of the 
emergency stop buttons and how to manually move machine elements in 
case of emergency. See the Emergency Stop Buttons and Emergency 
Movement of Machine Elements sections in this chapter.

• Anyone operating this machine must obey all warning signs. See the 
Warning Signs section in this chapter.

• At least one manual that describes the warning signs of the particular 
machine type must always be kept, for instance if the machine is upgraded 
with a later TPSys version.

• Apart from the daily maintenance described in the operator’s manual, the 
machine is to be serviced by authorized maintenance engineers only.

• Excess component tape from tape magazines shall be cut from the front of 
the machine when it is not in operation.

• When inserting or removing tools to or from the tool bank, the emergency 
stop button shall be pressed down.

• The emergency stop button shall be pressed down when a tool or component 
is manually inserted or removed from the X wagon of the machine.

• If there is a risk that any unauthorized personnel might alter the system 
settings and thus the behavior of the machine, then the logon facility for 
individual access rights has to be used.

• Ensure that all covers and shields are intact, mounted and closed while the 
machine is in operation.

• Do not disable or disengage any safety switch or sensor.

• Do not configure or modify MYDATA machines or devices without 
consulting MYDATA. The machines, devices or the interfaces between 
them might become unsafe.

• Do not use chemicals or other substances that may have any influence on 
the operator or other personnel involved in the machine operation.
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Emergency Stop Buttons

All MYDATA placement machines have emergency stop buttons that are red 
and stop all machine movements immediately when pressed down.

All MY9 – MY19 have two emergency stop buttons located at the front of the 
machine frame. There is also a stop button located by the trackball. These 
emergency stop buttons are released by being turned clockwise.

 WARNING! An emergency stop button must always be pressed down when 
hands, fingers, tools or other objects are within a shielded area or in the risk 
area of movable machine elements such as Y wagon or Tray Wagon Magazine.

Emergency stop buttons on all MYDATA optional devices, such as TEX Tray 
Exchanger and conveyor systems, have the same function, that is to switch all 
motors off and release movable machine elements.

 Activating a stop system in an optional device, for instance opening a TEX 
Tray Exchanger door, stops only the optional device. The placement machine 
is not stopped by such an action.

Restart

To restart a machine after an emergency stop button has been released, enter a 
command on the keyboard.
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Emergency Movement of Machine Elements

On the MY machines, the X wagon, Y wagon, and Tray Wagon can be moved 
manually after pressing both the emergency stop buttons down, provided that 
the power is on.

If an accident has occurred and an emergency movement of a machine element 
is required, use the following procedure:

Learn this by heart!

Warning Signs

The warning signs on the machine must be observed as this machine contains 
fast moving parts and high voltage.

The machine has warning signs placed as shown on the following pages. The 
figure numerals refer to the following descriptions.

Note that at least one manual that describes the warning signs of the particular 
machine type must always be kept, for instance if the machine is upgraded 
with a later TPSys version.

Optional devices have the warning signs shown in their manuals except for the 
TEX unit which has the warning signs detailed in this chapter.

All signs must be kept clean and readable.

1. Press down both emergency stop buttons.

2. Leave the power on.

3. Move the machine element away by hand.
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MY9 and MY12 Warning Signs

MY9 and MY12 have the same set of warning signs. Figure 1-1 shows the 
MY12 machine.

Number and position of each sign type is described in the following text. If a 
sign is missing, it must be replaced immediately.

Figure 1-1.  MY9 and MY12 warning signs.
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MY15 and MY19 Warning Signs

MY15 and MY19 have the same set of warning signs. Figure 1-2 shows the 
MY15 machine.

Number and position of each sign type is described in the following text. If a 
sign is missing, it must be replaced immediately.

Figure 1-2.  MY15 and MY19 warning signs.
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Sign 1 warns of fast machine movements. Ensure that all covers and shields 
are intact, mounted and closed while the machine is in operation. Do not 
disable or disengage any safety switch or sensor.

The figures show signs according to:

– European and Canadian standards (1).

– US standards (2).

This sign is applied as follows:

MY9, MY12

– 2 signs on the glass shield.

MY15, MY19

– 4 signs on the glass shield.

1 1 2
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Sign 2 warns of electric shock. Units, on which this sign is placed, contain 
dangerous voltage levels. Power must be switched off before opening the unit. 
Only authorized service personnel are allowed to operate the machine when 
such a unit is open. Hazardous voltage is present with machine power off.

The figures show signs according to:

– European and Canadian standards (1).

– US standards (2).

This sign is applied as follows:

– 1 sign at the mains switch.

– 1 sign on the power supply unit at the rear of the machine.

 DANGER! Always lock out and tag the main switch before opening the hoods 
and commencing any servicing within the machine.

Sign 3 alerts that only MYDATA approved equipment is allowed to be 
connected to the power supply unit outlet.

This sign is applied as follows:

– 1 sign on the power supply unit at the rear of the machine.

2

HAZARDOUS
VOLTAGE.
Disconnect power
before servicing.

1 2

3
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Fast Horizontal Movements

This sign warns of fast horizontal movements. The sign is located on optional 
Tray Wagon Magazines (TWM) and it is applied as follows.

– Two signs on the TWM.

The figures show signs according to:

– European and Canadian standards (1).

– US standards (2).

Figure 1-3.  Signs on the TWM.

1 2
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Type Plate

The type plate shows the name and address of the manufacturer, the machine 
type and serial number, and manufacturing year and country. An example of a 
type plate is shown below.

On the MY machines, the type plate is found on the rightmost machine stand 
(see '4' in Figure 1-1).

Figure 1-4.  Machine type plate.

MYDATA automation AB
Adolfsbergsvägen 11
S-168 66 Bromma

Type:
Serial no:
Date:
Voltage

Power:

Made in Sweden

MY19
19036
1999-06-16
3 x 208V / 120V AC
+/- 10%
50/60Hz
3 x 2.2 kVA
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TEX Tray Exchanger

Number and position of each sign type is described in the following text. If a 
sign is missing, it must be replaced immediately. Part numbers are printed on 
the signs, but can also be read from the following description.

Figure 1-5.  TEX Tray Exchanger.

1

2

2

3
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TEX Warning Signs

The warning signs are located as shown in Figure 1-5.

Sign 1 warns of fast machine movements. Ensure that all covers and shields 
are intact, mounted and closed while the machine is in operation. Do not 
disable or disengage any safety switch or sensor.

The figures show signs according to:

– European standards (1).

– US and Canadian standards (2).

Two warning signs are applied on the safety hoods as shown in Figure 1-5.

Sign 2 warns of electric shock. Units, on which this sign is placed, contain 
dangerous voltage levels. Power must be switched off before opening the unit. 
Only authorized service personnel are allowed to operate the machine when 
such a unit is open. Hazardous voltage is present with machine power off.

The figures show signs according to:

– European and Canadian standards (1).

– US standards (2).

Two warning signs are applied as shown in Figure 1-5.

Sign 3 (D-024-0345) states the laser classification for TEX units equipped 
with laser barcode scanner. One certification sign is applied as shown in 
Figure 1-5.

1 1 2

2 1 2

3
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TEX Emergency Stop

There are safety switches at the two hoods and at the door. When a switch is 
activated all movements in TEX are stopped immediately. The placement 
machine is not affected by these switches.

When an emergency stop button on the placement machine is pressed down, 
the TEX is also stopped.

TEX can thus be stopped in four different ways:

– The door is opened.

– The front cover is opened.

– The rear cover is opened.

– An emergency stop button on the placement machine is pressed down.
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Warnings in the Manual

 Throughout the manual this symbol is used to call your attention to commands 
that starts machine movements. The symbol refers to the warning signs, which 
must be obeyed to eliminate the risk of injury. If there are instructions 
accompanying this symbol, they must be followed.

Also, to avoid damage, this symbol means that the operator must be observant 
of the following:

Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas, and that the standard tool head and the HYDRA tools are in their upper 
positions.
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Noise

For all MY machines, the equivalent continuous sound pressure level is 
measured in accordance with EU directive 98/37/EC to be less than 70 dB(A).

Material Safety Data Sheets
The machine is shipped with various types of grease and oil. Below are 
references to descriptions of chemical composition and toxicity (Material 
Safety Data Sheets, shortened to MSDS) of these products.

If you have problems accessing the web sites referenced below, contact 
MYDATA support.

Oils

HYDRAULIC OIL, part number L-012-0122 (Shell Tellus Oil 46)

MSDS is found at http://www.epc.shell.com, search for Shell Tellus 46.

Greases

GREASE PASTE OKS 270, part number K-013-0014

MSDS is found at http://www.mydata.com, document number P-040-
0137-EN. A logon user name and password may be required.

GREASE TUBE RETINAX EP2, part number K-015-0091

MSDS is found at http://www.epc.shell.com, search for Retinax.

MULTEMP LRL No. 3, U-015-0014

MSDS is found at http://www.mydata.com, document number P-040-
0139-EN. A logon user name and password may be required.

This grease can also be called 'NSK No.1', on some grease tubes.

GLEITMO 585 K

Request MSDS at http://www.fuchs-lubritech.com/cms, search for 
Gleitmo 585 K and select "Product information".

GREASE PARALIQ GA 351, 25G, K-012-0122B

MSDS is found at http://www.klueber.com, search for Paraliq GA 351.

LITHIUM GREASE RUBENS 00, K-023-0009

MSDS is found at http://www.mydata.com, document number P-040-
0138-EN. A logon user name and password may be required.

LUBRICATING GREASE FOR YM, part number K-045-0028

MSDS is found at http://www.mydata.com, document number P-045-
0028-EN. A logon user name and password may be required.

OMEGA 28 GREASE , MYDATA part number L-012-0860

MSDS is found at http://www.mydata.com, document number P-040-
0140-EN. A logon user name and password may be required.
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Lead Acid Batteries

Batteries that may be included in the machine:

BATTERY LEAD 6V 12AH, MYDATA part number E-053-0001.

BATTERY 12V 7AH, UPS 151X65X94, MYDATA part number E-053-0002.

BATTERY 6V 4.5AH 101X47X70, MYDATA part number E-053-0003, used 
for instance in UPS EBK-350.

The manufacturer for the batteries above may vary over time. The 
batteries shipped with machines or data servers may have different 
manufacturers than after-sales batteries. For correct MSDS, locate the 
battery and read the manufacturer information, and refer to the table 
below for MSDS location.

Leader
http://www.celltech.internetbutik.se/produkter/upload_pdf/leader/
msdsleader.pdf

Panasonic
http://www.panasonic.com/industrial/battery/oem/

Yuasa
http://www.yuasabatteries.com/pdfs/MSDS_LeadAcidBattery.pdf
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In Case of Fire
Only use carbon dioxide (CO2) extinguishers or dry chemical extinguishers in 
case of fire. Under no circumstances use water, as the machine contains 
electronic equipment.

ESD

ESD, ElectroStatic Discharge, is one of the few things an individual can 
unwittingly do to damage or destroy components. Much like the shock you 
receive when rubbing your feet on a carpet and then touching some metal. ESD 
can occur when working and will cause components you touch to no longer 
work properly.

How To Help Prevent ESD

The following steps help reducing the chances of ESD:

– Do not touch components unless you are constantly earthed by an 
ESD wrist strap or you are wearing ESD shoes or ESD shoe earthing 
strips on an ESD floor.

– Always ensure that people, the workplace and packaging are safely 
earthed when handling electrostatic sensitive components.

– If the packaging is not conductive, place the modules in a conductive 
envelope before packaging. Use ESD bags, domestic aluminum foil 
or paper, for example. Never use plastic bags or film.

– Make sure not to wear any clothing that conducts a lot of electrical 
charge, such as a wool sweater or synthetic fibers.

– Most plastics can easily become charged and must therefore be kept 
away from components.

– Do not touch electronic modules unless it is absolutely necessary to 
do so in order to carry out other work. If it is necessary, make sure that 
you do not touch pins or printed conductors.

 All MYDATA pick-and-place machines have jacks for wrist straps. They are 
marked with an ESD sign.
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2. Installation

In this chapter you will find the following information:

– Site Preparation on page 2-2.

Describes what is required of the site for a successful installation.

– Installation on page 2-5.

Describes how to install the machine at the site.
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Site Preparation

In this section you will find prerequisites of what is required of the site for a 
successful installation of a MYDATA Placement Machine. Details about the 
working area, environmental and electrical requirements, and regulatory 
compliance are given. Follow these directions to ensure a safe and proper 
installation, as well as ongoing operating efficiency.

Site Preparation Check List

1. Identify the desired location for the machine. Verify that enough space 
is available.

2. Verify that all environmental requirements are met.

– Temperature

– Humidity

– Cleanliness/airborne contaminants.

3. Verify that the floor is level and can take the weight.

4. Plan the transportation route to the installation site.

5. Verify that means for transportation and lifting are available (fork lift, 
crane etc.).

6. Obtain required, stable input power.

7. Arrange for electrostatic avoidance equipment.

8. Table (and chair) for terminal/printer.

9. Network connection.

Required Working Area

Prepare a suitable working area according to the dimensions shown in 
Figure 2-1 and Figure 2-2. The dimensions shown are the minimum space 
required for the machine with no extra options. To achieve a more efficient 
working area, add space for operating personnel and storage area for 
magazines, components etc.

Note that space around the machine is necessary for maintenance of the 
machine and optional equipment, if any.

Machine weight

The floor, on which the machine is transported and finally positioned, must 
support the machine weight, which is:

for MY9 1 800 kg net weight.

for MY12 2 000 kg net weight.

for MY15 2 500 kg net weight.

for MY19 2 800 kg net weight.
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Shipping gross weight

The shipping gross weight depends on the quantity of delivered options. 
A usual gross weight is the machine weight plus approximately 1 000 kg.

The site

The floor at the machine site must be level.

It is recommended that the area at the machine site is ESD (Electrostatic 
Discharge) protected.

Cables for mains and computer network are connected to the machine at the 
rear (see Figure 2-2).

Maximum cable length from the machine to the terminal or printer is 5 m.

The machine noise is maximum 62 dB(A).

Figure 2-1 shows the main dimensions (in mm). Note that the height, 
1 460 mm, does not include the monitors.

Figure 2-1.  Main dimensions.

2 000

MY9   2 820 
MY12  3 360 
MY15  4 080 
MY19  4 800 

1 460
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Figure 2-2 shows a top view over the required service area around the machine 
(measurements in mm), the position of the keyboard, monitor and printer and 
the terminal and printer cables. Also the position of the network and power 
inlets are shown in the figure.

Environmental Requirements

Temperature

Operating: +18 to +35 °C with full performance.

+10 to +18 °C and +35 to +40 °C with no guarantee of  accuracy.

Storage:  –30 to +65 °C.

Relative humidity

Operating: <95 %, non-condensing.

Storage: 100 %

Dust and dirt

The machine does not require a clean-room environment but dust and dirt must 
be kept as low as possible. The maintenance intervals are shortened by high 
temperature and a dusty or dirty environment.

Electrical Requirements

Three phase 50/60 Hz AC, 6.6 kVA (3 x 2.2 kVA), 5-wire connection, slow 
blow fuse (T). Acceptable voltages (±10 %): 435/250, 415/240, 410/235, 400/
230, 390/225, 380/220, 370/215, 365/210, 220/127, 210/121, 200/115, 190/
110.

Figure 2-2.  Clear space around the machine.

Network     Power

600
27

MYDATA MY Machine

MY9    1 330 
MY12  1 600 
MY15  1 960 
MY19  2 320 

400 400

120 Keyboard
Monitor
Printer

Terminal and Printer 
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Installation

Upon arrival the machine must be unpacked, lifted, moved to the machine site 
and leveled.

This section describes how to perform the installation tasks and is divided into 
the following main parts:

– Unpacking on page 2-6.

– Lifting the Machine on page 2-7.

– Moving and Placing the Machine on page 2-9.

– Powering on page 2-10.

– Network Connection on page 2-13.

– Machine Installation And Calibration on page 2-14.

Equipment

– Standard Tools.

– Set of Allen Keys(mm).

– Spirit level and 70mm wrench.

– Lifting equipment.
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Unpacking

The machine is shipped in a wooden crate (outside Europe) and must be 
handled with care. It is strongly recommended that a MYDATA representative 
is present when the machine is unpacked.

1. Inspect the "Shock-Watch" and "Tilt-Watch" gages for activation and 
the crate for damages. These must be annotated on the Bill of Lading and 
goods received note.

2. Remove the top lid.

3. Remove the rear and front sides of the box.

4. Remove the plastic protection.

5. Remove the additional packages fastened to the machine (monitor, 
printer, magazines, etc.).

6. Release the machine from the bottom of the box.

7. Inventory all packages to ensure that the correct items are delivered 
according to the packing list. If not, contact your local MYDATA 
representative.

Items that are always included:

– Power cable.

– Keyboard and trackball.

– Monitor (with cables).

– Calibration board and calibration components.

– Operator’s Manual.

– Programming Manual.

– Software Manual.

– Machine Manual.
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Lifting the Machine

To avoid tilting or damaging the machine, always lift the machine as described 
below. The description includes fork lift as well as crane lift.

 WARNING! Lift the machine as described below. Otherwise, the machine may 
become damaged and the lifting may become dangerous.

Fork Lift

Normally, the machine can be lifted with the forks placed at the center of the 
machine, see Figure 2-3.

Figure 2-3 shows a MY19 machine, but the forks are to be placed in the center 
for all machines in the MY series.

If the Y wagon is fitted other than in the center of the machine, it may be 
necessary to compensate for this unbalance by placing the forks slightly more 
to the side where the Y wagon is positioned.

Figure 2-3.  Fork lift.
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Crane Lift

A lifting equipment, available from MYDATA Sweden, should be used when 
lifting the machine with a crane.

 The machine´s center of gravity is located near the front of the machine. 
Therefore the hoisting cable should be slightly shorter at the front.

Figure 2-4 shows a MY19 machine, but the procedure is the same for all the 
machines in the MY series. The numerals in Figure 2-4 refer to the description.

1. Remove the front cover(s) at the leveling feet.

2. For MY9: Fit lifting eye bolts (M30 thread) in the two leveling feet at the 
rear of the machine.
For MY12, MY15, MY19: Fit four lifting eye bolts (M30 thread) in the 
leveling feet.

Figure 2-4.  Crane lift.
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3. For MY9: Fit the hoisting cable as in Figure 2-4 for the two eye bolts on 
the rear of the machine. Fit the front hoisting cable around the two front 
leveling feet.
For MY12, MY15, MY19: Fit the hoisting cable between the eye bolts 
and the beam. This beam has a length of 1 500 mm.

4. Place a piece of cardboard, or a blanket, between the machine frame and 
the hoisting cable. This will protect the magazine table when the hoisting 
cable is stretched.

Moving and Placing the Machine

Move the machine to the final position and put it on the leveling feet. You can 
use either a fork lift or a crane. An alternative is to do as follows:

1. Place the machine on fixed supports, for instance 280 mm or higher solid 
wooden blocks. These supports must be placed under the frame of the 
machine.

2. Mount a wheel on each leveling foot using four screws (8 mm Allen key) 
for each wheel.

3. Resting the machine on the wheels, move it to its final location.

4. With a jack under the cross bar at a short end of the machine, lift one side 
of the machine.

 WARNING! Block up the machine while working under it.

5. Remove two wheels and place the machine on the leveling feet.

6. Repeat the procedure on the other side of the machine.

Leveling

When the machine has been placed in the final location, check the leveling as 
described below.

1. Place a spirit level on the Y wagon or on the magazine tracks and adjust 
the leveling feet until the machine is level in both directions.

2. Make sure that each leveling foot is screwed firmly against the floor so 
that the weight of the machine is divided equally on the four feet.

3. Check if the machine is steady by manually trying to rock the machine. 
If not, adjust the leveling feet.

4. Tighten the locking nut on each leveling foot.



Installation MY9 – MY12 – MY15 – MY19  MYDATA

2 - 10 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Powering

MYDATA machines are set up for adequate mains supply before delivery. It 
is set according to the customer order, normally only the mains power needs 
to be connected, and nothing needs to be altered inside the machine.

Knowing your mains power supply, you can verify that the machine is 
properly set up by comparing the configuration plugs numbers in the machine 
to the table below.

If the mains voltage or the type of mains supply is to be changed, internal 
power connections in the machine must also be changed accordingly, see the 
next section.

 DANGER! The power configuration plugs should only be installed by an 
authorized MYDATA service engineer.

Electrical Configuration

 WARNING! Disconnect the mains before opening, or doing any work inside 
the machine.
Always ensure that the voltage labeled on the machine (close to the mains 
power inlet) corresponds to the mains.

The machine is equipped with three mains transformers (TR1, TR2 and TR3), 
which all have to be configured in the same way and according to the supply 
voltage. A configuration plug (’A’) is provided for selecting how the three 
mains supply phases are connected to the machine (Delta or Y connection). 
The voltage configuration is set by moving a jumper cable in the EPT units

Figure 2-5 shows the rear panel with the type configuration plug (’A’) and the 
three EPT units (’B’).

Figure 2-5.  Rear panel.

A

B
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Electrical Configuration Plug Table

Select the configuration plugs for the mains according to the table below.

 WARNING! Never connect the mains before ensuring that the correct 
configuration plugs are installed.

Setting the Voltage Configuration

The voltage configuration is set by moving a jumper cable in the EPT units. 
Follow the procedure below to set the voltage in the EPT units.

Procedure

1. Remove the two screws holding the cover of the EPT unit.

On the back of the cover there is a sticker (’A’) that describes how to 
configure the unit for different voltages.

2. Locate the jumper cable (’B’) on the right side of the terminal block.

One end of the jumper cable should always be connected to terminal ’0’ 
on the terminal block.

3. Move the other end of the jumper cable to the terminal (1-5) that 
represents the desired voltage configuration.

4. Re-assemble the EPT cover.

5. Repeat the procedure above on the other two EPT units.

D/Y Type plug part # Remark

Delta

 L-029-0297 Japan

 L-029-0296 USA 
220 V w. no neutral Norway.

USA 3-phase w. long leg 

 Y (Wye)  L-029-0295  USA
EU standard 

The U.K. and Japan.

Figure 2-6.  Configuration plugs.

A

B
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Electrical Connection

This placement machine is intended to be stationary and movable to 
accommodate the changing production needs of the end use factory (this is in 
compliance with the NEC Article 400-7 and -8).

The machine is delivered with a 5 x 2.5 mm2 power cable and, depending on 
the destination, a US 5 pole, three-phase power plug (Figure 2-7), or 
a European standard 5 pole, three-phase power plug (Figure 2-8).

US power plug specification (Figure 2-7): NEMA L21-20P, 20A 3Y, 120/
208 V AC, UL/CSA, 2HP, IP20.

Power Plug Connection

Connect the mains power plug according to Figure 2-7 or 2-8 and table shown 
below.

.

Figure 2-7.  Power plug, US Figure 2-8.  Power plug, Europe

Part
Power plug 
markings

US

Power Cord 
Colors, US

Power plug 
markings

EU

Power Cord 
Colors, EU

Live 1  X  Orange  T  Black

Live 2  Y  Red  S  Brown

Live 3  Z  Black  R  Black

Neutral  W  White  N  Blue

Protective Earth  PE  Green W Yellow/Green

X

Y

Z

WG R

S T

N
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Power Cord Connection

The machine power terminal block is to be connected to the mains power cord 
as shown in Figure 2-9 and table shown below.

 WARNING! Never connect the mains power before ensuring that the correct 
configuration plugs are installed.

Network Connection

The computer network is connected with a RJ45 connector.

Figure 2-9.  Power terminal block

Part

Power 
terminal 

block 
marking

Power cord 
marking, US

Power cord 
marking, EU

Live 1  W  Orange  Black

Live 2  V  Red  Brown

Live 3  U  Black  Black

Neutral  N  White  Blue

Protective Earth  PE/G Yellow/Green Yellow/Green

HAZARDOUS
VOLTAGE.
Disconnect power
before servicing.
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Machine Installation And Calibration
There are a number of installation and calibration tasks in TPSys for a 
complete machine installation. The system will lead you through these tasks 
in the correct order – all you have to do is follow the instructions on the screen. 
Chapter 3 details how the various subsytems are registered in hwconf. 
Chapter 4 give information as to the tools and other hardware that is needed, 
as well as details on how to use calibration compmnents and boards.

ECR

ECR is a choice you make when installing the machine. On this type of 
machine, the mechanical centering unit is no longer required. A new type of 
X-wagon camera with a bigger FOV than standard is installed. In auto install 
above some new measurements have been added, and the order is slightly 
different.
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3. Hardware Configuration
TPSys has a hardware configuration program called hwconf. This is where the 
machine configuration is specified.

There are two main tasks for the program:

– Identification of the servo controllers present in the machine, and thus 
select the appropriate servo software for them.

– Configuration of machine parameters, given the installed hardware.

Hwconf must be run every time the hardware is changed, or TPSys is 
upgraded. When you run hwconf for the first time, you must perform the 
operations described below manually. This is also the case if you add, or 
remove, hardware on the machine. When upgrading TPSys on the other hand, 
the program will perform these steps automatically.

TPSys View Of the Machine

TPSys sees the machine as a set of units, or subsystems. Each subsystem is 
configured by selecting the appropriate module type, which is an actual 
physical implementation of the subsystem. If there are more than one module 
type available, the operator must point to the correct one.

TPSys can communicate with some of these subsystems. To communicate, the 
system uses a number of controllers, or servo boards. The hwconf program 
automatically detects the various controller types on the machine.

Starting hwconf

1. Exit TPSys if it is running.

2. Start the configuration program hwconf at the Linux prompt on a 
machine. This opens up a TPSys-like interface with only two menus, 
Main and Exit.

The Main menu in the hwconf program has two options, Controllers and 
HW Configuration. These options are described below.
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* Controller Viewer * Window

Select Main > Controllers in the hwconf menu to open the * Controller Viewer 
* window.

This window is primarily used for troubleshooting of servos and for installing 
special servos.

Command Keys

All available commands for the * Controller Viewer * window are found in the 
upper-right area of the window.

Commands that are common in the TPSys interface are described in the 
TPSys, Operator’s Manual.

Commands that are specific to the * Controller Viewer * window are listed 
below.

Enter– Autodetect Controller

Highlighting a controller in the list and pressing <Enter> starts a search 
for that specific controller.

F1 – Auto-detect all Controllers

Pressing <F1> starts a search for all controllers in the list.

F2 – Select special servo

It is possible to bypass the automatic selection of servo for a controller and 
selecting a special servo. Press <F2>, and a list of available servos for the 
controller will appear.

 There is no check that the servo selected is valid for the machine or 
configuration

Controllers

The Controllers list shows the possible controllers for the current machine, 
and the status of detection. A status symbol at the left of each entry shows the 
current status. When the window is first opened, no symbols are shown.

Data

This box contains detailed information about the highlighted controller, for 
instance servo software name, version and date.

Symbol Status

No symbol means no search has been made for that 
controller type.

– Searched for but not found.

* Searched and found.
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* Subsystem Viewer * Window

Select Main > HW Configuration in the hwconf menu to open the * Subsystem 
Viewer * window.

This will bring up a list of possible subsystems in the machine. When 
configuring a new machine, mandatory subsystems and the centering unit are 
preselected. You may need to manually add some subsystems, depending on 
the configuration. If an old machine configuration exists, for instance when 
TPSys is being upgraded, this existing configuration is read.

If the system has not auto detected the controllers before you configure a 
subsystem, it will perform an automatic detection. This may take a few 
seconds.

Command Keys

All available commands for the * Subsystem Viewer * window are found in the 
upper-right area of the window.

Commands that are common in the TPSys interface are described in the 
TPSys, Operator’s Manual.

Commands that are specific to the * Subsystem Viewer * window are listed 
below.

Space – Select subsystem

By pressing <Space> when a subsystem is highlighted, you toggle 
whether the subsystem should be present or not. The Present field in the 
Data box indicates the status for the highlighted subsystem. Note that you 
cannot toggle the presence of mandatory subsystems.

Enter – Configure subsystem

By pressing <Enter> when a subsystem is highlighted, you start a 
configuration wizard for that subsystem and for any subsystems related to 
that subsystem.

F1 – Configure selected subsystems

By pressing <F1> the program will configure all selected subsystems, in 
other words the subsystems marked with * or ** in the list (see page 3-4). 

F2 – Save machine configuration

By pressing <F2> the configuration is saved. This performs all the 
required setup for the machine, setting the appropriate parameters and 
such. If you exit the window without saving with <F2>, the system will 
prompt if you wish to save the configuration.

F3 – Select all subsystems

By pressing <F3>, all subsystems are selected.

F4 – Mark subsystem replaced

By pressing <F4>, the highlighted subsystem is marked as uncalibrated in 
the Utility > Installation and Calibration > Calibration function in 
TPSys.
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Subsystems

This list contains the possible subsystems for the machine.

The configuration status is shown in the left margin of the Subsystems list. A 
status symbol at the left of each entry shows the current status.

To configure a system, highlight it in the Subsystems list and press <Enter>. A 
message box will inform that auto detection is ongoing, this may take some 
time. Depending on the subsystem, you may get further configuration 
questions. For further information, see page 3-5.

If the configuration is successful, the subsystem will be marked as present and 
configured in the list.

Data

The data box at the bottom right shows the status and, if configured, the 
selected module type.

Symbol Status

Not present.

* Present but not configured.

** Present and configured.
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Configuration Questions

When you are configuring the subsystems, the system will ask a number of 
questions. The actual questions will depend on which subsystems are marked 
as present, and what machine type it is.

If the machine has previously been configured with hwconf, the program will 
point out the choices previously made. Not all of the following questions and 
choices will appear for each machine.

Y Wagon

The program will ask for the type of Y wagon installed.

Conveyor

The program will ask what type of conveyor is installed on the machine.

Z Unit

You will be asked what type of Z unit is installed on the machine. It will be 
either a Midas unit or the older Z-Fi type, see Figure 3-1 below.

Figure 3-1.  Z units.

Midas Z-Fi
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Magazine

The program will ask if the magazine bus is CAN-based or MOT-based. If the 
machine is upgraded to handle Agilis LM8 or LM1216 magazines, or 
manufactured after February 2004, the machine magazine bus is CAN-based.

X wagon Camera

You will be asked for the kind of X wagon camera (PVC) installed. The list 
below shows the different types. Some of the options are only available on 
some machine models.

PVC 2

Big shiny lighting unit with 4 halogen bulbs. SONY-camera XC-77CE. 
Field of view (FOV) 14x11mm.

PVC 3

Small black lighting unit with 2 halogen bulbs. SONY-camera XC-73CE. 
FOV 8x6 mm.

PVC 4, CP5

Small black lighting unit with 2 halogen bulbs. SONY-camera XC-73CE. 
FOV 14x11 mm. For machine with CP5 electronics.

PVC 4, CP5, 21.5x17

Small black lighting unit with 2 halogen bulbs. SONY-camera XC-73CE. 
FOV 21.5x17 mm. For MY-series ECR machines.

PVC 4, CP5, 16x12.5

Small black lighting unit with 2 halogen bulbs. SONY-camera XC-73CE. 
FOV 16x12.5 mm. For MY-series machines with a T3, T4, T5 or T6 
conveyor that is mounted in its lower position to allow mounting of higher 
components.

PVC 4, CP4

Small black lighting unit with 2 halogen bulbs. SONY-camera XC-73CE. 
FOV 14x11 mm. For machine with CP4 electronics.
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Optical centering cameras

You must indicate which type each selected optical centering camera is. The 
list below shows the different types.

For each camera subsystem, there is a corresponding illumination subsystem. 
The illumination subsystem is automatically configured when the camera 
subsystem is configured.

SVC

Rectangular field of view, approximately 53x41 mm. Lighting unit with 
surface mounted diodes. Manufactured in steel. Previously known as L-
011-0034 or L-11-034B.

HRC

High-resolution camera. Always part of a DVC together with an SVC.

OVC1

TP9-2U specific with FOV 41x41mm. Lighting unit with through hole 
mounted diodes. Manufactured in aluminum. Previously known as L-
011-0110B.

OVC2, 3, 4, 5

Rectangular field of view (FOV), approximately 53x41 mm. Lighting unit 
with through hole mounted diodes. Manufactured in aluminum. 
Previously known as L-011-0025.

EVC1, 2, 3, 4

Standard cameras with extended field of view.

HYDRA camera

The program will ask whether the installed HYDRA camera is for HYDRA 
14,400 cph or for HYDRA 21,000 cph.

HYDRA tools

The program will ask whether the HYDRA unit has 11.5mm exchangeable 
tools or shorter exchangeable tools. Select the 11.5mm option.
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HYDRA reference background

The program will ask what type of HYDRA reference background the 
machine has. The options will vary depending on if the machine has a 
Linescan camera present or not.

The HYDRA unit can be fitted with three different reference backgrounds 
(HRB): type 14, type 14LSC and type 23LSC. 

– Type 14 can only be used with the HYDRA camera. 

– Type 14LSC can be used with both the HYDRA camera and the 
Linescan camera. Type 14LSC has an inner diameter of 14 mm.

– Type 23LSC can only be used with the Linescan camera. Type 23LSC 
has an inner diameter of 23 mm.

HYDRA vacuum

The program will ask if the HYDRA vacuum unit is black or white.

Figure 3-2.  HYDRA with vacuum unit (see arrow).
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Calibration and updating questions

Depending on the machine type and hardware configuration, the program may 
indicate that you have to calibrate the X servo.

Calibration may be done at this time, or skipped for the time being. If you skip 
the calibration, a warning will be displayed, saying that the calibration should 
be performed before running the machine the next time.

You may be asked if any TEX units are installed. If there are, the program will 
check whether their firmware needs updating, and if necessary, update it. This 
may take a couple of minutes.

The program will automatically search for other controllers with firmware that 
needs updating, and if it finds any, it will update them also.

Messages will be displayed to inform you of what is happening during this 
time.

When saving a configuration, the program will show a list of calibrations that 
will be marked as uncalibrated in the Utility > Installation and Calibration > 
Calibration function in TPSys. It is possible to abort at this point by typing 
<Esc>.
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4. Installation And Calibration
The machine configuration is specified in the hardware configuration program 
hwconf, see Chapter 3. Hwconf must be run every time the hardware is 
changed, or TPSys is upgraded.

Running hwconf is just the first step in the installation process. The next step 
is to let TPSys install and calibrate the various resources. Thereafter the 
machine is ready to use.

The TPSys Installation Guide (P-010-0905-EN) describes how to perform a 
complete installation of Linux and TPSys.

This chapter is divided into the following sections:

– Installation on page 4-2.

Describes the main steps when installing the TPSys software.

– Calibration on page 4-4.

Describes the various calibration procedures that has to be performed.
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Installation
When performing a new software installation there are a couple of 
measurements and configurations that have to be done before the machine is 
ready for operation.

The following steps have to be performed before the machine can be used. 
Each step is described in the following section.

1. Install the TPSys software.

2. Run the Postinstall program.

3. Run the hwconf program (hardware configuration program).

4. Run the Autoinstall procedure.

5. Perform the machine calibration procedures.

Installing the TPSys Software

The TPSys software is installed by inserting the TPSys software CD in the 
machines DVD player and powering up or rebooting the machine. Follow the 
instructions on the screen.

For a more detailed description of the TPSys software installation, refer to the 
TPSys Installation Guide

Postinstall Program

Postinstall is an option configuration program that is used to set different 
software options, for example magic word, use time lock, tools used in the 
machine, colors used, network parameters. The postinstall program is 
automatically started after the TPSys software installation. It is also possible 
to start the program by typing postinstall at the Linux prompt.

 Note, if you start postinstall on an already installed and calibrated machine all 
settings will be reset and all calibrations have to be re-done.

For a detailed description of the postinstall procedure, refer to the TPSys 
Installation Guide.

Hardware Configuration Program

The machine configuration is specified in the hardware configuration program 
hwconf. The hwconf program must be run every time the hardware is changed, 
or TPSys is upgraded.

For a detailed description of the hwconf program, refer to Chapter 3 in this 
manual.
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Autoinstall Procedure

Before actual use of the machine, some machine parameters must be measured 
in every individual machine. The measurement procedure is assisted by a 
program called autoInstall. Some of the steps will require manual 
intervention. Follow the instructions given on the screen.

 WARNING! Not all of the normal safety systems of the machine are in 
operation during this procedure, so make sure that nothing is in the way of the 
machine’s moving parts before pressing <Enter>, <PgDn> or <PgUp>.

For a detailed description of the autoInstall procedure, refer to the TPSys 
Installation Guide.

Machine Calibration

The final step is to perform a number of calibration procedures on the machine, 
thereafter the machine is ready to be used.

The machine calibration procedures are described in the following section.
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Calibration
If you are to perform a new installation of a machine. Start by following the 
first six steps as described in the TPSys Installation Guide. When done, return 
to this section for detailed descriptions of each calibration that needs to be 
performed.

If you are not performing a new installation of a machine but new hardware 
has been added or replaced in the machine, then TPSys must first be informed 
about which calibration steps that need to be performed. Before starting any 
calibrations, inform TPSys about the new hardware by running the hwconf 
program and select the new hardware in hwconf, see Chapter 3.

TPSys use calibration components and plates in some of the operations. You 
will be asked to locate and verify, for instance, fiducial marks on these 
components. In some cases you may have to do mechanical calibrations, like 
for instance the HYDRA camera's alignment in Y direction.

Backup and Restore

When performing a backup, the calibration status of the machine as well as the 
calibration data created by the calibration operations are saved. Restoring will 
restore the calibration status of the machine.

Requirements

In order to be able to perform the calibrations, there are some hardware and 
tools that are needed. Before starting any calibration steps, ensure that you 
have the required parts at hand.

– Calibration components and plates.

– Empty board (PCB).

– Slide caliper.

– Allen keys.

– Screwdrivers

– Spanners

– Metal ruler.
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Starting the Calibration

Knowing the dependencies between various installation operations, and in 
which order to perform them, can be difficult. TPSys will help you with these 
tasks. Simply put – follow the instructions on the screen. 

To start the machine calibration, select Utility > Installation and Calibration. 
This opens a CALIBRATION window listing all calibration steps.

The following calibration procedures are described later in this Chapter.

1. X-wagon camera calibration on page 4-6.

2. Place area calibration on page 4-8.

3. Centering Base Level Measurement on page 4-9.

4. Mechanical centering unit alignment on page 4-10.

5. Coarse measurement of Z-unit offset on page 4-11.

6. Cable resistance measurement on page 4-12.

7. Optical Centering Calibration (SVC & HRC) on page 4-13.

8. Optical Centering Camera Offsets (SVC & HRC) on page 4-13.

9. Optical Centering Calibration (Linescan Camera) on page 4-16.

10. Linescan Camera Fine Tune on page 4-18.

11. Calibrate HYDRA Camera Optics on page 4-19.

• Press <F1> to run through the required calibrations.

Command Keys

F1 – Finish calibration

By pressing <F1> all non-performed calibration steps will be executed in 
the required order. For each operation TPSys will display a pop-up 
window declaring which operation will be started. If an operation is 
aborted, or fails, TPSys will return to the main window without 
performing the remaining steps. After an operation is completed the Date 
column is updated.

F2 – Clear calibration status

Pressing <F2> will clear all timestamps, marking all operations as not 
performed.

Enter – Perform specific calibration

To perform a specific calibration, place the cursor on the desired line and 
press <Enter>. If you select not to perform dependent steps, the operation 
will be executed but not marked as performed. The system will warn you 
if the specified operation invalidates any already performed calibrations. 
It you proceed with the operation, the timestamp for all invalidated 
calibration operations will be cleared.

Data

Date

Timestamp showing when a calibration step was performed. If no 
calibration has been performed the column is blank.

Operation

All required calibration steps in the preferred order.
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X-wagon camera calibration

Purpose

The purpose of this calibration is (with the aid of a calibration board) to 
stabilize the X,Y offset values and the theta value for the X-wagon camera.

When to perform this procedure?

• Installing a new machine.

• If the offset values for the X-wagon camera, are not within ±3μm 
approximately.

Requirements

– Calibration Plate, see Figure 4-1.

– Calibration Background Plate 

The table below show which background to use for different load 
tables.

Figure 4-1.  Calibration plate.

Load table Plate

288 or 358mm Y-wagon with covers L-015-1681

ML3 L-015-1682

ML4 L-015-1686

ML5 L-015-1687

ML6 L-015-1689

Special ML7 Proline L-015-1690

400PT or 420PT with covers L-015-1683

450PT without covers L-015-1684

468 or 478mm Y-wagon with/without covers L-015-1684

538mm Y-wagon without covers L-015-1684

T3 L-015-1685

T4 L-015-1686

T5 L-015-1687

T6 L-015-1688

500T without covers L-015-1685

500T extended 1 module L-015-1686

500T2 with covers L-015-1685

500T2 ML adapter L-015-1684

500T2 special extension 24" L-015-1686

500T2 extended 1 magazine module L-015-1686

500T2 special extension 28" L-015-1686

A B

MYDATA

L-015-0450

CALIBRATION PLATE
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Procedure

1. Start the calibration by selecting the camera to calibrate in the   
Calibration window.

2. Follow the instructions presented on the screen.

– When prompted, insert the appropriate calibration background plate. 
Set the conveyor width and grab the plate.

– When prompted, place the area calibration plate (L-015-0450) on the 
calibration background plate, see Figure 4-2. Set it approximately 
aligned to the X axis.

TPSys will repeat the calibration a number of times, and present the final 
results in a dialog box.

Figure 4-2.  Calibration board (L-015-0450).

Xxxxxxx
Xxxxxxx
Xxxxxx

A B

MYDATA

L-015-0450

CALIBRATION PLATE

A B

MYDATA

L-015-0450

CALIBRATION PLATE
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Place area calibration

Purpose

This procedure is used to calibrate the assembly table place area, where the 
objective is to obtain the standard deviation values for the X axis and the 
Y axis.

When to perform this procedure?

• Installing a new machine.

• If the Y wagon has been removed/replaced.

Requirements

– See X-wagon camera calibration requirements on page 4-6.

Procedure

1. Start the calibration by selecting Place area calibration in the 
Calibration window.

2. Follow the instructions presented on the screen.

– When prompted, insert the appropriate calibration background plate 
in the conveyor. Set the conveyor width and grab the plate.

– When prompted, place the area calibration plate (L-015-0450) on the 
calibration background plate, see Figure 4-3. Set it approximately 
aligned to the X axis.

A coarse measurement of the Z unit offset is made.

The place area calibration will now run and a progress bar will be 
displayed showing information as to elapsed time and remaining time. 

The calibration is performed in one pass, including both the X axis 
and the Y axis. When the calibration is completed, the result is 
displayed as standard deviations for the X axis and the Y axis. A high 
standard deviation indicates that the area calibration plate has moved 
during calibration or that there are some mechanical problems in the 
machine.

Figure 4-3.  Calibration board (L-015-0450).

Xxxxxxx
Xxxxxxx
Xxxxxx
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L-015-0450
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L-015-0450

CALIBRATION PLATE
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Centering Base Level Measurement

Purpose

This procedure measures the vertical position of the centering jaws, which 
equals the base centering level.

When to perform this procedure?

• Installing a new machine.

• The mechanical centering level must be measured if the centering jaws have 
been loosened.

• If a centering or electrical verifying problem occurs.

Procedure

1. Start the calibration by selecting Place area calibration in the   
Calibration window.

2. Follow the instructions presented on the screen.

The vertical position of the centering jaws is measured and the new value 
is stored as parameter 21.0221 Centering; Centering base level which 
normally equals centering level Number 1.



Installation And Calibration MY9 – MY12 – MY15 – MY19  MYDATA

4 - 10 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Mechanical centering unit alignment

Purpose

The purpose of this calibration step is to mechanically align the mechanical 
centering unit to the rotational center of the Z unit mount tool.

When to perform this procedure?

• Installing a new machine.

Requirements

– Empty board (PCB).

– Calibration component (L-010-0166-1 HCOB ED-1), see Figure 4-4.

Procedure

1. Start the calibration by selecting Mechanical centering unit alignment in 
the Calibration window. 

2. Follow the instructions presented on the screen.

– When prompted, insert an empty board to place the calibration 
component on, and put the calibration component on the board. The 
component shall be placed as in Figure 4-5, that is with the text and 
four dots upwards.

TPSys does the required measurements and displays the
C misalignment. If the misalignment is too big, then the mechanical 
centering unit must be mechanically adjusted.

Figure 4-4.  Calibration component (L-010-0166-1 HCOB ED-1)

Figure 4-5.  Placing calibration component.
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Coarse measurement of Z-unit offset

Purpose

To set a coarse offset between the optical axis of the X-wagon camera and the 
mount tool center line. 

When to perform this procedure?

• Installing a new machine.

• If the camera or parts of the Z axis have been loosened.

Requirements

– See Mechanical centering unit alignment requirements on page 4-6.

Procedure

1. Start the calibration by selecting Coarse measurement of Z-unit offset in 
the Calibration window.

2. Follow the instructions presented on the screen.

– When prompted, manually insert the component on the mount head 
nozzle.

TPSys centers the component mechanically, places the component on 
the board and locates the component using the X-wagon camera.
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Cable resistance measurement

Purpose

This procedure is used to measure the cable resistance in wires included in the 
electrical verification circuit, and to update this value in the system.

The cable resistance has effect when verifying low ohm resistors only, see 
below.

When to perform this procedure?

• Installing a new machine.

• If the centering jaws have been replaced.

• If the resistance test fails in verifying low resistance.

Requirements

– Zero ohm resistors are required to perform this measuring.

Procedure

1. Start the calibration by selecting Cable resistance measurement in the   
Calibration window. 

2. Follow the instructions presented on the screen.

– When prompted, apply manually a zero ohm resistor with the selected 
package to the tool tip in 0 degrees.

This procedure updates the 111.0002 Right X wagon; Cable resistance 
or 111.0012 Left X wagon; Cable resistance parameter. The default 
value for this parameter is 0.6 ohm, which, if incorrect, has affect only 
on resistors with a resistance of less than 50 ohm approximately.

If you have no zero ohm resistor, you can use a low ohm resistor and 
subtract the real resistor value from the measured value and enter the 
difference to the 111.0002 Right X wagon; Cable resistance or 111.0012 
Left X wagon; Cable resistance parameter.
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Optical Centering Calibration (SVC & HRC)

Purpose

This procedure describes how to calibrate the SVC and HRC camera.

When to perform this procedure?

• Installing a new machine.

• If parts of the optical or mechanical system is modified or replaced.

Requirements

– C23S mount tool.

– Slide caliper.

– Calibration board (L-029-0506-3 Plate 506 ED-3), see Figure 4-6.

 The calibration plate is the cameras absolute reference and should therefore 
always be handled with care. When not used the calibration plate should be 
stored in its accompanying casing in order to keep it clear from dust and in 
good shape.

The calibration plate in Figure 4-6 is used for the calibration of the 
Standard vision camera (SVC) and the High resolution camera (HRC) 
in a dual vision system. A rubber cloth is provided with the plate. This 
cloth will keep the plate from slipping when placed on a board.

Figure 4-6.  Calibration board (L-029-0506-3 Plate 506 ED-3).

SVC HRC
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Procedure

1. Start the calibration by selecting the camera to calibrate in the 
Calibration window.

2. Follow the instructions presented on the screen.

– When prompted, Move the crosshairs to the camera´s left side when 
the Center cross hairs on the left side of the camera frame dialog box 
is shown.

– When prompted, Measure the calibration plate thickness with a slide 
caliper when the Verify calibration plate thickness dialog box is 
shown. Insert the correct value in the dialog box on the screen.

– When prompted, put a board on the assembly table. Put the rubber 
cloth provided with the calibration plate on the board. Place the 
calibration plate on top of the rubber cloth. The rubber cloth will keep 
the calibration plate from slipping around on the board.

– When prompted, use the trackball, adjust the crosshairs to the center 
of the calibration pattern.

The camera is positioned in 90 degrees. Consequently, the dot area 
should be centered vertically on the monitor.

To pan the image, use the key combinations in the table below.

3. If the calibration pattern is not aligned in the Y direction, it might be 
necessary to adjust the Y position of the camera unit mechanically, see 
page 9-7.

 Do not adjust a DVC unit mechanically if the SVC is calibrated.

4. The camera calibration is now completed. Proceed with the procedure.

–  Optical Centering Camera Offsets (SVC & HRC) on page 4-15.

Key combination Move image

+ Up

+ Down

+ Left

+ Right

+  Zoom Out

+ Zoom In

+ Back to normal view

Ctrl
W

Ctrl
X

Ctrl
A

Ctrl
D

Ctrl PgUp

Ctrl

Ctrl
S
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Optical Centering Camera Offsets (SVC & HRC)

Purpose

This calibration step needs to be performed for all centering cameras in the 
machine in order to increase the accuracy of the computed centering offsets.

When to perform this procedure?

• This calibration step needs to be performed for all centering cameras in the 
machine.

Requirements

– See Mechanical centering unit alignment requirements on page 4-6.

Procedure

1. Start the calibration by selecting the camera to calibrate in the 
Calibration window.

2. Follow the instructions presented on the screen.

TPSys picks up the component and acquires the necessary number of 
images and calculates the centering offsets.

When the measurement is done, the result is presented on the screen.

3. If this procedure was performed on the Linescan camera then continue 
with the following procedure.

– Linescan Camera Fine Tune on page 4-18.
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Optical Centering Calibration (Linescan Camera)

Purpose

This procedure describes how to calibrate the Linescan camera.

When to perform this procedure?

• Installing a new Linescan camera 

• If parts of the optical or mechanical system is modified or replaced.

Requirements

– C23S mount tool.

– Calibration plate Linescan camera (L-010-0452B).

 The calibration plate is the cameras absolute reference and should therefore 
always be handled with care. When not used the calibration plate should be 
stored in its accompanying casing in order to keep it clear from dust and in 
good shape.

Figure 4-7.  Calibration plate Linescan camera (L-010-0452B).
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Procedure

1. Start the calibration by selecting the camera to calibrate in the 
Calibration window.

2. Follow the instructions presented on the screen.

– When prompted, use the trackball to center crosshairs on the camera 
frame (see figure). 

– When prompted, align the left side of the Midas mount head tool 
holder top to the horizontal line in the center of the screen. Use the 
trackball to move the tool position up or down.

– When prompted, align the right side of the Z tool in the same way as 
above.

– When the Verify calibration plate thickness dialog box is shown, 
measure the calibration plate thickness with a slide caliper. Insert the 
correct value. The plate thickness does not include the supports.

– When prompted, put a board on the assembly table and then put the 
calibration plate on top of that board with the supports downwards. 
Note the orientation of the plate.

A = upper left fiducial mark of calibration plate.

B = lower right fiducial mark of calibration plate.

C = lower left fiducial mark of calibration plate.

When ready, the calibration starts and the Running Linescan camera 
calibration dialog box is presented on screen. The calibration procedure 
will last for approximately 2 minutes and if successful the Calibration 
successful dialog box is presented on the screen.

3. When the calibration is completed, continue with the following 
procedure.

– Linescan Camera Fine Tune on page 4-18.

L

R

L

R

A B

C
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Linescan Camera Fine Tune

Purpose

After a camera calibration it is always necessary to perform a fine tuning to 
achieve the highest possible placement accuracy. This procedure measures the 
angle between the Midas LSC reference line and the X axis of the table 
coordinate system.

When to perform this procedure?

• After performing Optical Centering Calibration (SVC & HRC) (Linescan 
Camera).

Requirements

– C23S mount tool.

– Calibration component (L-040-1084).

1. Start the calibration by selecting the camera to calibrate in the 
Calibration window.

2. Follow the instructions presented on the screen.

3. When prompted, use the trackball to move the camera crosshair to 
indicated component fiducial marks, and verify each fiducial mark.

Centering camera angle offset value in the parameter file is now adjusted 
automatically. 

Figure 4-8.  Calibration component (L-040-1084).

Fiducial mark
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Calibrate HYDRA Camera Optics

Purpose

To calibrate the optical system of the HYDRA camera. This enables TPSys to 
compensate for non-linearities and distortions in the optical system.

When to perform this procedure?

• Installing new HYDRA system.

• After replacing or moving the HYDRA system.

Requirements

– C23S mount tool.

– Calibration plate HYDRA camera (L-019-0633-2).

Procedure

1. Measure the thickness of the calibration plate, using a slide caliper and 
enter the value when prompted.

2. When prompted, insert a clean PCB on the lower left end of the 
Y wagon. Place your calibration plate (L-019-0633-2) upside down on 
the PCB according to figure 4-10. Verify when ready.

3. Use the trackball to Center cross hairs on lower left fiducial mark of 
calibration plate as accurately as possible, and verify.

The X-wagon moves to the lower right fiducial mark.

4. Use the trackball to Center cross hairs on lower right fiducial mark of 
calibration plate as accurately as possible, and verify. 

Figure 4-9.  L-019-0633-2 Calibration plate.

Figure 4-10.  Calibration plate L-019-0633-2 on the PCB.

PCB
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5. Find a place to measure the board level on. Use the trackball to move the 
X-wagon camera somewhere on the PCB near the calibration plate. 
Verify when ready.

The Midas mount head will now pick up the calibration plate and move 
to a position above the HYDRA camera. 

The camera view with a graphical support pattern is shown on the screen 
See Figure 4-11.

6. Use the graphical support pattern to locate the X position of the 
calibration plate. See Figure 4-11.

7. When you are satisfied with the X position, select Ready in the Locate X 
position of calibration plate dialog box and press <Enter>.

8. You may have to adjust the cameras Y position. Please see page 9-8 for 
information.

9. When you are satisfied with the Y position, select Ready in the Adjust Y 
position of camera dialog box and press <Enter>.

10. When the calibration of the camera optics is done, verify the calibration 
by pressing <Shift> + <F1> and study the view with the small crosses.

11. Ensure that all crosses are in the center of the dots. Move the image with 
the shortcut keys, see table on page 4-14.

Measuring HYDRA Camera Height

When you measure the HYDRA camera Z level, a protection hood with 
known thickness (‘t’ in the figure) must be placed over the camera opening.

We suggest you use a metal ruler as hood. If the camera openings plastic cover 
is sticking up above the camera housing, this height (‘h’ in the figure) must 
also be measured and added to the thickness of the hood. Use a slide calliper 
to measure the height.

Figure 4-11.  Locate X position of calibration plate

Figure 4-12.  Adjust Y position of camera

t h

HYDRA camera

Plastic cover

'Hood'
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5. X Movement System
This chapter contains adjustment and calibration instructions for the 
X movement function.

Also, it contains some procedures to measure particular values for evaluating 
purposes during calibrations.

The machine contains the following four different movement systems:

1. X movement moves the X wagon in the X direction.

2. Y movement moves the Y wagon with the assembly table in the 
Y direction.

3. Z movement moves the mount tool vertically.

4. Theta movement rotates the mount head.

 WARNING! In this chapter, some of the procedures cause the machine to make 
movements. The below warning must be followed for such procedures.
Procedures that cause the machine to make movements are marked with this 
sign next to the text. Before entering such commands, check the following: 
Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas, and that the standard tool head and the HYDRA tools are in their upper 
positions
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Show Transducer Positions

This program shows the C, Theta, X, Y, and Z positions, and the Theta and Z 
positions for the HYDRA unit, if used. Use this procedure to detect transducer 
faults or faults in the transducer wiring.

Procedure

1. If you currently run TPSys, select Restart TPSys from the Exit menu and 
press the space bar on the keyboard to get to the startup menu.

2. Select Show Transducers.

3. When prompted OK to initiate hardware? press <Enter>. The Show 
Transducers window is shown.

– Transducers named ‘Fi’ show the Theta values (in mDeg).

– The YM transducer is shown only if the machine has a tray wagon 
magazine, and the HFi and HZ transducers are shown only if the 
machine has a HYDRA unit.

– All axes, except for the X axis, are released. Use the joystick to make 
X movements.

 CAUTION! Watch the tool head during movements because the locks can be 
released, which means that the Z mechanism may go entirely down by its own 
weight.

4. When ready with  Show Transducers, exit by pressing any other key than 
<F1> on the keyboard or Camera on the machine keypad.

5. Confirm by replying Yes in the shown Exit dialog box.

 WARNING! Make sure there are no fingers in the machine moving areas and 
press <Enter> to resume the previous positions:

6. If you want to return to the startup menu, press <Space> before TPSys 
is started.

Check X-wagon Grease Pump

Use the procedure below to test the function of the X-wagon grease pump.

Procedure

1. Select Exit > Exit To Service.

2. Select Utility > Test PAIB board.

The Load board dialog box is shown with the servo file that will be 
loaded to the MOT-X board.

3. When ready, select Yes in the Load board dialog box to start the 
measurement. The PAIB Board Test information box is shown.

4. Control the Grease pump status by moving the cursor to the Grease 
pump on field and press <Space> to toggle the grease pump on or off. 

5. Press <Enter> to save the chosen setting.
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Adjustment and Calibration

Adjustments and calibrations included in the X movement section are:

– Measuring the X Belt Tension on page 5-4.

– Adjusting the X Belt Tension on page 5-5.

– Adjusting the X-Belt Pulley on page 5-6.

– Measuring the Cog Play on page 5-8.
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Measuring the X Belt Tension

This section describes how to measure the tension of the X belt, located under 
the upper covers of the machine.

Tools

– Frequency counter.

– Two prisms.

Procedure

1. Open the upper left cover using a pointed object, for example a thin 
screwdriver, see Figure 5-1.

2. Move the X wagon to its leftmost position.

3. Put the two prisms on the X rail with the flat edge upwards as shown in 
Figure 5-2, under the X belt upper part. They should be placed with a 
spacing of 900 mm ±2 mm.

4. Measure the resonant frequency on the length between the prisms. The 
belt tension is correct when the frequency is 57 Hz.

5. If the belt tension is not correct, then adjust as described in the next 
section Adjusting the X Belt Tension.

Figure 5-1.  Opening the upper machine cover.

Figure 5-2.   Measuring the X belt tension.

1 2 3 4 5 6

Insert pointed object here

900±2
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Adjusting the X Belt Tension

This section shows how to adjust the X belt tension if the measured frequency 
is not measured to be 57 Hz (see above).

A measured value below 57 Hz indicates that the belt is slack and must be 
tightened. A value above 57 Hz indicates a belt too taut and therefore needs to 
be untightened.

Procedure

1. Loosen the A and B fixing screws, see Figure 5-3.

2. Adjust the belt by turning the screws marked 'C' in Figure 5-3 as follows:

– To stretch the belt – turn screws 'C' clockwise.When stretching the 
belt, loosen the 'A' and 'B' fixing screws successively.

– Loosen the belt – turn the 'C' screws counter-clockwise.

3. Make sure that the belt is parallel to the X-rail end by adjusting the 'C' 
screws equally.

4. When satisfied with the adjustment, tighten the 'A' and 'B' fixing screws.

5. Continue by performing the Adjusting the X-Belt Pulley procedure as 
described on page 5-6.

Figure 5-3.   Adjusting X belt tension.
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Adjusting the X-Belt Pulley

This procedure is used to adjust the X belt dynamic position on the pulley after 
adjusting the X belt tension. 

The X-belt utility option in TPSys is used to run the X wagon back and forth, 
while adjusting the X-belt pulley.

Adjust the pulley using the X-belt utility as follows:

Procedure

1. Select Exit > Exit To Service in TPSys to start the service program.

2. Start the X-belt utility program by selecting Utility > Adjust X belt.

 WARNING! To simplify the adjustment the machine will move the X wagon 
continuously.

3. Loosen the 'A' and 'B' fixing screws somewhat, see Figure 5-3.

4. Adjust the dynamic position of the X belt to the center of the stretching 
pulley.

– To move the belt to the left, loosen the right C screw somewhat and 
tighten the left 'C' screw somewhat.

– To move the belt to the right, loosen the right 'C' screw somewhat and 
tighten the right 'C' screw somewhat.

5. When the X belt is centered on the pulley and does not touch the driving 
pulley flanges on the opposite side of the machine, tighten the 'A' and 'B' 
fixing screws.

6. Terminate the X-belt program by pressing any key.

7. Finally, run the X Axis Calibration on page 5-7.
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X Axis Calibration

This calibration creates correlation data for the X-wagon motor transducer and 
the X-belt motor transducer. The correlation data is inserted in a new X servo 
file.

This procedure is performed automatically on machines with MOT3D boards 
and HYDRA 21K during initialization. 

On machines with previous servo software it must be performed manually:

– After the X belt has been stretched (see section Adjusting the X-Belt 
Pulley).

– Prior to initiating the hardware if a new servo is installed.

– If mechanical parts of the X axis mechanism have been replaced or 
adjusted.

1. If you are currently running TPSys, then select Exit TPSys from the Exit 
menu.

2. Start the xCalibrate program by entering the command xCalibrate at the 
Linux prompt.

 WARNING! This will create machine movements.

3. Wait until the program is finished.
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Measuring the Cog Play

This procedure is used to adjust the X-wagon motor cog play.

It is an adjustment that shall be performed if the X-wagon motor has been 
removed for repair, or after yearly maintenance.

The procedure should be repeated for each magazine (slot) position along the 
X rail.

Procedure

1. If you are currently running TPSys, then select Exit TPSys from the Exit 
menu.

2. Press both the emergency stop buttons down, move the X wagon by 
hand to a magazine position, and release the emergency stop buttons.

3. Select X motor > Motor > Measure cog play

The Load board  dialog box is shown with the servo file that will be 
loaded to the MOT-X board.

4. When ready, select Yes in the Load board dialog box to start the 
measurement.

 WARNING! This cause machine movements.

An alternating forward/reverse force of 127 mNm is applied to the X-
wagon motor, which increases in 1 mNm steps until the X-belt motor 
transducer indicates a movement.

The system measures the cog play and presents the result in a window.

The cog play should be between 48 µm and 108 µm in all the magazine 
positions along the X rail.

5. Repeat the above procedure, on each magazine position along the X rail.

– If the received value is outside the accepted range (between 48 µm 
and 108 µm) in any of the magazine positions, adjust the cog play as 
described in the next step.
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Adjusting the Cog Play

Adjust the cog play as follows:

1. On machines with a Midas unit, remove the Midas Z motor (the Midas 
unit is described in Chapter 6 Mount Heads.

2. Loosen the three motor fixing screws ('A' in Figure 5-4) somewhat.

3. Use a metal ruler with a hole in the end. Insert this ruler behind the 
X wagon and place the hole of the ruler over a pin used to adjust the cog 
play (B).

– To increase the cog play, push the ruler to the right.

– To decrease the cog play, pull the ruler to the left.

4. Tighten the three motor fixing screws (A).

5. On machines with a Midas unit, reinstall the Midas Z-motor.

6. Run the X Axis Calibration as described on page 5-7.

(Not necessary if MOT3D and HYDRA 21K are installed).

Figure 5-4.   Adjusting X cog play
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6. Mount Heads
The MY series of machines can have two different types of placement heads:

Midas unit

This is the fine pitch single mount head on MY machines (See Figure 6-1).

HYDRA unit

The HYDRA unit is a multiple mount head with eight mount tools  (See 
Figure 6-2).

Both units are described in this section.

 WARNING! In this chapter, some of the procedures cause the machine to make 
movements. The below warning must be followed for such procedures.
Procedures that cause the machine to make movements are marked with this 
sign next to the text. Before entering such commands, check the following:
Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas. Ensure that the single mount head and the HYDRA tools are in their 
upper positions.

Figure 6-1.   The Midas Unit. Figure 6-2.   The HYDRA Unit.
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Midas Unit

The Midas unit is a highly accurate single mount head for the MY series of 
machines.

A Midas consists of two main units, the Z unit and the Theta unit (See 
Figure 6-3), which are assembled together. These two units include all devices 
needed for the Z movement and the Theta movement respectively.

In the Midas the motor and encoders are integrated with the Z shaft guided by 
stiff play-free bearings.

Electrical Parts

There are two PCBs included in the Midas Unit:

ZFIB located on top of the Theta unit. ZFIB is a connector board with a line 
driver for the Theta encoder.

FFX, which is a flexible board with Z sensors. FFX is located in between the 
ZFIB board and the tool head to allow the Theta movement.

Figure 6-3.   Z and Theta units of the Midas.

Z unit

Theta unit
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Adjustment and Calibration

This section comprises the following adjustment and calibration procedures:

– Adjusting the Cog Play on page 6-4.

– Troubleshooting on page 6-5.

Measuring Midas Cog Play

This section describes how to measure the cog play for the Midas 
Z movement.

1. If you are in TPSys you must exit to the Linux prompt. Select Exit > Exit 
TPSys.

2. Enter service -x at the Linux prompt to start the extended service 
program.

3. Select Utility > Test tools > Test of Midas > Friction test Z axis. Allow 
the test to perform.

4. Select View results on screen. You may have to press <q> repeatedly to 
see the results.

5. Exit. If the cog play needs adjustment, please see the following section.
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Adjusting the Cog Play

This section describes how to adjust the cog play for the Midas Z movement.

 The Midas Unit require adjustment of the cog play after replacing the Z motor.

Procedure

1. Carefully loosen the locking screw (see Figure 6-4).

2. Adjust the cog play. To check, press the rack gently towards and from 
the cog wheel by hand. Cog play must be as small as possible without 
increasing friction. 

3. Adjust the cog play by turning the excenter screw (see Figure 6-4).

4. Tighten the set screw.

5. Run the friction program for Z motor. If the measured friction is too 
high, readjust the cog play and remeasure the friction again.

Figure 6-4.   Adjusting the cog play.

Set screw

Excenter
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Troubleshooting

The following table shows some of the symptoms that may turn up when 
installing and running the Midas Unit.

Symptom Possible reason Suggested action

CMB in the way of Midas. Wrong CMB. Change to CMB2, part # L-029-0371-1E.

Scraping sound when 
rotating Theta.

FFX worn. Exchange the FFX board.

Theta stop in contact with 
housing.

Adjust the Theta stop.

Theta encoder broken Exchange Midas unit

Theta brushes worn out. Exchange the brushes.

High Z friction. Rack too tight. Adjust the rack.

Rack worn due to poor 
lubrication.

Exchange the rack and the Z motor.

Cable holder touches the linear 
guides.

Bend the cable holder back.

Z sensor does not work. FFX board worn or sensors 
broken.

Exchange the FFX board. See separate 
Repair Guide.

FFX board connector not 
inserted properly.

Reinsert FFX board connector.

Midas does not work. MOT2 motor board instead of 
MOT3.

Change to MOT3 board in the MOT-Z 
computer slot.

Z locks do not work. Solenoids worn out. Replace the solenoids.

Z lock bracket bent. Order new bracket or bend it back.

Theta upper/lower end 
point not repetitive.

The FFX board is too tight. Adjust the FFX board. See separate 
Repair Guide.

Theta encoder not stable. Theta stop loose. Tighten the M4 screw at the rear of the 
Midas unit.
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HYDRA Mount Head

The HYDRA system is a multiple mount head designed to pick and place up 
to eight components during the same X movement. This considerably 
increases the placement speed.

Figure 6-5.   HYDRA Unit.
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Aligning HYDRA Camera Background Reference

There are three types of reference backgrounds available:

Type 14

The standard HYDRA camera reference background.

Type 14 LSC

A reference background optimized for the Linescan Vision Camera.

Type 23 LSC

A reference background intended for bigger type of components.

Perform this procedure when a new HYDRA system is installed. In this 
procedure only a mechanical alignment is made, no parameters are modified.

This procedure can be carried out either with the HVC or the LSC.

 WARNING! This procedure will cause machine movements. Keep hands, tools 
and foreign objects clear of moving machinery.

Figure 6-6.  HYDRA reference background.
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Procedure

1. Select Utility > Installation and Calibration.

2. Select Adjust HYDRA reference background and the camera to use when   
performing this procedure.

The X wagon moves to the selected camera. Depending on the selected 
camera, the system shows different camera views.

Figure 6-7 shows the camera view when the HYDRA Vision Camera 
(HVC) is used. Figure 6-8 shows the camera view when the LineScan 
Camera (LSC) is used.

3. Check the alignment of the reference background by verifying that, the 
two small red crosses are positioned in the middle of the white reference 
points on both ends of the reference background. If necessary, the 
reference point background can be adjusted mechanically in horizontal 
(Y) and/or theta direction as described in points 4 - 7 below.

Figure 6-7.  HVC view

Figure 6-8.  LSC view
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4. Loosen the two 2.5 mm screws under the reference background with an 
allen key.

5. Adjust the reference point background in horizontal (Y) and/or theta 
direction with the two (0.9 mm) set screws, situated against the HYDRA 
chassis, perpendicular against the tools.

6. Adjust the reference background until the two small red crosses are 
positioned in the middle of the white reference points
(See Figure 6-7 and 6-8) at both ends of the reference background.

7. When satisfied, fasten the (2.5 mm) screws.

8. If you are satisfied with the result, select Ready in the shown dialog box 
and press <Enter> to exit the procedure.
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Adjustment and Calibration

This section comprises the following adjustment procedures:

– Adjusting Z-indicator Levellers (HYDRA 2D) on page 6-10.

– Cog Play Adjustment on page 6-11.

Adjusting Z-indicator Levellers (HYDRA 2D)

Below the swivel there is a cylinder acting as the z-indicator leveller. If the z-
levels need adjustment the cylinder can be adjusted up and down.

The cylinder is connected to the vacuum pipe with an M2 screw. Be sure to 
use thread lock Loctite on the screw after adjustment.

Figure 6-9.  Adjusting z-indicato.r
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Cog Play Adjustment

1. Run the HYDRA Service program, HZ Cog Play. Follow the instructions 
given by the program.

Depending on the result from the extended service program, reduce or 
increase the cog play as follows:

2. Loosen the locking screw (’1’) in Figure 6-10).

3. Turn the eccentric adjustment screw (2) slightly to reduce (too little cog 
play) or increase (too much cog play) the pressure of the bearing against 
the gear rack.

– From the mid position, the pressure is increased in both clockwise and 
counter-clockwise direction.

– If it is difficult to reach the correct adjustment in both upper and lower 
position, chose a loose setting rather than adjusting the cog play too 
tight.

4. Tighten the locking screw.

5. Run the HZ Cog play test again and repeat the adjustment if necessary.

Figure 6-10.   HZ Cog play adjustment.
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Troubleshooting

The following section covers some of the symptoms that may turn up when 
installing and running the HYDRA Unit. To perform some of the following 
tests, run the HYDRA Service program. Follow the instructions given by the 
program.

Check List

Before commencing any troubleshooting on the HYDRA unit, verify that 
measured values are in accordance with the values mentioned below.

Mechanics/movement

• Check the HZ and H-Theta operating ranges and the transducer deviations, 
if any. 

– The HZ operating range shall be 2 056 - 19 500 ±500 units (tics). 

– The H-Theta operating range shall be 2 056 - 19 500 ±500 units.

• The transducer deviation during operation should be less than 10 units for 
the HZ with no time limitation, and less than 100 units for the H-Theta 
during 100 cycles.

• Measure the HZ static friction. 

– The minimum force required to move the HZ wagon from a static 
position, above the tool latches, should be 0 - 6 force units 
approximately.

• Measure the HZ dynamic friction. 

– The minimum force required to move the HZ wagon across the 
operating range with some or all latches activated should be 4 - 12 
force units approximately.

• Check the HZ cog play. 

– The play between the HZ motor and the rack should be 5 - 12 tics. A 
low value means high friction. A high value could result in wear and 
bad servo regulation. The results from three consecutive readings (in 
the same Z position) must differ less than 3 tics.

• Measure the H-Theta dynamic friction.

– The minimum force required to move the H-Theta across the 
operating range should be 18 - 40 force units approximately.

• Each HYDRA tool must have an eccentricity (wobble) less than 0.08 mm.

• In lowered position, the difference in height between the lowest and highest 
tool must be less than 0.3 mm.

• Tool tips must not be worn or damaged. Clean with alcohol.

• The spring load on each HYDRA tool should be within 1.10 - 1.25 N.

• While turning the HYDRA theta belt, the belt must wander <1 mm Z wise 
across the belt wheels. If not, replace the belt.

• Ensure that all tool clamps are properly seated into the Theta couplings.
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Vacuum

• Measure the vacuum levels at open, partly open and closed vacuum system, 
see Chapter 10.

– For an open system, the level should be 60 - 80 units
(vacuum) approximately.

– A closed system should show 200 - 230 units approximately.

– When one valve is open, the vacuum system should show 160 - 200 
units approximately

• The vacuum sensor must indicate the atmospheric pressure within 0.01 bar, 
and a negative pressure of at least 0.4 bar.

Impact sensors

• Use the Check leds, current 0-15 feature in the Motqom menu. 

– Make sure that the light levels for the indicators are at 180 - 190 at 
current level 7 in the table. If not, adjust the position of the HYDUBB 
Ed-2 board.

• Check the correlation between indicator level and the angle of the H-Theta. 

– Verify that the variations do not exceed 15 units. Otherwise, the 
electronics make an incorrect decision as to weather or not an impact 
on a surface has been made, due to the angle of the H-Theta.

Tool latches

• Check the function of all the tool latches. In case of malfunction, measure 
the electrical resistance in each solenoid (85 ±5 W).

• Measure the individual HZ tool latch positions.

– The latch height levels shall be 4 200 - 4 900 units (tics).

– The deviation from the lowest to the highest level must be less than 
150 units. The variation between three consecutive measurements 
should be <50 tics.

• Check the indicator gain. 

– The correct value should be in an interval of 200 - 600 units. 

– A unit is defined as 1/1000 indicator unit per tic i.e. if HZ moves 
100 tics downwards and the gain is 600 units, the indicator should 
change 100x600/1000=60 units.
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Electronics

• Check the HYDB board function, the board supply voltage level, and the 
motor temperature.

– To indicate a proper function, the green LED on the board shall blink 
with the light on 75 % of the time.

– A fault in the communication is indicated with a blinking light which 
is on 25% of the time.

– The board supply voltage shall be approximately 25 Volt (18 - 26 V).

– The HZ motor temperature should not exceed 75 °C.

Vision

• Check and clean the Linescan and HYDRA camera optics, mirrors and 
protective glass.

• Clean the camera reference background and check for even the smallest 
scratch or damage. Align the camera if a HVC is installed.

TPSys

• Ensure that the setting of the HYDRA angle in the Package List is 90°.

• Ensure that the Small chip lead type is not used in the package data (unless 
otherwise is clearly stated).

• Ensure that the TPSys package data corresponds to the real components.



MYDATA MY9 – MY12 – MY15 – MY19  Mount Heads

P-040-0070-EN – Service Manual Rev. 0000  2008-06 6 - 15

Troubleshooting Actions

To perform some of the following tests, run the HYDRA Service program in 
the extended service program. Follow the instructions given by the program.

For each test in Test specific system there are defined limits. These limits are 
stored in a separate text file.

When the control of limits is performed the system generates a number of error 
messages. Refer to the table below for information about a specific error 
message.

Symptom (Error Message) Suggested action

HZ- or HTheta working range assumes 
unreasonable figures and limits

Reload MOT-Z and re initiate. 

If the error repeats itself it may be caused by problems with the 
MOT-Z or a bad transducer coupling.

HZ and HTheta within limits, but too 
big transducer drift

Check that the transducer is properly connected and that no 
outside currents interfere.

HZ start friction or movement friction 
very high:

Check that the shaft or guide bearings are not damaged or dirty. 

Make sure the rack is not too tight. 

Check if there is current to the HZ- motor.

HZ cog play too big or too small Adjust the rack.

HTheta friction very high Make sure all tool holders are properly in position. Try 
manually, with zero motor current, to move the belt back and 
forth.

If the friction feels uneven the belt is probably deformed. Run 
burnin on HTheta or change belt.

Also check each bushing.

Vacuum levels out of bounds Make sure the vacuum pump is working properly. Apply 
vacuum for each tool and feel with the finger tip. Check filters 
and look for possible leakage.

Bad current levels for the indicators, or 
no indication of hit

Use ‘Check leds, current 0-15’ in the single command menu. 
Make sure that the light level for the indicators is at correct 
values at current level 5 in the table.

If not, then the indicators are not adjusted properly, and may 
have to be readjusted.

Repeated problems may be caused by poorly adjusted sensors, 
bad LEDs or the light path may be obstructed. Also worn out tool 
springs may generate disturbances or even indications of a hit.

Indicator variation is too big when 
turning HTheta

Check if the upper part of the tool mechanism wobbles too much.

Check if the lower edge of the housing, which obstructs the light 
beam from the LED, is uneven.

Tool latches don’t work Check if the latches can be activated in a position were the HZ-
wagon is out of the way. A burnt solenoid can be detected by its 
distinct smell.

Check that there is no mechanical obstacle for the latch itself by 
moving it by hand.

Uneven levels between the tool latches If one or more latches operates at a different height or out of 
bounds, it may be caused by a poorly adjusted solenoid pack. 
Make sure the latch does not move too much z-wise.

The problem may also be caused by a bad HZ-indicator.

Tool spring length too small Adjust the latch fingers upwards. You need to remove the 
vacuum module (white or translucent) to see the three screws 
holding the latch fingers in place. Loosen the screws and move 
the shaft upward.



Mount Heads MY9 – MY12 – MY15 – MY19  MYDATA

6 - 16 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Tool spring length too big The latch finger misses the rim of the tool mechanism. This 
causes failure when e.g. measuring board height. Adjust 
solenoids outwards, by adjusting the position of the brackets 
attached to the HZ-frame.

Make sure that the latch finger does not hit (noticeable as a 
metallic sound) the tool mechanism when the latch is actuated. 
A perfectly adjusted latch should make more of a ’thud’-sound.

Problems of malfunctions Reload MOT-Z and initiate HZ and HTheta.

Make sure the motor is not too hot. 

Check if the fan works properly.

Investigate if the motor windings smell burned. 

Check the position of the brackets attached to the HZ-frame.

Symptom (Error Message) Suggested action
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7. Tools & Tool Banks
This chapter contains a description of the different tools and tool banks used 
on MYDATA placement machines.

– Single Mount head Tools on page 7-2. 

The single mount head tools used on the Midas unit.

– HYDRA Mount Tools on page 7-9.

The HYDRA mount tools used on the HYDRA unit.

– HYDRA Automatic Tool Exchanger on page 7-11.

HYDRA Speedmount ATE, Automatic Tool Exchanger, is a system 
for changing HYDRA tools automatically

 WARNING! In this chapter, some of the procedures cause the machine to make 
movements.The below warning must be followed for such procedures.
Procedures that cause the machine to make movements are marked with this 
sign next to the text. Before entering such commands, check the following:
Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas, and that the standard tool head and the HYDRA tools are in their upper 
positions.
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Single Mount head Tools

The following two types of single mount head tools are available for the Midas 
unit on MYDATA placement machines:

The main difference between these two types of tools is that the spring-loaded 
tools provide a faster mounting speed by utilizing the Intelligent Surface 
Impact Control (ISIC) function.

Both types are intended for the same component ranges. The A14S, A23S, 
A24S and C23S tools are spring-loaded versions of the A14, A23, A24 and 
C23 stiff tools.

 To get full Linescan Vision System performance, it is necessary to use spring-
loaded tools.

Figure 7-1.  Stiff tools.

Figure 7-2.  Spring-loaded tools.
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Single Mount head Tool Installation

This procedure is used to install the single mount head tools, spring-loaded or 
stiff, before they can be used for placement or adhesive application.

 WARNING! This procedure cause the machine to make movements. Ensure 
that there are no foreign objects on the assembly table, near the tool bank, or 
within the X wagon, Y wagon, or Tray Wagon Magazine moving areas, and 
that the standard tool head and the HYDRA tools are in their upper positions.

Procedure

1. Select Utility > Installation and Calibration > Tool Installation > Install 
tools.

2. The Select tools to install dialog box is shown and a submenu with the 
following three options is opened.

– All tools

Including tools that have been previously installed.

– All uninstalled tools

Only the tools that are not installed.

– Specific tool

Only one specific tool. You have to choose which specific tool you 
want to install. Press <Space> to show a list of available tools.

3. When prompted, trim the tool positions by centering the cross hairs on 
the selected tools and confirm the positions with Ready.

This window is also used to edit installed tools.

 CAUTION! The Spring parameter must be set to No when a stiff tool is used 
otherwise there is a risk to get uncontrolled placement forces or impact forces 
which may damage the component and the board or the mount head. Always 
check that the parameters are correctly set when a tool is exchanged.

CAUTION! Because of the wide tool body compared to the tool tip on A23S 
and A24S, there is a small but not negligible risk for collision between the tool 
body and tall components already placed, or between the tool body and the 
rails of the conveyors. This risk does not apply to the C23S tool. To limit this 
risk it is advisable to mount low components before mounting high 
components.



Tools & Tool Banks MY9 – MY12 – MY15 – MY19  MYDATA

7 - 4 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Installing a Tool Bank

1. Select Utility > Installation and Calibration > Tool Installation > Install 
tool bank in TPSys. The Select tool bank type dialog box is shown.

2. Press <Space> to show a list of available tool banks (See page 7-5 for 
various tool bank layouts).

The standard tool bank has the following layout:

Tool numbering and usage 
are further detailed in the 

Programming Manual.

The tool body on the A23S, A24S and C23S tools are wide (Ø9.5mm) 
therefore the A23S and A24S tools will not fit in some tool banks. Check that 
the tool bank is compatible with the tools you are planning to use. If the tool 
bank is not compatible with the tools, you may require an upgrade kit (see the 
table below).

 An A23S tool has the same code pin configuration as the corresponding stiff 
tool A23. The same applies for A24S and C23S. It is therefore not possible to 
use a spring-loaded tool and the corresponding stiff tool simultaneously.

Removing a Tool Bank

1. Select Utility > Installation and Calibration > Tool Installation > 
Remove tool bank.

The Remove tool bank dialog box is shown.

2. Select which tool bank to remove from the list of installed tool banks.

3. Press <Enter> to remove the selected tool bank.

Figure 7-3.  Example of tool bank layout.

Tool bank related to mount table
Compatible with 

tools
Requires 

upgrade kit

ML tables (ML3, 4, 5, 6) A23S, A24S, C23S

500T2 Conveyors (pre. 2001-08-20) C23S L-015-1616

500T2 Conveyors (post. 2001-08-20) A23S, A24S, C23S

400PT Conveyors A23S, A24S, C23S

420PT Conveyors (pre. 2001-08-20) C23S L-015-1615
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Tool banks

These tables can be used to identify the bank in the machine when asked to 
Select tool bank type at installation above. “TP” in these tables indicates the 
test position, that is the tool check position. 

Y wagon 288

ML 3/4/5

B24 B34 C12 C13 C14 C23 C24 C34 D12 D13 D14

A12 A13 A14 A23 A24 TP A34 B12 B13 B14 B23

C23 C24 C34 D12 D13 D14 D23

A12 A13 A14 A23 A24 A34 B12 B13 TP B14 B23 B24 B34 C12 C13 C14
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ML 3/4/5 ATE

ML 6

ML 6 ATE

T conveyor 500T and 500T2

B34 C12 C13 C14 C23 TP C24 C34 D12 D13 D14

A12 A13 A14 A23 A24 A34 B12 B13 B14 B23 B24

A12 A13 A14 A23 A24 A34 B12 B13 TP B14 B23 B24 B34 C12 C13 C14 C23 C24 C34 D12 D13 D14 D23

A12 A13 A14 A23 A24 A34 B12 B13 B14 B23 B24 B34 C12 C13 C14 C23 TP C24 C34 D12 D13 D14

A12 A13 A14 A23 A24 A34 B12 B13 B14 TP B23 B24 B34 C12 C13 C14 C23 C24
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PT conveyors

PT Conveyor 400PT.

 

If the tool bank on the machine does not match any of the above layouts, the 
installation can proceed anyway. These layouts are used by TPSys to provide 
good initial guesses as to tool positions and tool check positions. The positions 
can be manually located in case of an unknown tool bank.

If the tool bank is not of a known type, choose the “custom” type. Then locate 
the tool bank on the Y-wagon. TPSys will guide you through this procedure.

The tool and glue tool check positions must also be located. The machine will 
offer a default position for these, but the position must be located manually. In 
this case, the default positions of the mount tools will also be incorrect, and 
they will need to be located with the joystick when they are installed.

400PT  420PT 450PT

TP D23 C24

D14 D14 C23

D13 D13 C14

D12 D12 C13

C34 C34 C12

C24 C24 B34

C23 C23 B24

C14 C14 B23

C13 C13 B14

C12 C12 B13

B34 B34 B12

B24 B24 A34

B23 B23 A24

B14 B14 A23

B13 B13 A14

B12 B12 A13

A34 TP A12

A24 A34 TP

A23 A24

A14 A23

A13 A14

A12 A13



Tools & Tool Banks MY9 – MY12 – MY15 – MY19  MYDATA

7 - 8 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Custom Tools

In some cases, custom tools may be bigger than 10 mm in diameter – the size 
of the biggest standard tools C23 and C23S. 

The three following parameters in the Edit tool dialog box must be set if this 
is the case:

• Lower edge of code pins

Measure with auto install with the biggest tool installed.

• Tool case diameter

Measure with auto install with the biggest tool installed.

• End of fast margin for C

Measure the dimension of the biggest part of the tool. Use the diameter on 
round tools, or the diagonal on other tools. Add 1mm. If, for example, the 
tool has a diameter of 21 mm, set the parameter to 22 mm.

Follow the procedure below to set the parameters for a specific tool.

1. Utility > Tool Installation > Edit tool

The Select tool to edit dialog box is shown.

2. Press <Space> and select the tool to edit from the list.

The Edit tool dialog box is shown (see Figure 7-4).

3. In the shown dialog box, set the parameters as desired.

Figure 7-4.  Edit tool dialog box.
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HYDRA Mount Tools

The HYDRA mount tools consist of a tube with a changeable nozzle (H03 – 
H06), see the figure 7-5.

There are, for the time being, six types of HYDRA tools intended for different 
sizes of component packages. Each tool type has its own identification color 
on the top of the nozzle. Mount tools must be kept free from dirt and foreign 
particles to prevent the tubes from being clogged up. 

The HYDRA mount tools can be changed manually or by using the HYDRA 
Speedmount ATE, Automatic Tool Exchanger system mentioned below.

Figure 7-5.  HYDRA mount tools.

Nozzle

Tool tube

H01        H02          H03          H04           H05          H06       
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HYDRA Tool Tubes

The HYDRA tool tubes are attached to the HYDRA unit.

The HYDRA unit moves to the HYDRA tool bank where the tool tubes leave 
the current tools before picking up new ones.

Each tool is held in place on the tool tube by two O-rings. This ensures that the 
tool is always properly aligned and can be replaced without re-calibrating the 
HYDRA unit.

Figure 7-6.  HYDRA 2B Tool tube.

Figure 7-7.  HYDRA 2D Tool tube.
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HYDRA Automatic Tool Exchanger

HYDRA Speedmount ATE, Automatic Tool Exchanger, is a system for 
changing HYDRA tools automatically.

Instructions regarding how to operate the ATE system can be found in the 
Operators Manual.

The ATE system comprises the following parts:

– HYDRA Mount Tools on page 7-9.

– HYDRA Tool Tubes on page 7-10.

– HYDRA Tool Bank on page 7-12.

In the following text, the HYDRA ATE tool bank is called HYDRA tool bank 
or just tool bank.
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HYDRA Tool Bank

The HYDRA tools are stored in the HYDRA tool bank when not in use. When 
the tools are to be exchanged, the HYDRA unit moves to the bank and the tools 
are exchanged.

Each tool resides in an own position in the tool bank. When a tool is 
automatically fetched by the HYDRA unit, it is considered that the HYDRA 
unit has borrowed the tool from the tool bank. So, all the tools reside in their 
own tool bank positions but are temporarily attached to the tool tubes on the 
HYDRA unit.

The first tool tube (position 1 in the HYDRA unit) fetches a tool from one of 
the two tool slots with index No. 1 in the tool bank, see Figure 7-8. The second 
tool tube (position 2 in the HYDRA unit) fetches from one of the slots marked 
2, and so on.

Figure 7-8.   HYDRA ATE tool bank.
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Bank types

There are two types of HYDRA tool banks:

Standard type

For T-type conveyors and 288, 468 and ML 3-6 tables, see Figure 7-9.

PT type (Pass-through)

For 400 PT and 420 PT conveyors, see Figure 7-10.

Figure 7-9.   Standard tool bank.

Figure 7-10.  PT Tool bank.
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Bank Parts

A HYDRA tool bank consists of the following parts (see Figure 7-11 and 
Figure 7-12):

– A housing.

– A lid with recessions underneath to ensure the positioning of each 
tool.

– A spring that presses the tools against the lid.

– Four mounting screws for the lid.

Figure 7-11.  HYDRA tool bank parts – new type.

Figure 7-12.  HYDRA tool bank parts – old type.

Hole for mountbolt
Spring

Lid

Screws for the lid

Housing

Hole for mountbolt

Spring

Lid

Screws for the lid

Housing
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Bank Positions, Slots and Rows

A HYDRA tool bank can hold up to 16 tools in two rows by eight tool 
positions, see Figure 7-13.

– A slot has two positions, a front position and a back position.

– A tool position can hold one tool.

– The rows are called Front (marked ‘F’) and Back (marked ‘B’) 
corresponding to their Y positions in the tool bank. Front is the row 
facing the operator.

Figure 7-13.  Tool bank positions, slots and rows.

Slot

Row
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Installing HYDRA Tool Bank

This procedure is used to install the HYDRA Tool bank. Perform this 
procedure after installing a new HYDRA Tool bank or after replacing, or 
moving the HYDRA Tool bank. If the spring has been replaced, perform this 
procedure.

Create New Fiducial Mark

TPSys need fiducial marks to be able to locate the bank positions on the 
Automatic Tool Exchanger (ATE) tool bank. Therefore first create a new 
fiducial mark in TPSys, and make TPSys recognize this mark type.

Each tool bank has two fiducial marks of the same type. This mark type is to 
be recognized by TPSys.

1. Select Edit > Fiducial Marks. The Fiducial Marks window is shown.

2. Press <Ins> in the Fiducial Marks window, this will open the Create 
New Fiducial Mark box.

3. Type the name and user comment for the new fiducial mark called: 
hydrabank (in one word). Note that only this name can be used for this 
purpose.

4. Enter the following data:

– Type: Circle

– Diameter: 1 mm

– Color: Dark or Bright depending on type of toolbank. For the new 
type of toolbank use – Dark.

– Search area width: 1.5 mm

– Search area length:  1.5 mm

5. Press <Enter> to save the new fiducial mark.

6. Activate the teach function by pressing <F5>.

7. Use the joystick or trackball to move the x-wagon camera until the 
fiducial mark is centered in the x-wagon camera field of view. Confirm 
the position by pressing <Enter>. A graphical overlay in the form of a 
yellow rectangle is shown on the screen.

8. The teach area can be adjusted with the joystick or trackball. When 
ready, press <Enter> to confirm the size of the teach area. The detected 
fiducial mark is outlined on the screen with a graphical overlay in green.

9. Press <Enter> to confirm the size of the search area.Locate and center 
one of the fiducial marks on the tool bank by using the joystick or 
trackball. Press <Enter> when ready.

10. The yellow rectangle, shown on the screen represents the teach area.
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11. Use the joystick or trackball to adjust the size of the teach area until the 
yellow rectangle completely covers the fiducial mark. Press <Enter> 
when ready.

12. The fiducial mark is taught and the result is shown on the screen.

13. Proceed with the next section.

Install HYDRA tool bank

1. Select Utility > Installation and Calibration > .HYDRA Tool 
Utility > Install HYDRA tool bank.

2. Select a tool bank to install from the shown list.

3. Select type of tool bank to install.

– Choose PT type for Pass-Through Conveyors.

– Choose Standard for all other Y wagon solutions.

4. Make sure the tool bank is empty.

 CAUTION! If a tool is left in a tool position, then the tool tube for that position 
will most certainly be bent.

When prompted, confirm in the shown dialog box that the tool bank is 
empty.

5. Center the first fiducial mark, located to the left of the tool bank, by 
using the trackball or joystick and confirm.

6. Center the second fiducial mark, located to the right of the tool bank, in 
the same way as the first one.

TPSys will now measure the scale, angle and level for the tool bank, and 
if the tool bank seems to overlap an already installed tool bank.

If the measured values are inside the defined limits, the system will ask 
if you accept the scale and angle deviations.

If the values are outside the limits you must adjust the tool banks as 
described in section Adjusting HYDRA Tool Bank Position on page 7-19.

If you accept, then the installation is complete.

7. You can now insert tools in the tool bank as described in the Operator’s 
Manual.
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Uninstalling HYDRA Tool Bank

This procedure is used to uninstall a HYDRA tool bank from the system. 
Perform this procedure when you want to replace or remove a HYDRA tool 
bank.

 Make sure the HYDRA tool bank is empty from tools, before uninstalling the 
tool bank. Refer to the Operator’s manual for instructions regarding the 
removing of tools.Uninstalling a non-empty tool bank means that the 
information about the inserted tools is lost and the tools must be removed 
manually.

Procedure

1. Select Utility > Installation and Calibration > HYDRA Tool 
Utility > Uninstall HYDRA tool bank.

2. Select the tool bank to be uninstalled from the shown list in Select 
HYDRA tool bank to uninstall dialog box.

3. If the tool bank is not empty you have to confirm that you want to 
uninstall a non-empty tool bank. The tool bank is now uninstalled from 
TPSys.
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Adjusting HYDRA Tool Bank Position

If the tool bank scale, angle or level measurement values are outside the 
defined limits in the installation, you must adjust the tool banks as described 
below.

The adjustment description comprises:

– Adjust Tool Bank Angle.

– Adjust Tool Bank Level (288 and 468 ATE Base Tool Bank only).

– Overlapping Tool Banks.

Adjust Tool Bank Angle

If the angle deviation was outside the defined limit during the tool bank 
installation.

1. Loosen the two tool bank mounting screws and tap it carefully to a 
correct position.

2. Tighten the two mounting screws.

3. Run Install HYDRA tool bank, see page 7-16.

Adjust Tool Bank Level

This description is applicable for 288 and 468 board handling systems only.

 CAUTION! If you have altered the tool bank height – you must reinstall the 
tool bank. The machine can be damaged due to new tool bank height.

If the level was too low during the tool bank installation, you can place shims 
(see Figure 7-14) under it. Use a single or a combination of shims. An ATE 
Base Tool Bank Upgrade Kit contains 1mm, 2mm and 3mm shims (2 pieces 
of each).

Overlapping Tool Banks

If the system senses that a tool bank seems to overlap another tool bank during 
the installation, the installation will fail. This will occur if you try to install a 
tool bank that is already installed.

Figure 7-14.  Shim.
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8. Mechanical Centering and Verification
This chapter describes the mechanical centering system. It contains a 
description of the system, adjustment and calibration information.

 WARNING! In this chapter, some of the procedures cause the machine to make 
movements. The below warning must be followed for such procedures.
Procedures that cause the machine to make movements are marked with this 
sign next to the text. Before entering such commands, check the following:
Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas. Ensure that the single mount head and the HYDRA tools are in their 
upper positions.

The mechanical centering system centers and aligns the components 
mechanically when held by the single mount head tool.

The mechanical centering system is also a mechanical and electrical verifier 
system that verifies the component dimensions and electrical values prior to 
placing the components.

Figure 8-1.  C60 Mechanical centering system.
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Mechanical Centering

Two centering jaws move symmetrically in a C movement towards each other, 
see Figure 8-2. They move until they both touch the component. The 
component is moved to the rotational center of the tool (centering and 
aligning). In this position the external dimensions and electrical data are 
verified. The centering jaws then retract.

The assembly process continues if the component was not rejected at the 
verification above. A rejected component is put into a reject bin, put back, or 
manually removed.

For most common, packages the tool with the component is rotated 90° by the 
Theta movement to be centered and verified a second time. Packages can be 
programmed to use up to twelve mechanical centering phases. See the 
Programming Manual for more information.

Mechanical Verification

Mechanical verification means that the centering jaws measure the external 
dimensions of the component during mechanical centering. The component 
dimensions specified in the package list are used at this verification. 
Components that do not meet the mechanical specifications are rejected, see 
the next section.

Electrical Verification

Electrical verification means that electrodes on the centering jaws measure 
electrical parameters of the component during the mechanical centering. 
Component values and tolerances defined for each component, and are used 
during this verification.

Components that do not meet the electrical specifications are rejected.

Figure 8-2.   Centering and verifying.
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Adjustment and Calibration

This section contains adjustment and calibration instructions for the 
mechanical centering system.

The following procedures are covered by this section:

– Measuring the Centering Base Level on page 8-3.

– Adjusting the Centering Unit on page 8-4.

– Cable Resistance Measurement on page 8-5.

– Measure friction on the Centering Device on page 8-6.

Measuring the Centering Base Level

This procedure measures the vertical position of the centering jaws, which 
equals the base centering level (see the figure 8-3).

The mechanical centering level must be measured if the centering jaws have 
been loosened or replaced.

It should also be performed as the first step if a mechanical centering or 
electrical verification problem occurs.

1. Select Utility > Installation and Calibration > CALIBRATION  >   
Centering Base Level measurement or Centering 2 Base Level 
measurement.

2. Press <Space> when the Measure centering base level dialog box is 
shown. The installed tools submenu is shown.

3. Select the smallest tool available (that is used for mechanical centering) 
from the submenu.

4. When ready, press <Enter>. The vertical position of the centering jaws 
is measured.

If the value in the following dialog box is confirmed, then the new value 
is stored as parameter 21.0221 Centering; Centering base level which 
normally equals centering level Number 1.

Figure 8-3.   Mechanical centering levels.
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Adjusting the Centering Unit

In this procedure the adjustment will compensate for any C misalignment in 
the centering device. This must be measured if the centering jaws have been 
loosened or replaced.

1. Prior to this adjustment you will have to perform the Centering Base 
Level measurement.

2. Read off the field C misalignment when the procedure is completed.

3. If the C misalignment exceeds 5µm, then the centering device should be 
adjusted as follows.

4. Loosen locking screws (’1’ in Figure 8-4).

5. Adjust the micrometer (’2’) on the centering unit to counteract the 
indicated C misalignment.

6. Tighten the locking screws.

7. Repeat the procedure until the misalignment value is within accepted 
range.

Figure 8-4.   Adjusting the centering unit.
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Cable Resistance Measurement

This procedure is used to measure the cable resistance in wires included in the 
electrical verification circuit, and to update this value in the system.

The cable resistance has effect when verifying low ohm resistors only, see 
below.

This must be measured if the centering jaws have been replaced.

Requirements

– Zero ohm resistors are required to perform this measurement.

Procedure

1. Select Utility > Installation and Calibration > Cable resistance 
measurement.

2. Select package. By default, package 1206-09 is highlighted.

3. When prompted, select the Measuring angle, which is 90° for 2-pole 
components.

4. Select Manual or Magazine pick method. The latter requires a magazine 
loaded with zero ohm resistors.

If you have selected manual pick, apply manually a zero ohm resistor with the 
selected package to the tool tip in 0 degrees. Press <Enter> when ready.

This procedure updates the 111.0002 Right X wagon; Cable resistance or 
111.0012 Left X wagon; Cable resistance parameter. The default value for this 
parameter is 0.6 ohm. If incorrect it only has effect on resistors with a 
resistance of less than 50 ohm approximately.
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Measure friction on the Centering Device

1. Select Exit > Exit To Service.

2. Select Motor > C motor > Measure friction.

3. Measure the friction with the default speed value suggested in the shown 
dialog box.

The Measure command starts the friction measuring. 

After completed measuring, the friction is shown in a pop-up window.

Measured friction values for the C-axis should be maximum 1 112 mN.

Replace Centering Jaws

1. Check the wiring before disconnecting the cables to the XTC board so 
that you can reconnect properly.

2. Remove the old jaws (see figure 8-5) and replace with new ones.

 Make sure the cables can run smoothly by pressing the centering jaws gently 
together by hand.

3. Perform the procedure Measuring the Centering Base Level on page 8-3.

4. Measure Z-unit offset.

5. Measure Z-unit offset if the received C misalignment value is outside the 
accepted range, see page 8-4.

6. Perform the Cable Resistance Measurement on page 8-5.

7. Make a test assembling.

Figure 8-5.  Centering Jaws.
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9. Vision Systems
This chapter contains a description of the different cameras and vision systems 
used on MYDATA placement machines.

This chapter is divided into the following two parts.

– X-wagon Camera on page 9-2.

– Optical Centering Systems on page 9-5.

The optical centering cameras, Standard and Dual Vision System, 
HYDRA Vision System and Linescan Vision System.
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X-wagon Camera

This section describes the positioning vision system. It contains a description 
of the system, adjustment and calibration information.

The positioning vision hardware consists of a camera located on the X wagon, 
therefore called the X-wagon camera. This camera faces downwards and is 
used for acquiring images of boards, magazines and trays. The operator uses 
it to locate various objects in the machine.

TPSys is able to automatically analyses the images taken by the X-wagon 
camera. It can use these images to:

• Set the PCB coordinate system by finding the PCB reference fiducial marks.

• Locate magazine positions.

• Locate TEX tray pallets.

• Locate components on trays before picking them.

• Locate local fiducials to a component mount position.

 WARNING! In this section, some of the procedures cause the machine to make 
movements. The below warning must be followed for such procedures.
Procedures that cause the machine to make movements are marked with this 
sign next to the text. Before entering such commands, check the following:
Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas, and that the standard tool head and the Hydra tools are in their upper 
positions.

 CAUTION! Camera units contain components that can be damaged by 
improper handling. Do not put fingerprints on any optical parts. Avoid 
exposing the camera to a dusty environment. Mirrors and CCD cameras are 
factory adjusted and must not be readjusted.
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Adjusting the X-wagon Camera Focus

At delivery the camera's focus is preset to a nominal 23.7 mm. This is the 
distance between the lowest part of the camera's illumination unit, and the 
upper surface of the PCB on the Y wagon. Sometimes the camera focus may 
need adjustments.

 Note that the camera has to be calibrated after this adjustment, and that the 
assembly table place area must be calibrated as well.

Procedure

1. Insert the calibration board (L-029-0220F or later) on the Y wagon.

2. Start the calibration by selecting: Utility > Installation and 
Calibration > X-wagon camera calibration

3. Center the camera on the calibration board pattern.

4. Make sure the emergency stop buttons are pressed down.

5. Remove the cover on the machine to gain access to the camera unit.

On the front of the camera unit, about 15 mm below the Sony camera, 
there are three holes. Two of which are threaded, see Figure 9-2.

In each of the threaded holes there is a locking screw for the lens system. 
The unthreaded hole is used for focus adjustment.

Figure 9-1.  L-029-0220F.
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6. Loosen one of the locking screws that locks the lens system.

7. Insert a screw driver in the unthreaded hole and apply a gentle force.

8. Unscrew the other locking screw that holds the lens system. The lens 
system can now be moved up and down with the screw driver.

9. View the image on the monitor and adjust the focus.

10. When ready, tighten the locking screws before removing the screw 
driver.

11. Put back the cover.

12. Release the emergency stop buttons.

13. Calibrate the camera in TPSys.

Figure 9-2.   Camera unit, front view.
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Optical Centering Systems

An optical centering system consists of a camera which acquire an image of a 
component held by a mount tool, and software which can identify, inspect and 
calculate the exact position and angle of the component relative the mount 
tool. The system then calculates the position and angle for the mount tool to 
place the component correctly on the PCB.

 WARNING! In this section, some of the procedures cause the machine to make 
movements. The below warning must be followed for such procedures.
Procedures that cause the machine to make movements are marked with this 
sign next to the text. Before entering such commands, check the following:
Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas, and that the standard tool head and the Hydra tools are in their upper 
positions.

 CAUTION! Camera units contain components that can be damaged by 
improper handling. Do not put fingerprints on any optical parts. Avoid 
exposing the camera to a dusty environment. Mirrors and CCD cameras are 
factory adjusted and must not be readjusted.
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Standard and Dual Vision Systems

SVS, Standard Vision System

The SVS, Standard Vision System, is a single camera system with a field of 
view (FOV) of 55.4 mm x 41.5 mm. This system is intended for optical 
centering and inspection of a wide range of parts, from SO packages with only 
a few leads to large fine pitch QFP packages and BGA packages with generic 
bump patterns.

The camera unit is called SVC, Standard Vision Camera. The SVC camera 
unit is shown in Figure 9-3.

DVS, Dual Vision System

The DVS, Dual Vision System, is a camera system with two different fields of 
view (FOV’s), 55.4 mm x 41.5 mm for the standard camera and 17.3 mm x 
12.9 mm for the high resolution camera (HRC).

Figure 9-3.  SVC camera unit.
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Figure 9-4.  DVC camera unit.
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Standard and Dual Vision Systems Mechanical Calibration

Sometimes it may be necessary to adjust the Y position of the camera unit 
mechanically.

 Do not adjust a DVC unit mechanically if the SVC is calibrated.

1. To adjust the camera Y position, remove the component bin and camera 
cover. Loosen the four screws as depicted in the figure.

2. Adjust the camera unit, in the Y-wise direction, until the cross hairs are 
centered to the calibration pattern (Calibration plate L-029-0506-3).

3. Tighten the four screws and check that the calibration pattern is still 
centered. If not, loosen the screws again and repeat the adjustment 
described above.

4. Confirm in TPSys that the Y adjustment is completed.
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HYDRA Camera

The HYDRA camera takes images of components picked by the HYDRA unit. 
It takes an image of four components in one shot. When inspecting 
components, two consecutive images are taken while the HYDRA unit passes 
over the camera.

The camera box is mounted on the machine using three screws at the bottom 
of the camera box, extending through a steel plate (See Figure 9-5).

To protect the lenses from dust and components there is a transparent gate in 
the camera box that is controlled from the front.

When removing any components from the glass on the gate they fall down to 
the back of the camera into a dump bin and can easily be reached.

Adjusting HYDRA Camera Y Position

Sometimes you must physically adjust the HYDRA camera Y-wise, so that the 
center of its CCD coincides with the center of the single mount head.

Figure 9-5.  HYDRA camera.

Mounting screws
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Adjusting HYDRA Camera 2 Y position

1. loosen the rear bolt, see Figure 9-6.

2. Loosen the two screws located at the front of the camera box (’A’ in 
Figure 9-7).

3. Adjust the Y position of the camera with screw (B). By turning the screw 
clock-wise the camera will move towards the front of the machine (on 
the monitor it looks as if the camera is moving downwards). If you want 
to move the camera towards the rear, turn screw (B) counter-clock wise 
while pushing gently on the camera.

4. When satisfied with the Y position, fasten screws (A) and the rear bolt 
(see Figure 9-6).

Figure 9-6.  Loosen bolt.

Figure 9-7.  Adjust camera Y-position.
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Adjusting HYDRA Camera 1 Y position

1. Loosen the lid of the camera box and remove it (e.g. with a magnet). See 
Figure 9-8.

2. Loosen the three bars in the camera box with a 9 mm universal screw 
spanner. See Figure 9-9.

3. Loosen screw located in the front of the camera box (’A’ in Figure 9-10).

4. Adjust the Y position of the camera with screw (B). By turning the screw 
clock-wise the camera can be moved towards the front of the machine 
(on the monitor it looks as if the camera is moving downwards).

Figure 9-8.  Remove camera lid.

Figure 9-9.  Loosen bars.
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5. When satisfied with the Y position, fasten screw (A) and the three bars 
in the camera box.

6. Reattach the lid.

Figure 9-10.  Adjust camera Y-position.
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Linescan Vision System

The LinescanVision System generates a picture by taking a series of line 
images synchronized with the position of the mount head as it pass over the 
camera. The final image is made up of thousands of such lines. The 
illumination of the component is done with ambient lighting.

The LinescanVision System consists of the following hardware:

– Camera box.

– LSAD board.

– Power unit.

 WARNING! In this section, some of the procedures cause the machine to make 
movements. The below warning must be followed for such procedures.
Procedures that cause the machine to make movements are marked with this 
sign next to the text. Before entering such commands, check the following:
Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas, and that the standard tool head and the Hydra tools are in their upper 
positions.
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Camera box

The most important part of the LVS is the Linescan camera (LSC). Inside the 
camera box there is a 2048 x 96 pixel CCD. There are also electronic boards 
needed to drive the CCD image sensor, and send the analog video signal to the 
LSAD board. 

The camera can be used as a 2048 x 96 pixels area camera, which is useful for 
calibration and troubleshooting. This mode is for example used in the service 
program. 

The focal plane is factory-set at 14 mm above the camera frame. This is not 
possible to adjust. There are no serviceable parts inside the camera box, except 
for the glass window and the LED boards. To avoid vibrations or relative 
movements between the CCD and the lens, all optical elements are glued to a 
steel frame. This frame is made from a single solid block of metal.

The illumination unit has two separate light segments. The LED current is 
constant (50 mA per diode). The light intensity is varied by changing the duty 
cycle.

LSAD Board

An LSAD board is mounted inside the AT-CPU2 and performs several 
functions:

– It provides the camera box with line synchronization based on 
HFLASH.

– Switches the LED boards on and off. 

– AD converts the 8 channel analog video and feeds the data to the 
4 MB video memory on VVG2. 

– It compensates for gain and offset variations between the 8 channels 
of the cameras CCD-sensor, using Look Up Tables (LUT).

– Controls the camera electronics via a serial link.

The LSAD board is accessed via the VVG2. Only +5 V and GND are 
connected to the ISA-bus. 

Power Unit

The Power unit is mounted behind the Linescan camera and supplies it with 
six different voltages: +15 V, +13.5 V, +12 V, +5 V, –2 V and -5 V. 

The Power unit also supplies the drive current for the LED boards. If the LED 
boards are kept on for too long, a watch-dog will automatically switch them 
off, preventing the diodes from over-heating due to a faulty cable or LSAD 
board. 

Two green LED indicate camera power OK and LED power OK.
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Troubleshooting

Refer to the table below if you have problems with the Linescan Camera.

Symptom Possible reason

Calibration fails. Calibration plate touches centering jaws when rotated. Try setting 
parameter 73.0003 to –13.5 mm.

Ensure that you have installed the reference background correctly.

Cannot find the reference 
background.

Camera or reference background incorrectly mounted in Y direction. The 
entire reference background (7x56 mm) should be visible in the leftmost 
channel (pixels 0-255). 

Reference background dirty, bent, damaged or not installed.

LED boards not illuminating. Light intensity in package data set to 0 %.

Power unit or LED cable damaged.

Blurred image in both vertical 
and horizontal direction.

Incorrect component height in package data.

Camera level incorrectly measured.

Centering unit mounted in upper position.

Magnification incorrectly measured during calibration.

Blurred image only in vertical 
direction. 

X wagon traveling too fast over camera. Try lowering parameter for max 
X speed 57.0211 (also 58.0211 if you have two LSCs).

Vertical stripes in image. Look-up-table calibration failed.

LED cable shield damaged.

Power unit or power cable damaged.

Video cable damaged.

Dark image. Calibration failed.

LED boards or power unit damaged.

Dark spots in image. Dirt on camera window.

Components on the camera glass.

Bad placement accuracy. Dirt on reference background.

Slow mounting. Max-safe-pos incorrect.

View mode or debug mode on.

Incorrect tool parameters.

Level of camera box not 
repeatable.

Midas touches LED board Plexiglas cover when measuring camera box 
height. Loosen screws holding Plexiglas over LED boards, push down, and 
re-tighten screws.
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10. Pneumatic System
This chapter briefly describes the pneumatic system. The chapter is divided 
into the following parts:

– Standard Pneumatic System on page 10-2. For the single mount head.

– HYDRA Pneumatic System on page 10-4. For the HYDRA unit.

Figure 10-1.  Pneumatic system.
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Standard Pneumatic System

The pneumatic system is located on the X wagon and is used to obtain a 
negative pressure in the single mount head tool when picking and moving 
parts. It also produces an air pressure used to quickly release parts when 
placing the components.

A schematic of the standard tool pneumatic system is shown in Figure 10-2.

Vacuum

A vacuum pump (V) maintains a negative air pressure in a vacuum tank (VT). 
When the vacuum valve (VV) opens, air will be taken from the mount tool via 
a filter (F). A sensor (S) measures and indicates the negative pressure to the 
system.

Pressure

An air pump (P) maintains an air pressure in a pressure tank (PT). When a 
pressure valve (PV) opens, air from the tank will increase the pressure in the 
mount tool. The sensor (S) indicates the pressure to the system.

An overload valve (OV) secures the air pressure not to exceed a certain 
maximum level.

The vacuum system is controlled by the MOT-Z board.

Figure 10-2.   Standard pneumatic system.
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Standard Vacuum control
You can individually control pump, vacuum valve, pressure valve, and also 
supervise the sensor pressure from the Vacuum control dialog box.

Procedure

1. Select Exit > Exit To Service.

2. To see the vacuum level in the standard mount tool, select 
Vacuum > Show/Hide vacuum/force sensors

In the Vacuum and force information box for the standard mount tool:

– The field Vacuum in the standard mount tool, shows as a value 
between 0 and 255.

– A value between 0 and 30 should be shown for no vacuum, that is 
when the vacuum/pressure pump is off.

– A value above 170 should be shown for full vacuum, that is when the 
pump is on, the vacuum valve is open, and the pressure valve is 
closed.

3. You can individually control pump, vacuum valve, pressure valve by 
selecting Vacuum > Z Vacuum.

4. You can control the vacuum pump, the vacuum valve and the pressure 
valve by moving the cursor to the desired option and pressing <Enter>.
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HYDRA Pneumatic System
The HYDRA pneumatic system uses the same vacuum and pressure pump as 
the standard tool pneumatic system. For more details see section in the 
Standard Pneumatic System section. 

The HYDRA pneumatic system consists of eight vacuum valves and one 
pressure valve. The vacuum valves switch between vacuum and pressure. 
Pressure can either be over pressure or atmospheric pressure. The pressure 
valve is only open (over pressure) for a few milliseconds, enough to clear the 
vacuum in the tool tip.

A schematic of the HYDRA pneumatic system is shown in Figure 10-3.

Vacuum

The HYDRA pneumatic system is connected to the common vacuum pump at 'H.'

Pressure

The HYDRA pneumatic system is connected to the common pressure pump at 'H.'

The vacuum system is controlled by the MOT-Z board.

Figure 10-3.   HYDRA pneumatic system.
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HYDRA Vacuum Control

You can individually control pump, vacuum valve, pressure valve, and also 
supervise the sensor pressure from the HYDRA Vacuum control dialog box.

Procedure

1. Start the Service Program by selecting Exit > Exit To Service in the 
TPSys menu.

2. To be able to see the vacuum levels in the HYDRA mount tools, open 
the vacuum sensor information box by selecting:

Vacuum > Show/Hide vacuum/force sensors

In the Vacuum and force information box for the HYDRA mount tools:

– The vacuum in the HYDRA unit is shown as a value between 0 and 
255 (H in the figure above). The field Z in the information box shows 
the vacuum in the standard mount tool.

– A value between 30 and 75 should be shown for no vacuum, that is 
when the vacuum/pressure pump is off. For best repeatability perform 
this test without HYDRA tools.

– A value between 190 and 220 should be shown for full vacuum, i.e. 
when the pump is on, the vacuum valve for the particular nozzle is 
open, and the pressure valve for the same nozzle is closed.

3. You can individually control pump, vacuum valve, and pressure valve 
by selecting Vacuum > HYDRA Vacuum.

You can control the vacuum pump, the vacuum valve and the pressure valve 
by moving the cursor to the desired option and pressing <Enter>.

The vacuum valves are controlled by moving the cursor to the desired tool 
number, pressing <Space> for an Open or Close action, moving the cursor to 
the Set option, and pressing <Enter>.
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11. Power Supply System
This chapter contains information about the power system and fuses that are 
accessible from the outside of the electrical units in the machine.

The following units are included in the power supply system. All the units are 
located on the electric shelf (’1’ in Figure 11-1):

– Mains Input Unit on page 11-2.

– EPT Units on page 11-2.

– PS4 (’2’ in Figure 11-1) on page 11-3.

– BM4CB (’3’) on page 11-4.

– UPS (’5’) on page 11-5.

– 12V/5V Box (’4’) on page 11-6.

 WARNING! These units contain dangerous voltage levels. Follow the safety 
instructions in the operator´s manual. Power must be switched off before 
opening a unit.

Fuses

The electrical systems are protected by fuses located in the following units:

– Mains Input Unit

– PS4

– BM4CB

– UPS Unit

Figure 11-1.  Power Supply System.
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Mains Input Unit

The Mains Input Unit is located at the rear of the machine. The unit supplies 
the various machine systems with power converted to different voltages from 
the mains voltage.

The machine can be either Y or D connected to the mains.

It is important to know what kind of connection the machine is connected to, 
because the fuses are different depending on the connection type.

The fuses included in the Mains Input Unit are accessible from the mains input 
panel (see '1' in Figure 11-2).

The F1, F2 and F3 fuse data are indicated in the following table for Y and 
D connection. The fuses are located at ’A’ in Figure 11-2.

EPT Units

Three EPT units are located in the Mains Input Unit accessible from the input 
panel (see ’B’ in Figure 11-2).

The EPT units have voltage plugs and fuses and are used for one phase each.

The fuses in the three EPT units are called F1 and have the following data:

Figure 11-2.   Mains input panel.

Fuse Type
Rate

Y Connection
Rate

D Connection

F1 6.3 x 32 mm 8 A Slow 15 A Slow

F2 6.3 x 32 mm 8 A Slow  15 A Slow

F3 6.3 x 32 mm 8 A Slow  15 A Slow

A

B

Fuse Voltage Type Rate

F1 140 V AC 6.3 x 32 mm 10 A Slow
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PS4

The PS4 power supply unit contains the main fuses ('2' in Figure 11-3).

The fuses in PS4 are accessible from the front of the machine, in the middle 
section, under the magazines.

The following table shows the fuses and circuit breakers included in the PS4 
unit.

Figure 11-3.  PS4.

Fuse Circuit Type Rate

F1 Mains Circuit breaker 8 A

F2 Mains Circuit breaker 8 A

F13 55 V AC 6.3 x 32 mm 0.1 A FAST

F14 55 V AC 6.3 x 32 mm 0.1 A FAST

F11 +75 V 6.3 x 32 mm 6.3 A SLOW

F12 –75 V 6.3 x 32 mm 6.3 A SLOW

F9 +38 V 6.3 x 32 mm 15 A SLOW

F10 –38 V 6.3 x 32 mm 15 A SLOW

F3 110 V AC 6.3 x 32 mm 15 A SLOW

F8 110 V AC 6.3 x 32 mm 15 A SLOW
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BM4CB

There is a BM4CB unit ('3' in Figure 11-4) located to the left in the computer 
box. The computer box is located on the electric shelf ('1') inside the machine.

The fuses included in the BM4CB are shown in the following table.

Figure 11-4.  BM4CB.

Fuse Type Rate

M25 V- 5 x 20 mm Quick 2 A

Theta (Fi) 5 x 20 mm Quick 1.6 A

C 5 x 20 mm Quick 1.6 A

H Theta (Fi) 5 x 20 mm Quick 1.6 A

M25 V+ 5 x 20 mm Quick 2 A

X nc nc

Z 5 x 20 mm Quick 2 A

Y 5 x 20 mm Quick 4 A

YM 5 x 20 mm Quick 1.6 A
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UPS

The UPS (Uninterrupted Power Supply) unit provides battery support to the 
computer box in case of power failure. The UPS unit (’5’ in Figure 11-5) is 
located on the right side of the electrical shelf, on top of the ELMO unit.

If the machine of any reason is turned off from power for more than 6 months 
the batteries in the UPS should be charged for 24 hours to prevent backup 
failure. The batteries should be changed after 5 years to new batteries.

UPS fuse

There is one fuse in the UPS unit. The fuse (rated 8 Amp) is located in the back 
of the unit (’1’ in Figure 11-6).

UPS Repair Guide

For instructions regarding the UPS installation see Repair Guide
(UPS REPLACEMENT, P-049-0678). Available from Mydata.

Figure 11-5.  UPS Unit.

Figure 11-6.   UPS Unit rear view.
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12V/5V Box

The 12 V/5 V Box is located on the electric shelf on the left side of the booster 
(’4’ in Figure 11-7).

Inside the box there are two switch mode power supplies, generating the 5 V 
and 12 V DISC voltages.

The 5 V and 12 V are distributed with the XP5/12 V cable to the BM4CB in 
the computer box.

The input power is supplied by the UPS unit.

Figure 11-7.   Box 12 V / 5 V.
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Functional Test
The following procedure describes how to display the internal system 
voltages.

Procedure

1. Start the Service Program by selecting the Exit To Service in the TPSys 
Exit menu.

2. Select Utility > Show line voltages 

The internal system voltages is displayed in the following box:

The voltage ‘5.6 V’ is no longer used and the ‘18 V battery’ voltage is 
generated by the UPS system.

Line voltages description

Remaining lines display internal supply voltages generated by the PSU and the 
following booster.

This function is controlled by the MOT-M board.

   50 V AC (rms): 53.91
20 V DC/DC input: 18.4
    18 V battery: 19.9
        12 V CRT: 11.9
       12 V disk: 11.8
           5.6 V: 5.68
             5 V: 4.98
           -25 V: -24.6
           -35 V: -35.9
           -75 V: -74.4
            75 V: 76.7
            35 V: 35.4
            25 V: 25.4

Line voltages  

Field Description

50 V AC (rms). This voltage is sensed for power failure. When it 
decreases to a certain level, files are saved and the 
system is shut down using battery backup power.

20 V DC/DC input. This voltage is generated by the PSU and is applied 
the DC/DC converter for 5 V DC supply voltage.

18 V battery. Battery power fed to the booster for generating 
required backup voltages.

12 V CRT. 12 V DC for monitor.

12 V disk. 12 V DC for disk drives.
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Troubleshooting

A LED indicator is located on the front panel of the UPS Unit. The LED 
indicator is used to show the current status of the UPS Unit. The following 
table shows the status levels that the UPS Unit can assume.

The following table shows some of the symptoms that may turn up in case of 
failure in the UPS Unit.

LED indicator status Function

Steady green light. Normal line.

Slow blinking. Battery in use.

Fast blinking (pending shutdown). Low battery.

Black out. Overload, short.

Symptom Suggested action

LED is not on. 1. Check for power fail.

2. Check if input cable is loose.

3. Check if power switch is "off".

4. Check if the fuse is blown.

Back up failure. Check if the battery voltage is to low (Recharge 
the batteries for 24 hours).
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12. Board Handling Systems
This chapter describes the Board Handling System. It contains brief 
descriptions about internal and external conveyors, Y wagons and Y module 
types and different Conveyor configuration systems.

This chapter also contains instructions concerning functional tests and 
adjustment and calibration procedures that can be performed on the different 
Board Handling System configurations.

The Board Handling System comprises the following main parts:

Y wagon

The Y wagon or Y module unit provides the Y movement of the Manual load 
table or Internal Conveyor in the machine.

Conveyor system

To transport the mounted PCB, the Y module is equipped with an Internal and/
or External Conveyor.

Cover hoods

The Y wagon and Conveyor system are covered by hoods to protect operators 
from moving parts of the machine.
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Y Wagon

The Y Wagon provides the Y movement of the Manual load table or Internal 
Conveyor in the machine.

There are two different methods, used by the Y wagon to hold the PCBs in the 
MY series of machines. The Y wagon can be equipped with either a Manual 
load table or an Internal conveyor system.

Manual load (ML)

The PCBs are fixed into position using magnetic supports. Any number of 
PCBs, of different sizes or shapes that fits on the table can be mounted 
simultaneously.
Examples of manual load Y modules are:

288 ML2 – The two module Y wagon using two magazine positions.

468 ML3 – The three module Y wagon using three magazine positions.

Internal conveyor (IC)

The PCBs are automatically placed and locked in the right position before the 
components are mounted. After the components are mounted the conveyor 
transports the board to the next stop, usually an external conveyor.
Examples of Y module Internal conveyors are:

– Conveyor 420PT.

– Conveyor 500T2.

– Conveyor 500T.

Figure 12-1.  MY 12 with manual load.
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Y Wagon or YM unit types

The table below shows the different Y Wagon or YM unit types.

Figure 12-2.  MY 15 with 500T Internal conveyor.

Y wagon
 name

Description

Y-cogbelt Y wagon with cog belt.

Y1/Y2a Y wagon with short screw.

Y1/Y2b Y wagon with long screw.

Y1/Y2c Y1, Y2 with YWB and optional TWM.

Y1/Y2d Y1, Y2 with YWB2 (with board jam indicators) and optional 
TWM.

Y1/Y2e Y1, Y2 with YWB and Y-type TWM.

YWU3a YWU3 with stand alone 288.

YWU3b YWU3, 4, 5 with stand alone 468, ML3, 4, 5 or conveyor.

YWU3c YWU3, 4, 5 with special conveyor.

YWU3d YWU3, 4, 5 with huge table.

YWU4a YWU4, 5 with ML6, 7 and low friction.

YWU4b YWU4, 5 with ML6, 7 and high friction.

YM0 Empty Y-unit for CAN network (Intended for Conveyor).

YM1 Y-unit for ML3 for CAN.
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Conveyor Systems

The main function of the Conveyor System is to transport the mounted PCB to 
the next stop, usually an external conveyor.

There are mainly two types of conveyor systems:

Internal Conveyor System

Uses an internal conveyor on the Y module to transport the PCB.

External Conveyor System

This system consists of external conveyors, board loaders and unloaders that 
are used to transport the mounted PCB to other stages in the production chain.

Examples of External conveyors are:

– Buffer conveyor BC2 1200.

– Buffer conveyor BC2 1500.

– Transport conveyor TC2 1200.

– Transport conveyor TC2 1500.

– Transport conveyor TC2 2000.

There are also loaders, unloaders and workstations available.

The External Conveyor System is not covered by this chapter.

Conveyor types

The table below shows some of the different Conveyor types.

Conveyor Description

Conveyor 400PT Internal Y module conveyor for the Pass 
Through configuration.

Conveyor 500T2 Internal Y module conveyor for the Transversal 
configuration.

Conveyor T3 through T6 Internal Y module conveyor for the Transversal 
configuration (controlled by CAN network).
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Conveyor System Configurations

There are two different configuration styles for Conveyor systems:

(T) Transversal style

In this configuration the entire line passes along the back of the machine. This 
allows the front side to be fully accessible to the operator.

(PT) Pass through

The pass through system has the advantage of using shorter conveyors, which 
keeps the overall length down. There is a choice of having the line passing 
through the center or at either end of the machine.

Figure 12-3.  Transversal style configuration.

Figure 12-4.  MY 9 with 400PT conveyor.
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Hoods

To protect operators from moving parts of the machine, the Y wagon and 
Conveyor system are covered by hoods.The hoods are equipped with safety 
switches that stop the machine, when opened during operation. 

To prevent failures in the board handling the hood kit is also equipped with 
Board Jam Sensors.
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Measure Friction Of Y Wagon

This procedure describes how to measure friction on the CAN-System 
controlled YM Y wagon. The maximum and minimum position values for the 
Y wagon will be needed to be able to perform this measurement.

Procedure

1. Start the Service Program by selecting Exit > Exit To Service in the 
TPSys menu.

2. Select Motor > Y motor > Read range.

3. Make a note of the position values that are shown in the information box.

4. Select Motor > Y motor > Measure friction.

5. Enter the speed value 100 mm/s in the dialog box.

6. Select the field Measure friction and press <Enter> to start the 
measurement.

7. When the measurement is done, select the field View result and press 
<Enter>.

8. Repeat the procedure above, using the following speed values 200, 400 
and 600 mm/s.

Measure Friction On T3 – T6 Board Handling Systems

This procedure describes how to measure friction on a CAN-System 
controlled conveyor.

Procedure

1. Start the Service Program by selecting Exit > Exit To Service in the 
TPSys menu.

2. Select Conveyor > Width motor > Measure friction.

3. Enter the speed value 10 mm/s in the dialog box.

4. Select the field Measure friction in the dialog box and press <Enter> to 
start the measurement.

5. When the measurement is done, select the field View result and press 
<Enter>.

6. Repeat the procedure above, for the Transport motor and the Hold motor 
using the following speed values:

– Transport motor: 40 mNm.

– Hold motor: 1 N.
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Adjusting Y wagon Reject Bins

It is possible to have up to eight reject bins. Usually they are placed in the 
frames of the machine. If the frames host cameras or a glue station there is no 
room left for reject bins. It is therefore possible to have reject bins on the 
Y wagon.

Procedure

1. Select Utility > Installation and Calibration > Locate Reject Bins.

2. When prompted select the bin you want to adjust.

– Bins 1-4, which are of frame type, are installed in autoInstall.

– Bins 5-8 are by default set to ‘Not used’. This can be changed in 
parameter group 32 Reject positions.

3. When prompted use the joystick to point the Z-head at the desired bin 
location.
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Adjust Board Jam Sensor 

Note that this section only applies to some versions of the T3-T6 Board 
Handing System. Other versions (the ones with Prima Y amplifier) have the 
control of the Board Jam Sensors integrated into the YMB electronic board.

Board Jam Sensors are used in the T configurations of the machine. The Board 
Jam Sensors are placed on the Side Covers below the feeder conveyors. Two 
of the Board Jam Sensors are positioned at the front end of the support beams 
and two at rear end.

Perform this adjustment once a month.

Procedure

1. Before adjusting the Board Jam Sensor verify the following Main Unit 
settings: (Depending on version, the Main Unit is either located inside 
the Y module's electronics cabinet, or panel mounted in the Y module's 
electronics cabinet).

– Output Selector switch set to D.ON (dark on).

– Power Mode set to "SUPER".

– Output Timer mode set to "OFF".

2. Make sure there is nothing blocking the Board Jam Sensor light beam.

3. On the Main Unit display, check that the value is above 500.

4. Adjust the Board Jam Sensors by loosening the two screws (‘A’ in 
Figure 12-5) holding the Board Jam Sensor to the sensor bracket.

5. Slightly turn the Board Jam Sensor (See Figure 12-5) and monitor the 
display on the Main Unit. The value on the display should be as high as 
possible. 

Figure 12-5.  Adjust Board Jam Sensor.
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6. When satisfied with the received value, refasten the Board Jam Sensor 
screws.

 CAUTION! Be careful, not to use too much force when tightening the screws 
or the Board Jam Sensor may be damaged.

7. With no PCB in place, press the button marked "SET" on the Main Unit.

The orange LED on the Main Unit lights up.

8. Place a 0.6 mm PCB on the Conveyor to cut out the light beam, and press 
the "SET" button again and release it.

9. Repeat the procedure above, on the other Main Unit.
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13. Component Feeding Systems
This chapter contains descriptions, calibration and adjustment information for 
the various component handling systems. The chapter is divided into the 
following sections:

– Tape Magazines on page 13-2.
This section describe Tape Magazines in general and how to adjust 
and calibrate the magazine slots. It also contains information on how 
to perform general functional tests.

– Agilis Linear Magazine (ALM8 and ALM1216) on page 13-6.

– Agilis Magazine (AM8) on page 13-9.

– TM – Tape Magazines on page 13-18.

– Tray Wagon Magazine on page 13-25.

TEX Tray Exchanger is described in a separate manual entitled TEX Tray 
Exchanger, Service Manual. This manual shall be inserted in this chapter, if a 
TEX is used.

 WARNING! In this chapter, some of the procedures cause the machine to make 
movements. The below warning must be followed for such procedures.
Procedures that cause the machine to make movements are marked with this 
sign next to the text. Before entering such commands, check the following:
Ensure that there are no foreign objects on the assembly table, near the tool 
bank, or within the X wagon, Y wagon, or Tray Wagon Magazine moving 
areas, and that the standard tool head and the HYDRA tools are in their upper 
positions.
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Tape Magazines

To get the full flexibility of the tape magazine system, the machine must be 
calibrated accurately using a reference magazine.

When the machine is calibrated, all the tape magazines (except Agilis LM8 
and LM1216) need a pick line adjustment. For more information about a 
specific tape magazine refer to the following sections and pages.

– Agilis Magazine (AM8) on page 13-9.

– TM – Tape Magazines on page 13-18.

Adjusting Magazine Slots

The magazine slot´s Y direction is adjusted mechanically. This adjustment 
must be performed if the magazine slot´s adjustment screw has been loosened.

Prerequisites

– Shims in different thicknesses.

– A set of Allen keys (mm).

– A reference magazine is required to adjust and calibrate the magazine 
slots properly.

Procedure

1. Insert, until stop, the reference magazine in position 1.

2. Select Utility > Installation and Calibration > Locate Slot Position.

3. Select a magazine position from the shown selection box.

4. Check the slot's Y direction on the monitor against the reference 
magazine's center mark in both X and Y.

Use the trackball or joystick to move the camera along the pick position 
line. The cross hairs should be centered on the line.

5. If the centermark is off in the Y direction, adjust the slot position. Start 
by unscrewing the stop screw, see Figure 13-1.
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6. Add or remove shims as necessary, see Figure 13-2. Shims are available 
in different thicknesses. Use the cross hair scaling to determine how 
much off-center the mark is in the Y direction.

7. Check that the Y position of the centermark aligns with the cross-hair.

8. Center the cross-hairs on the Magazine center mark in the X direction. 
Confirm by selecting Ready in the Locate position dialog box. 

9. Repeat the procedure for all the magazine positions.

Figure 13-1.  Unscrew the Stop Screw.

Figure 13-2.  Add or remove shims for correct alignment.
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Test Magazine
This option tests major functions of the selected magazine.

Procedure

1. Select Exit > Exit To Service.

2. Select Magazine > Test.

3. Select the desired magazine by entering the magazine position in the 
Select slot dialog box:

A continuously updated test result for the selected magazine is shown.

The Button and Lamps status shall reflect the visible states of these functions 
on the magazine.

Function Setting Description

Test result Passed A communication test completed successfully.

Off The test was not successfully completed.

Button No The release button on the magazine is released.

Yes The release button on the magazine is pressed in.

Lamps Off Both of the LEDs are temporarily off, or the 
LED test was not successfully completed.

Yellow The Yellow LED only is temporarily lit.

Green flash The Green flash LED only is temporarily lit.

Yellow flash Yellow flash of the LEDs are temporarily lit.
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Polling Magazines
Polls those magazines which are inserted in the machine.

Procedure

1. Select Exit > Exit To Service.

2. Select Magazine > Poll.

3. The polling result is displayed on the monitor.

If the text in the Buttoned out column is No the magazine is in operation (the 
green LED on the magazine is lit with a steady light). If the text is Yes the 
system does not pick from the magazine (the green LED is either flashing or 
off). If it is neither of these but '---' the magazine type has no release button.
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Agilis Linear Magazine (ALM8 and ALM1216)

From version 2.6 TPSys supports Agilis Linear Magazine 8 (for 8 mm tape) 
and Agilis Linear Magazine 1216 (for 12 and 16 mm tape).

The main features of these magazines are feeding speed, feeding accuracy and 
flexible feeding stroke. The magazine can feed tape in variable length. This 
makes it possible for the software to adjust the pick position for a feeder not 
only in the X direction but also in the Y direction.

The Agilis Linear Magazines 8mm, ALM8, use the same feeders as Agilis 
Magazine M8, see Agilis Magazine (AM8) on page 13-9.

The Agilis Linear Magazines 1216mm, ALM1216, use 12 and 16 mm feeders. 
They are similar to the 8 mm feeders but can handle larger components.

Figure 13-3.  Agilis Linear Magazine ALM1216 and ALM8.
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Instead of the cogwheels that feed the tape in the AM8 magazine, the ALM 
magazines have a linear slide that moves back and forth (see Figure 13-4). The 
slide is equipped with pins that move up and down. This construction makes 
it possible to feed tape with steps of arbitrary length.

The ALMs have two fiducial marks, one on each side of the wagon. They are 
circular, 1 mm diameter, black on white. Both fiducial marks are searched 
when the magazine is located. All previous types of magazines only have one 
fiducial mark (1 mm wide, 10 mm long) on the left side.

Figure 13-4.  Agilis Linear Magazine – ALM8.
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Pick Line Adjustment

As mentioned above, Agilis Linear Magazines have the ability to step feeders 
with an arbitrary step length. This makes it possible for the software to adjust 
the pick position in both in X and Y direction. Mechanical adjustments to the 
magazine are no longer required. 

See the Operator´s Manual for instructions on how to adjust the pick line.

Information Panel

The Agilis Linear Magazine has the same information panel as Agilis M8.

Polling Removable Feeders

Agilis Linear Magazines use the same feeders as Agilis M8. Therefore polling 
of the feeders are done in the same way. Please see Polling Removable Feeders 
on page 13-11



MYDATA MY9 – MY12 – MY15 – MY19  Component Feeding Systems

P-040-0070-EN – Service Manual Rev. 0000  2008-06 13 - 9

Agilis Magazine (AM8)

The Agilis M8 Magazine is a tape magazine for 8 mm tape. Removable 
feeders are used to bring the components to the placement head. These feeders 
make reloading of components fast and easy. You can run any combination of 
normal and fine pitch component tapes in an Agilis M8 Magazine.

The removable feeder is an intelligent unit in which you load the component 
tape before inserting it into the magazine. Feeders can easily be moved from 
one feeder position to another.

The feeder has a barcode and a unique ID number, which is also stored in its 
electronic part.

Figure 13-5.  Agilis M8 magazine.

Figure 13-6.  Removable Feeder.



Component Feeding Systems MY9 – MY12 – MY15 – MY19  MYDATA

13 - 10 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Release button and status LEDs

The Agilis magazine has an info panel with green and yellow LEDs showing 
the status for each feeder. The panel also has a release button from which you 
can order the machine not to pick components from the magazine. Finally 
there is a LED indicating the magazine status.

Green and Yellow LEDs (1, 2)

The LEDs on the information panel indicate that the magazine has contact 
with the machine. There is one green and one yellow LED for each feeder 
position. If a feeder is loaded, the green LED is on at this position. If there is 
no feeder in a feeder position no LED is on.

If the component reel is running out of components, the green LED for that 
feeder position will blink. If the machine is unable to use the feeder, the yellow 
LED comes on.

Release button and Indication LED (3, 4)

Press the release button (’3’ in Figure 13-7) on the panel. This tells the 
machine not to pick components from the magazine. 

This button resets magazine errors for the magazine, i.e. equivalent to 
removing or inserting the magazine.

The green indication LED in the bottom right corner (’4’ in Figure 13-7) is on 
when the magazine is inserted in the machine. It starts blinking when you press 
the release button and is off when the magazine is ready to be pulled out.

Make sure the green LED in the bottom right corner and the green LEDs for 
loaded feeder positions are on before starting assembly.

 Always wait until the green indication LED in the bottom right corner is off. 
Removing the magazine from the machine while the green LED is on can 
damage the placement head.

Figure 13-7.  Information panel.
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Polling Removable Feeders

Polls magazines that are equipped with removable feeders.

Procedure

1. Start the Service Program by selecting Exit > Exit To Service.

2. Select Magazine > Poll removable feeders.

3. Select the desired magazine by entering the magazine position in the 
Select slot dialog box. The polling result is displayed on the monitor as 
follows:

The serial numbers are presented both by decimal and by hexadecimal 
notation in the information box.

If the decimal serial number is ’3’, it means that the system has found no 
Agilis feeders in that position. Apart from the obvious reason of no 
feeder installed, it can be caused by:

– Poor contact between the Agilis feeder and the Magazine.

– Faulty Agilis feeder ID circuit board.

                  Serial number

  Feeder      ((dec))       ((hex))

  ==========  ==========  ========

   1          16779431    0x10008a
   2          16779833    0x1000a3

   3          3           0x3

   4          16780099    0x1000b4

   5          3           0x3

   6          3           0x3

   7          3           0x3

   8          3           0x3

   9          3           0x3

  10          3           0x3

  11          3           0x3

  12          3           0x3

  13          3           0x3

  14          3           0x3

  15          3           0x3

  16          3           0x3

Poll removable feeders
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Agilis M8 Pick Line Adjustment

The pick line in Agilis M8 is adjustable in Y direction mechanically and in X 
direction through TPSys, see Operator’s Manual.

To adjust the pick line Y direction, use the two Allen screws positioned on top 
of the magazine near the feeders, see Figure 13-8. You can do the adjustment 
with the magazine inserted in the machine and instantly see the result on the 
screen.

We recommend you to adjust feeder position 1 first and then position 16. Use 
a 3 mm Allen key.

Use the step feeder function, key <F4>, to assure that the component is in pick 
position before you make the adjustment.

Figure 13-8.  Adjusting Pick line Y direction.
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Troubleshooting

This section describes how to locate errors that may occur and suggestions on 
how to solve the problems.

The troubleshooting chapter is divided as follows:

– Locating Errors on page 13-14.

– Magazine Errors on page 13-15.

– Machine Errors on page 13-17.

Start in the first localization section. You will then be guided to the appropriate 
part of the other sections.
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Locating Errors

The following table helps you to find out if an error is located in the Agilis 
magazine or in the base machine.

An error has occurred

Is the Magazine correctly inserted? No – Insert properly. 

Yes – Do the test below.

Does the magazine work in other magazine 
positions? 

Yes  – Most likely the 
magazine position does not 
work properly. Go to the 
Machine Errors section.

No – Do the test below.

Do other Magazines work in the magazine 
position?

No – Most likely the 
magazine position does not 
work properly. Go to the 
Machine Errors section.

Yes –  Most likely the error 
is located in the Agilis M8 
Magazine. Go to the 
Magazine Errors section.
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Magazine Errors

This section contains errors located in the Agilis magazine and suggestions on 
how to solve the problems.

LED Indicated Error

This table contains errors indicated by the LEDs on the rear handle and how 
to solve these problems.

Symptom Action

None of the LEDSs are lit. Check if the control board cables are connected? 

If No – Connect the Magazine board cables through the 
main opening underneath the Magazine.

If Yes – Replace the control board.

If control board is replaced but LEDs not lit – 
Replace the rear handle.

Note! If it is a faulty rear handle unit, put the old control 
board back since it is probably intact and has the 
original serial number.

The LEDs are not lit according to the loaded 
feeders position and TPSys do not detect the 
magazine.

Replace the control board.

If replacing control board does not solve the problem – 
Replace the handle unit.

Note! If it is a faulty rear handle unit, put the old control 
board back since it is probably intact and has the 
original serial number.

Yellow LEDs are lit but only for a short while. Try feeders that you know work in other Magazines.

If other feeders does not solve the problem – 
Replace the control board.

If replacing control board does not solve the problem – 
Replace the interconnection board.

Note! If it is a faulty interconnection board, put the old 
control board back since it is probably intact and has the 
original serial number.

A feeder is not detected in a single feeder 
position.

Check if the feeder work in other magazines. – If not 
replace the feeder.

If the feeder work in other magazines – Check the 
condition of the interconnection board connectors (there 
are double connectors for each of the two contact areas).

If no fault with interconnection connectors – Change the 
interconnection board.
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Pick Error

This section contains component pick errors and how to solve the problems.

Feed Error

This section contains feed errors and how to solve the problems.

Check Action

Out of components? Yes Load a new component reel. 

No See below.

Is the pick line adjusted? No Adjust the pick line according to the Operator´s Manual.

Yes See below.

Is the tape transport free 
from interference?

No Make sure the tape can run smoothly from the reel to the 
feeder.

Yes See below.

Is the feeder properly 
inserted in the Magazine?

No Make sure the feeder wheel spikes are positioned in the 
component tape feeding holes.

Yes See below.

Is the feeder properly 
loaded?

No Reload the feeder according to the Operator´s Manual.

Yes See below.

Are the feeder wheels 
running?

No See the Feed Error section.

Yes See below.

Are the feeder wheels 
running evenly and 
smoothly?

No Assure the free movement of the wheels by adjusting the nut 
on the feeder wheel unit.

Yes See below.

Are the feeder wheels 
intact?

No Replace the feeder wheel unit.

Yes Make sure there are no components or other things stuck 
between the feeder wheel cogs.

Check Action

Do you hear the motor 
running for about a second?

No Replace the motor unit.

If this does not solve the problem – replace the control board.

Yes See below.

Do you hear clicking sound 
from the solenoids?

No Make sure the connectors to the solenoids are properly 
connected (20-pole flat cable). Check both the connectors at 
the control board and at the solenoid unit. If the cable is loose, 
reconnect it.

If this does not solve the problem – replace the control board.

If this does not solve the problem – replace the solenoid unit.

Note! If it is a faulty interconnection board, put the old control 
board back since it is probably intact and has the original 
serial number.

Yes See below.

Make sure there are no components or other things stuck 
between the feeder wheel cogs.
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Machine Errors

This section contains errors indicated by the LEDs on the rear handle, located 
in the machine and suggestions on how to solve the problems.

Symptoms Action

The LEDs are not lit the way they are supposed 
to.

Check if any LEDs are lit. Make sure there are no 
components or other things stuck in the Magazine slot 
connectors – check all the slots.

Check the M25V+ fuse on the BM3CB board in the 
computer box – replace if blown.

LEDs are lit but TPSys does not detect any 
Magazine.

Replace the 74HC/LS244 socketed circuit on the MI 
board in the computer box (Always use HC-circuits 
when replacing).

If replacing this circuit does not solve the problem – 
Check the XMIF cable between the computer box and 
the Magazines.

LEDs are lit and TPSys does detect the 
Magazine

Make sure there are no components or other things stuck 
in the Magazine slot connectors – check all the slots.

If the action above does not solve the problem – 
Change the driver circuits on the MI board (ULN2003, 
L603 or L702).

If the action above does not solve the problem – Replace 
the MI board and/or the MOT-M or the MCU.
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TM – Tape Magazines

The TM tape Magazines can handle all tape materials – paper, plastic and 
aluminium. They do not have removable feeders like the Agilis range of 
Magazines.

TM magazines are available for a range of tape widths – 8 mm – 56 mm. There 
is also a TMFlex Magazine available which have removable feeders with 
internal tape feeding.

Figure 13-9.  TM8 tape magazine.
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Functional Test

Release Button and Status LEDs:

All TM Magazines are equipped with a release button (’1’ in Figure 13-10) 
which has a green LED (2) and a yellow LED (3).

Release button (1)

 Press this button and wait until the green LED is off before removing the 
magazine from the machine.

 This button resets magazine errors for the magazine, i.e. equivalent to 
removing or inserting the magazine.

Green LED (2)

Steady light The magazine is recognized by the system and will be used.

Flashing The release button has been pressed.

Off The system does not use the magazine.

Yellow LED (3)

Steady light At least one feeder is empty or a pick error has occurred.

Off In operation.

Figure 13-10.  Release button and status LEDs.
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Adjusting Pick-Up Position

TM8 magazine pick positions are adjusted by turning an eccentric disk on each 
side of the magazine as follows:

1. Insert the magazine and, select Magazine > Locate Feeder Positions.

2. Select feeder 1 and center the cross hairs on the component.

3. Make a few component advancements by choosing the Step feeder 
option in the upper left menu and check the Y-wise deviation.

4. Adjust feeder 1 by loosening three screws, see Figure 13-11. Turn the 
eccentric disc with two holes as shown in the figure.

– Remove the magazine if inserted near the machine frame. Otherwise, 
it can be adjusted without being moved. If the eccentric disk is turned 
counter-clockwise, the pick-up position is moved forwards, see the 
figure 13-11.

Figure 13-11.  Magazine pick-up position, first feeder.



MYDATA MY9 – MY12 – MY15 – MY19  Component Feeding Systems

P-040-0070-EN – Service Manual Rev. 0000  2008-06 13 - 21

5. When the first feeder is adjusted, repeat step 2 to 4 on the last feeder in 
the magazine.

If the eccentric disk is turned clockwise, the pick-up position is moved 
forwards (see Figure 13-12).

6. Return to feeder 1 and check the pick position again. Adjustments made 
on one side may affect the other side somewhat.

7. When both outermost feeders are properly adjusted, make sure the three 
screws are re-tightened properly on both sides.

The axle shaft points downwards when the magazine is set to default eccentric 
disk position (see Figure 13-13).

From this position the adjustment range is 90 degrees forwards or reverse.

 CAUTION! The belt tension is affected by this adjustment. If the eccentric 
discs are turned more than 10° the belt tension should be readjusted.

Figure 13-12.  Magazine pick-up position, last feeder.

Figure 13-13.  Default eccentric disk position.
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Adjusting Feeder Arm Gap

Procedure

1. Slightly tighten both the countersunk screws at the solenoid bar (one at 
each side of the magazine).

2. Adjust the gap between the feeder wheels and the feeder arm tips (’A’ in 
Figure 13-14) by turning the solenoid bar. 

The gap should be 0.5 mm - 1.0 mm. Set the gap as follows:

– Lift the outermost feeder arm (B) by hand as much as the tip touches 
the feeder wheel.

– Turn the feeder wheel (C) while the feeder arm is lifted.

– Stop turning the feeder wheel when the top point of a tooth passes (D).

– Compare the lifted feeder arm position to the released position and 
estimate the gap.

– Turn the solenoid bar (E) until the gap is 0.5 mm - 1.0 mm.

– Slightly tighten the adjusting screw (protruding head) at the solenoid 
bar.

– Repeat the procedure for the outermost feeder arm on the opposite 
side.

3. Turn all the feeder wheels. The feeder arm tips must not touch the 
wheels. Readjust if necessary.

4. Tighten the four solenoid bar screws.

5. Check the gap again. Readjust if necessary.

Figure 13-14.  Feeder arm gap.
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Setting Code Disc Synchronization

The code disc synchronization can be set either by using a pulse counter device 
or without using this device. The following describes setting the 
synchronization without a pulse counter device.

Procedure

1. Loosen the stop screw on the single hole code disc.

2. Turn the multi-hole code disc by hand (’A’ in Figure 13-15) until the 
eccentric shaft with the feeder arms are as far from the magazine front 
as possible (B), i.e. when the ’d’ distance is maximum.

3. Measure the ’d’ distance and note it down as ’d1.’

4. Continue turning the multi-hole code disc by hand until the eccentric 
shaft with the feeder arms are as close to the magazine front as possible 
(C), i.e. when the ’d’ distance is minimum. 1.5

5. Measure the ’d’ distance and note it down as ’d2.’

6. Calculate ’d3’ as follows:

7. Again, turn the multi-hole code disc until the ’d’ distance equals the 
calculated ’d3’ distance.

8. Without turning the multi-hole code disc, turn the single hole code disc 
until the hole is in the optical sensor read off position (D).

9. Without turning the code discs, position the single hole code disc in the 
middle of the optical sensor gap, and tighten the stop screw.

10. Check the setting by turning the single hole disc until the hole is in the 
optical sensor read off position and measure the ’d’ distance. It shall 
correspond to the calculated ’d3’ distance. If not, readjust the setting.

Figure 13-15.  Setting the code disc.

d3
d1 d2+

2
------------------- 1.5+=
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Measuring Feeder Wheel Friction

This procedure is for the TM8 – TM56 Magazines, but not for the TMFlex 
Magazines.

Prerequisites

– Piece of component tape.

– Dynamometer

Procedure

1. Measure the feeder wheel friction by putting a piece of component tape 
on the feeder wheels and pull the tape using a dynamometer (see 
Figure 13-16). The force required to rotate each wheel shall be 1 - 5N. 

2. If necessary, adjust by turning the nut (A in Figure 13-17) clockwise to 
increase the friction, counter-clockwise to decrease it.

.

Figure 13-16.  Feeder wheel friction measurement.

Figure 13-17.  Feeder wheel pack end nut
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Tray Wagon Magazine

Figure 13-18 below shows the Tray Wagon Magazine inserted in one of the 
magazine positions of a TP9-UFP machine.

The Tray Wagon Magazine can be used on all the MYDATA placement 
machines.

The Tray Wagon Magazine has a Y movement of its own.

Figure 13-18.  Tray Wagon Magazine.

1

3

2
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Tray Wagon Magazine Installation

1. Insert the Tray Wagon magazine in a magazine position (’1’ in 
Figure 13-18). Any magazine position can be used for a one-module 
magazine. Two- and three-module magazines can be used in all 
magazine positions except for the positions required for the magazine 
top overhang.

2. Fasten the magazine by tightening the screw (2).

3. Select Utility > Installation and Calibration > Tray Wagon 
Installation/Removal. The Connect the tray wagon magazine dialog box 
is shown.

4. Connect the magazine cable at the rear of the machine and press <Enter> 
when done. The TWM cable is connected to the XYM-B connector 
underneath the Y wagon. If the magazine has been used before, then the 
connection is made to the cable connector.

5. Press <Enter> to verify OK to initiate hardware?

6. Enter the top table width of the magazine from the Select table width 
dialog box (1 – 3 magazine positions):

7. Check and, if incorrect, modify used magazine position number in the 
shown Tray wagon position calibration dialog box.

For two or three-module magazines, the magazine position furthest to 
the left should be entered.

8. Calibrate the Tray Wagon Magazine position by centering the following 
marks on the tray wagon:

– Lower left mark.

– Upper right mark.

– Lower right mark.

9. Restart any off-line terminal.

The installation extends some of the TPSys menu options. Any off-line 
terminal that has been active during the installation must be restarted to 
make the installation take effect in the off-line menu system.

Tray Wagon Magazine Removal

1. Select Utility > Installation and Calibration > Tray Wagon 
Installation/Removal.

2. The Remove tray wagon? dialog box is shown. Reply Yes to remove the 
tray wagon.

3. Press <Enter> when prompted OK to initiate hardware?

4. The system will indicate that the tray wagon magazine is uninstalled. 
Disconnect the TWM cable connector at the rear of the magazine, loosen 
the fixing screw and remove the magazine.



MYDATA MY9 – MY12 – MY15 – MY19  Peripheral Systems

P-040-0070-EN – Service Manual Rev. 0000  2008-06 14 - 1

14. Peripheral Systems
This chapter describes the peripheral systems, which includes the following 
accessories:

– Signal Tower on page 14-2.

– Printer on page 14-4.
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Signal Tower
An optional signal tower that has red, yellow, green and white light in addition 
to a buzzer can be used to indicate the operational status of the machine.

The combination of light and buzzer signals for various machine states can be 
configured to match individual needs, which is described in the following 
sections.

The unit is connected as follows:

– CP4 board to an 8 pin Din connector labeled Warning lamp.

– CP5 board to a 15 pin D-sub connector behind the connector panel at 
the rear of the machine.

The machine can be pre-wired with a 15 pin D-sub connector in one of the 
cable racks. The connector carries +25V, GND and a number of control 
signals.

Signal connection:

Bit 0 = Red lamp

Bit 1 = Yellow lamp

Bit 2 = Green lamp

Bit 3 = Not connected

Bit 4 = White lamp (fixed at GND on most CP4 boards).

Bit 5 = Not connected

Bit 6 = Buzzer

Bit 7 = Not connected

Machine States

The machine can be in seven different states, which are defined in the below 
default settings table. Each state can be indicated with the signal tower with a 
combination of lit lamps and activated buzzer. The lamps can have steady light 
or be blinking and the buzzer sound can be intermittent or continuous.

The combination of lit lamps, blinking lamps and buzzer sound for the various 
machine states is configured in a parameter file.
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Default Settings

The settings shown in the following table is the default settings for delivered 
machines.

The desired combinations of lamp and buzzer signals for each machine state 
are set in the parameters. See the Software Manual for information on how to 
change these parameters.

Testing the Signal Tower

Use the procedure below to test the function of the lamps in the Signal Tower.

Procedure

1. If not already running, start the Service Program by selecting Exit > Exit 
To Service in the TPSys menu.

2. Select Utility > Warning lamps.

3. Select which lamp to be altered in the field named Lamp.

4. Each lamp can be set in three different states On, Off or Blink by moving 
the cursor to the desired field and pressing <Enter>.

Default signal  Machine state  Description

Green steady light Running Normal mounting or gluing operation.

Waiting The machine is running but it waits for loading or unloading 
the board.

Green steady light + 
yellow blinking + 
intermittent buzzer

Poor performance The machine is running but components cannot be picked 
from at least one magazine feeder which may be out of 
components. The same component type is however 
available in another magazine feeder.

Stops soon The machine is running but components cannot be picked 
from at least one magazine feeder which may be out of 
components. The layout will not be completely mounted.

Yellow steady light Idle/stopped The machine

- has not been started yet

or

- has finished mounting/gluing a layout.

or

- is stopped by the operator.

Red steady light + 
buzzer

Operator needed The machine cannot complete the assembly without help 
from the operator. Typically caused by lack of components.

Error The machine is stopped due to a fatal error or by an 
emergency stop button(s).
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Printer

A printer is an option with the machine. It is used to print out several kinds of 
data, for example:

– Component data.

– Package data.

– Magazine and tray data.

– Layout, panel and PCB data.

– Settings and parameters.

– Production data.

This section describes how to prepare the following printer for usage in 
TPSys:

Figure 14-1.  Printer.



MYDATA MY9 – MY12 – MY15 – MY19  Peripheral Systems

P-040-0070-EN – Service Manual Rev. 0000  2008-06 14 - 5

Installation

The printer is delivered in its original box. With the printer there is a 
manufacturers manual detailing how some of the steps below are to be 
performed.

Procedure

1. Unpack the printer and check the contents according to the printer 
setup guide.

2. Install toner and load paper as per the printer manual.

3. Make sure the power for the MY machine is switched off.

4. Attach the power cord to the printer and the mains power. Plug the power 
cord into the printer first, then into a grounded outlet.

5. Insert the printer end of the cable firmly into the connector on the back 
of the printer. Fasten the cable to the printer securely.

6. Connect the other end of the cable to the printer connector on the MY 
machine backside (see Figure 14-2). Fasten the cable securely.

7. Switch on the MY machine and turn on the printer. It takes about 10 
seconds for the printer to initialize, warm up, and display the ON-LINE 
message, indicating the printer is ready to receive data.

8. Do not start TPSys.

9. Follow the description in the TPSys 2.6 Installation Guide, or software 
manual, on how to install and configure the printer. For details on 
operations of the printer, please refer to the printer manual.

It is possible to set printer options using the TPSys web interface. In found in 
the Service Tools menu.

Figure 14-2.  Mains input panel.
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15. Safety System
The safety system comprises the following parts:

– Emergency Stop Buttons on page 15-1.

– Optical Safety System on page 15-2.

– Cover and Door Switches on page 15-2.

This chapter contains a description of these parts. It also contains adjustment 
and calibration information for the WSR2 boards in the optical safety system. 
There is also a description of a functional test that displays the status of the 
emergency stop buttons and the light beams 

Emergency Stop Buttons
There are two emergency stop buttons located on the machine frame adjacent 
to the Y wagon.

The emergency stop buttons are red and they stop all machine movements 
immediately when pressed down.

The buttons are released by turning the knobs clockwise.

Emergency stop buttons on MYDATA accessories such as Tray Exchanger – 
TEX, conveyor system, etc. have the same function, that is to switch all motors 
off and release movable machine elements.

 WARNING! An emergency stop button must always be pressed down when 
hands, fingers, tools or other objects are within a shielded area or in the 
danger area of movable machine elements such as the X wagon or Tray 
Wagon Magazine.

Restart

To restart the machine after an emergency button has been released, enter a 
command on the keyboard.
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Optical Safety System

There is an optical safety system that transmits and receives non-visible light 
beams between the X wagon and the machine ends, along the glass shield. If 
any of these light beams is blocked, a safety relay stops the X movement 
immediately.

The X wagon safety relay is included in the safety system.

The optical safety system is built-up by two WSR2 boards on the X wagon and 
two TST2 boards in the machine ends.

The WSR2 boards have switches that must be set as detailed in the adjustment 
part of this chapter.

Cover and Door Switches

There are electrical switches at the X-wagon covers and at the Y-wagon 
cabinet.

If any of the switches at the X-wagon covers is activated, i.e. if a cover is 
opened, then the X-wagon safety relay stops the X movement immediately.

If the front or rear part of the Y-wagon cabinet is opened, then an Y-motor 
relay stops the Y movement immediately.

The Conveyor transp. are controlled by the MOT-X board.
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Functional Test
This procedure displays the status of the emergency stop buttons and the light 
beams of the X-wagon optical safety system.

Procedure

1. Start the Service Program by selecting Exit > Exit To Service in the 
TPSys menu.

2. To be able to see the Conveyor transp. settings, open the Show/Hide 
safety switches information box by selecting: Motor > Show/Hide safety 
switches. The Conveyor transp. dialog box is shown. The following 
settings can be made:

Conveyor hold

– No – The emergency stop buttons are not pressed. The machine is 
operable.

– Yes – At least one of the emergency stop buttons are pressed down. 
The machine is not operable.

Light curtain

– No – The light beams of the X-wagon optical safety system are not 
blocked (green LED lit on the optical safety unit). The machine is 
operable.

– Yes – The light beams are blocked (red LED lit). The machine is not 
operable.

 Both the emergency stop buttons have to be pressed down to release the 
X wagon and make it possible to move it manually.



Safety System MY9 – MY12 – MY15 – MY19  MYDATA

15 - 4 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Adjusting the WSR2 Switches

The optical safety system is built-up of two WSR2 boards on the X wagon and 
two TST2 boards in the machine ends. The WSR2 boards have switches that 
must be set as detailed below.

The WSR2 boards have two switches each, S1 and S2. The boards are located 
leftmost and rightmost on the lower part of the X wagon. The boards are 
shown in Figure 15-1 and Figure 15-2. In some cases WSR2 switches may be 
found in a different location as to the ones shown in the figures below. The 
markings though are always the same.

• The switch setting for the WSR2 board on the left-hand side of the X wagon 
is shown in Figure 15-1. S1 should be set to ON-OFF-OFF-ON and S2 to 
OFF-ON-OFF-ON.

• The switch setting for the WSR2 board on the right-hand side of the 
X wagon is shown in Figure 15-2. S1 should be set to ON-OFF-OFF-ON 
and S2 to ON-OFF-ON-OFF.

Figure 15-1.   Left WSR2 board.

Figure 15-2.  Right WSR2 board.
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16. Test Protocol
This chapter is intended for the test protocols provided with the machine.
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17. Schematics
This chapter contains the block schematics – ZG-040-0004C – for MYDATA 
MY9 – MY12 – MY15 – MY19 machines.

Detailed schematics are available from http://www.mydata.com



Schematics MY9 – MY12 – MY15 – MY19  MYDATA

17 - 2 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Power Supply And Ups

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

1
5
-J

a
n
-2

0
0
1

P
o

w
e
r 

s
u

p
p

ly
 a

n
d

 U
P

S
0
0
0
4

1 Z
G
-0
4
0
-0
0
0
4
C

F
il
e
 n

a
m

e

C
:\
tm

p
\P

o
w

e
rs

.s
ch

T
sV

T
sV

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

E
M

B

B
M

4

M
a

in
s

 i
n

p
u

t 
u

n
it

 a
n

d
 E

L
M

O
 t

ra
n

s
fo

rm
e

r 
u

n
it

s

S

E
S

P
o

w
e

r 
S

u
p

p
ly

 4

E
L

M
O

 p
o

w
e

r 
s

u
p

p
ly

A
C

 i
n

A
C

 i
n

P
E

+
7

5
V

+
3

8
V

P
W

R

-3
8

V

-7
5

V

5
5

V
 A

C
1

1
1

0
V

 A
C

P
E

5
5

V
 A

C
2

N
R

E
G

+
7

5
V

+
3

8
V

P
W

R

-3
8

V

-7
5

V

5
5

V
 A

C
1

5
5

V
 A

C
2

+
7

5
V

+
3

8
V

D
C

D
C

 s
u

p
p

ly

P
W

R

-3
8

V

-7
5

V

5
5

V
 A

C
1

5
5

V
 A

C
2

+
2

5
V

-2
5

V

+
3

8
V

-3
8

V

B
M

4
C

B
B

N
B

 m
a

s
te

r

+
7

5
V

+
3

8
V

+
2

0
V

G
N

D

-3
8

V

-7
5

V

M
 5

5
V

 A
C

1

M
 5

5
V

 A
C

2

+
2

5
V

 I
N

-2
5

V
 I

N

+
7

5
V

+
3

8
V

P
W

R

-3
8

V

-7
5

V

T
S

T
2

P
A

IB
2

+
5

V

+
3

8
V

P
W

R

-3
8

V

A
ll

 M
O

T
 b

o
a

rd
s

X
W

B
3

H
Y

D
B

3
P

T
1

W
S

R
2

+
2

5
V

+
5

V

G
N

D

-2
5

V

A
ll

 p
o

w
e

rs

+
2

5
V

+
1

2
V

R
+

5
V

G
N

D

-2
5

V

+
2

5
V

-2
5

V

+
1

5
V

-1
5

V

-2
5

V
-5

V

+
2

5
V

R
+

5
V

G
N

D

-2
5

V

+
2

5
V

G
N

D

-2
5

V

+
5

V

G
N

D

G
N

D

+
5

V

+
2

5
V

G
N

D

S TR

-2
5

V
-1

7
V

+
1

5
V

+
2

5
V

-1
5

V

+
2

4
V

+
2

4
V

+
1

2
V

+
3

8
V

-3
8

V

+
2

5
V

V
C

C

+
5

V
A

-2
0

V

-5
V

E
L

M
O

+
3

4
0

V

3 phase AC input

+
5

,6
V

-5
V

S
F

B +
3

8
V

P
W

R

-3
8

V

R S T

A
T

C
2

+
1

2
V

 d
is

k

+
5

V

G
N

D

-2
5

V

-1
2

V

-5
V

C
P

5 +
2

5
V

+
5

V

G
N

D

5
5

V
 A

C
1

5
5

V
 A

C
2

+
5

V

-5
,6

V

+
5

V
re

f

+
2

5
V

+
2

5
V

G
N

D
G

N
D

G
N

D

G
N

D

G
N

D
0

E
N

B
A

T
T

F
1

E
L

M
O

 b
o

x

F
1

F
2

C
o

m
p

u
te

rb
o

x

U

U

U

U

+
3

4
0

 V

F
1

1

F
9

F
1

0

F
1

2

F
1

3

F
1

4

R

0
 /

 T

F
1

E
T

E
0

0

E
R

2
3

0
V

 A
C

 /
 S

T

F
1

6

F
1

1

F
6

F
1

P
E

U U

-7
5

V

-3
8

V

P
W

R

+
3

8
V

+
7

5
V

+
7

5
V

+
3

8
V

P
W

R

-3
8

V

-7
5

V

B
N

B
 s

la
v

e

-7
5

V

-3
8

V

P
W

R

+
3

8
V

+
7

5
V

B
o

o
s

te
r

3
 p

h
a

s
e

3
 p

h
a

s
e

M
a

in
 s

w
it

c
h

3
 p

h
a

s
e

3
 p

h
a

s
e

X
B

N
B

 c
a

b
le

X
B

N
B

 c
a

b
le

X
C

P
 c

a
b

le

XBOP cable XBOF cable

M
I

A
ll

 p
o

w
e

rs

+
5

V

+
1

2
V

+
2

5
V

G
N

D

-2
5

V

-2
5

V

G
N

D

+
5

V

+
2

5
V

A
ll

 p
o

w
e

rs

+
2

5
V

+
5

V

G
N

D

5
5

V
 A

C
1

5
5

V
 A

C
2

(S
u

p
p

ly
 o

ff
)´

+
1

2
V

 d
is

k

+
5

V

G
N

D

-2
5

V

U U

-2
5

V

UU U

U U

UU

U

+
2

5
V

X
 w

a
g

o
n

G
N

D

W
S

R
2

U

+
3

8
V

P
W

R

-3
8

V

XPOW cable

XPS cable

XMUR cable

XXW cables

X
T

S
T

 c
a

b
le

G
N

D

+
5

V

T
o

 b
e

 m
e

a
s

u
re

d

+
2

4
V

+
1

2
V

G
N

D

D
+

5
V

G
N

D

+
5

V

+
2

4
V

WSR-WSR cable

G
N

D

+
2

4
V

+
5

V

X
M

E
B

+
2

5
V

G
N

D
G

N
D

+
2

5
V

X
H

Y
D

 c
a

b
le

XTP cable

XSA cable

X
X

W
2

B
 c

a
b

le

XGTS cable

T
S

T
2

+
5

V

G
N

D

X
G

T
S

2
5

V
_
O

N

1
0

0
V

 A
C

+
5

V
+

5
V

P
E

P
E

B
o
o
s
te

r2
 (

Z
)

+
7

5
V

-7
5

V

G
N

D

+
7

5
V

-7
5

V

G
N

D

+
3
8
..
7
5
V

-3
8
..
7
5
V

S
W

IT
C

H
 M

O
D

E
 P

O
W

E
R

 S
U

P
P

L
Y

 5
V

+
5

V

G
N

D

A
C

 I
N

P
E

S
W

IT
C

H
 M

O
D

E
 P

O
W

E
R

 S
U

P
P

L
Y

 1
2

V

+
1

2
V

G
N

D

A
C

 I
N

P
E

U
P

S

A
C

 O
U

T

A
C

 I
N

P
E

P
E

C
o

m
m

o
n

S
h

u
t 

D
o

w
n

D
B

-9
c

o
n

n
e

c
to

r
POWER OUTPUT UPS cable

B
O

X
5

V
 1

2
V

U
P

S
 U

N
IT

 F
O

R
 M

Y

XP5/12V cable

X
U

P
S

c
o

n
n

e
c

to
r

G
N

D

1
0

K

G
N

D

S
h

u
t 

D
o

w
n

G
N

D

X
P

5
c

o
n

n
e

c
to

r

X
P

1
2

c
o

n
n

e
c

to
r

+
5

V

G
N

D

+
1

2
V

G
N

D

X
U

P
S

 C
O

M
. 

C
A

B
L

E

P
o

w
e

r 
o

u
tl

e
ts

0
/S

0
/R

0
/S

0
/R

D
ra

w
e

r 
fa

n
s

1
0

0
V

 A
C

B
o

o
s

te
r 

fa
n

s

1
0

0
V

 A
C

F
il

te
r 

fa
n

1
0

0
V

 A
C

B
o
o
s
te

r2
 (

Y
)

+
7

5
V

-7
5

V

G
N

D

+
7

5
V

-7
5

V

G
N

D

+
3
8
..
7
5
V

-3
8
..
7
5
V

3
 P

H
A

S
E

 F
il

te
r

UPS MAINS cable

U
+

7
V

+
2
5
V

U

E
+

5
V

U

D
+

5
V

(E
+

5
V

 t
o
 s

u
p
p
ly

 e
n
co

d
e
rs

)
F

P
C

IB
2

1
0

0
V

 A
C

1
0

0
V

 A
C

D
ra

w
e

r 
fa

n
s

F
P

C
IB

2

1
0

0
V

 A
C

1
0

0
V

 A
C

1
0

0
V

 A
C

T
e

rm
in

a
l 

b
lo

c
k

F
il

te
r 

fa
n

1
0

0
V

 A
C

1
0

0
V

 A
C

1
0

0
V

 A
C

1
0

0
V

 A
C

1
0

0
V

 A
C

XPOWIN cable

FILTER FAN POWER cable

XFAN 110V cable

XFAN 110V cable

XMPS MAINS POW.SW. cable

P
E

M
C

C
B

M
Y

C
A

N
0

M
Y

C
A

N
1

P
G

N
D

+
3

8
V

+
2

4
V

X
C

A
N

P

M
Y

C
A

N
 b

u
s

XCANP cable

(S
u

p
p

ly
 o

ff
)'

1
6
-M

a
r-

2
0
0
7

T
S



MYDATA MY9 – MY12 – MY15 – MY19  Schematics

P-040-0070-EN – Service Manual Rev. 0000  2008-06 17 - 3

Safety System

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

1
4
-O

ct
-1

9
9
7

S
a
fe

ty
 s

y
s
te

m
0

0
0

4
2 Z
G
-0
4
0
-0
0
0
4
C

H
S

H
S

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

C
:\t

m
p
\s

a
fe

ty
.s

ch

M
Y

C
A

N
 e

n
d

 p
lu

g

B
o

o
s

te
r2

 (
Y

)

M
O

T
-X

Y
W

B
2

M
O

T
-C

M
O

T
-Y

E
M

B

B
N

B
 (

X
)

N
R

E
G

X
W

B
3

B
M

4
C

B
C

P
5

B
M

4

S
F

B

E
M

E
R

G
E

N
C

Y
 S

T
O

P
 R

E
L

A
Y

S

A
u

x
in

1

A
u

x
in

 4

/A
u

x
in

 3

A
u

x
in

 4
B

O
O

E
N

A

P
A

IB
2

A
u

x
o

u
t 

5

/E
M

 P
R

E
S

S

A
u

x
o

u
t 

5

/S
A

F
E

T
Y

 O
K

A
u

x
in

 4
/E

M
 P

R
E

S
S

X
6

E
L

M
O

 b
o

x

E
L

M
O

a
/b

[5
..

0
]

X
P

A
IB

B
O

O
E

N
A

X
 r

e
la

y
+

C
o

m
p

u
te

r 
b

o
x

 2

X
 w

a
g

o
n

X
 b

ra
k

e

a
/b

[5
..

0
]

/E
M

 P
R

E
S

S

/E
M

 P
R

E
S

S

X
M

X
O

/E
M

 P
R

E
S

S

/E
M

 P
R

E
S

S

/S
A

F
E

T
Y

 O
K

E
L

M
O

 i
n

h

c
o

n
tr

o
l

X
P

A
IB

XPAIB cable

X
B

O
F

 c
a

b
le

B
O

O
E

N
A

B
O

O
E

N
A

XBNB cable

XSA cable

X
S

A
c

o
n

n
e

c
to

r

/S
A

F
E

T
Y

 O
K

E
L

M
O

 i
n

h

B
o

o
s

te
r 

u
n

it

WSR cable

X
X

W
2

A
 c

a
b

le

E
L

M
O

 i
n

h

/E
M

 P
R

E
S

S

E
L

M
O

 i
n

h

re
l 

h
i

XYBO cable

T
S

T
2

 (
le

ft
)

W
S

R
2

 (
ri

g
h

t)

W
S

R
2

 (
le

ft
)

T
S

T
2

 (
ri

g
h

t)

Y
 w

a
g

o
n

+
5

V

/S
A

F
E

T
Y

 O
K

O
K

/E
M

 P
R

E
S

S

D
A

IS
Y

Y
 &

 Y
M

 M
O

T
O

R

X
W

 &
 X

B
E

L
T

 M
O

T
O

R

m
a

c
h

in
e

 c
o

v
e

rs
 &

 d
o

o
rs

E
L

M
O

-P
S

P
S

 h
o

t
P

S
 h

o
t

P
S

 h
o

t
P

S
 h

o
t

/E
M

 P
R

E
S

S
/E

M
 P

R
E

S
S

+
2

5
V

-2
5

V

..
.

L
e

ft
 e

m
e

rg
e

n
c

y
 s

to
p

 b
u

tt
o

n

R
ig

h
t 

e
m

e
rg

e
n

c
y

 s
to

p
 b

u
tt

o
n

XYF cable

Y
 H

O
O

D

/S
A

F
E

T
Y

 O
K

X
Y

H
::

4

Y
 H

O
O

D

+
5

V

X
Y

H
::

1

/E
M

 P
R

E
S

S

G
N

D

D
A

IS
Y

G
N

D

fr
o

n
t 

Y
-h

o
o

d
re

a
r 

Y
-h

o
o

d

/S
A

F
E

T
Y

 O
K

/S
A

F
E

T
Y

 O
K

/S
A

F
E

T
Y

 O
K

/S
A

F
E

T
Y

 O
K

Y
 H

O
O

D

Y
 H

O
O

D

/A
u

x
in

 0
Y

 H
O

O
D

G
N

D

X
 B

E
L

T
 m

o
to

r 
b

ra
k

e

a
c

t 
d

o
o

rs

d
o

o
rs

 r
e

t

d
o

o
rs

d
o

o
rs

X
R

D
::

1

X
L

D
::

2

re
t 

re
le

a
s

e

e
x

t 
a

c
t

p
re

s
 r

ig
h

t
X

S
L

1
::

2
G

N
D

 s
a

fe
ty

Y
 H

O
O

D
Y

 H
O

O
D

X
 b

ra
k

e
s

a
fe

ty
 g

n
d

re
l 

h
i

s
a

fe
ty

 g
n

d

X
 r

e
la

y

1
k

Ω

3
9

k
Ω

1
0

k
Ω

+
5

V

/E
M

 P
R

E
S

S

A
u

x
in

0

Y
 E

N
A

B
L

E

Y
 E

N
A

B
L

E

A
u

x
o

u
t0

Y
 E

N
A

B
L

E

4
4

0
Ω

n
o

te
: 

S
h

o
rt

h
a

n
d

 i
s

 u
s

e
d

 f
o

r 
s

o
m

e
 o

f 
th

e
 m

o
re

 f
re

q
u

e
n

tl
y

 u
s

e
d

 s
ig

n
a

l 
n

a
m

e
s

.
  

  
/E

M
 P

R
E

S
S

 =
=

 (
e

m
e

rg
e

n
c

y
 p

re
s

s
e

d
)'

  
  

B
O

O
E

N
A

 =
=

 b
o

o
s

te
r 

e
n

a
b

le
p

re
s

 r
ig

h
t

b
ra

k
e

 X

re
t 

re
le

a
s

e

re
t 

2

re
t 

1

X
M

B
R

::
6

X
M

B
R

::
5

K
2

K
3

K
1

+
2

5
V

+
2

5
V

G
N

D
G

N
D

X
 r

e
la

y
X

 r
e

la
y

+

X
 r

e
la

y
X

 r
e

la
y

+

G
N

D1
0

k
Ω

X
M

B
R

 c
a

b
le

A
u

x
.e

m
e

rg
.c

a
b

le
X

M
R

 c
a

b
le

T
ra

c
k

b
a

ll
 h

o
u

s
e

XMXO

B
ra

k
e

 r
e

le
a

s
e

d
 i

f 
fe

d
 2

5
V

T
ra

n
s

is
to

r 
n

o
rm

a
ly

a
c

ti
v

a
te

d
 b

y
 X

-s
e

rv
o

th
u

s
 r

e
le

a
s

in
g

m
o

to
r 

b
ra

k
e

a
n

d
 e

n
a

b
le

in
g

m
o

to
r 

re
la

y
s

B
ra

k
e

 l
o

o
p

 t
h

ru
s

a
fe

ty
 b

u
tt

o
n

s
re

le
a

s
e

s
 m

o
to

r
w

h
e

n
 b

o
th

b
u

tt
o

n
s

 a
re

p
re

s
s

e
d

S
A

F
E

T
Y

 O
K

in
v

e
rt

e
d

 !

S
A

F
E

T
Y

 O
K

S
A

F
E

T
Y

 O
K

S
A

F
E

T
Y

 O
K

cable

X
B

J
I-

A
::

2
X

B
J

I-
A

::
3

X
B

J
I-

B
::

2
X

B
J

I-
B

::
3

C
o

n
v
e
y
o

r 
s
a
fe

ty
 s

e
n

s
o

rs
 (

b
o

a
rd

 j
a
m

m
e
d

)

/B
O

A
R

D
 J

A
M

M
E

D

/B
O

A
R

D
 J

A
M

M
E

D

+
5

V

/A
u

x
in

 1
/B

O
A

R
D

 J
A

M
M

E
D

G
N

D

S
IP

H
A

 G
u

a
rd

 m
a

s
te

r

+
2

4
V

1
4

1
3

S
E

N
S

E

S
E

N
S

E

(P
R

O
 L

in
e

)

G
N

D

fr
o

n
t 

Y
-h

o
o

d
re

a
r 

Y
-h

o
o

d

+
2

4
V

+
2

4
V

1
k

Ω

re
t 

1
re

t 
2

M
C

C
B

E
S

T
O

P
+

s
h

u
t 

re
l

G
N

D
S

w
+

 O
u

t 
1

S
w

+
 I

n
 0

M
Y

C
A

N
 b

u
s

S
w

+
 I

n
 0

S
w

+
 O

u
t 

0

E
S

T
O

P
+

S
w

- 
In

 0

S
w

- 
In

 0

E
S

T
O

P
-

S
w

- 
O

u
t 

0

E
S

T
O

P
+

S
w

+
 I

n
 1

S
w

+
 O

u
t 

1

S
w

- 
In

 1

E
S

T
O

P
-

S
w

- 
O

u
t 

1

XEXT2 cable

s
h

u
t 

re
t 

2
s

h
u

t 
re

t 
2

1
6
-M

a
r-

2
0
0
7

T
S



Schematics MY9 – MY12 – MY15 – MY19  MYDATA

17 - 4 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

C/fi Movement, Vacuum And Electrical Test

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

1
7
-N

o
v-

2
0
0
6

M
Y

C
A

N
 b

u
s

0
0

0
4

3 Z
G
-0
4
0
-0
0
0
4
C

T
S

T
S

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

C
:\t

m
p
\m

yc
a
n
.s

ch

Y
C

B
3

Y
M

B
2

C
A

N
 b

o
a

rd

M
Y

C
A

N
 e

n
d

 p
lu

g

M
C

C
B

M
C

B

Y
C

B
2

C
P

U
 b

o
a

rd

C
B

P
C

I 
b

u
s

P
C

I 
b

u
s

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

/C
A

N
0

C
A

N
0

A
T

C
P

U
2

C
o

m
p

u
te

rb
o

x

XCHAIN2 cable

CAN cable

M
Y

C
A

N
 c

a
b

le

E
L

M
O

 b
o

x

MYCAN cable

C
A

N
1

/C
A

N
1

/C
A

N
1

C
A

N
1

1
2

0
Ω

C
A

N
0

/C
A

N
0

/C
A

N
0

C
A

N
0

C
A

N
1

/C
A

N
1

/C
A

N
1

C
A

N
1

C
A

N
0

/C
A

N
1

/C
A

N
0

C
A

N
1

1
2

0
Ω

E
V

E
N

T
/E

V
E

N
T

1
2

0
Ω

M
C

U

Y
M

 E
le

c
tr

o
n

ic
 C

a
b

in
e

t 
2

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

Y
M

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

E
V

E
N

T
/E

V
E

N
T

C
A

N
0

/C
A

N
0

C
o

n
v

e
y

o
r

M
Y

C
A

N
 e

n
d

 p
lu

g

1
2

0
Ω

E
V

E
N

T

/E
V

E
N

T

C
A

N
0

/C
A

N
0

XMYCAN cable

1
6
-M

a
r-

2
0
0
7

T
S



MYDATA MY9 – MY12 – MY15 – MY19  Schematics

P-040-0070-EN – Service Manual Rev. 0000  2008-06 17 - 5

X Movement

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

1
4
-O

ct
-1

9
9
7

C
/F

i 
m

o
v
e
m

e
n

t,
 v

a
c
u

u
m

0
0

0
4

4 Z
G
-0
4
0
-0
0
0
4
C

N
vR

N
vR

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

a
n

d
 e

le
c
tr

ic
a
l 
te

s
t

C
:\t

m
p
\C

fim
o
ve

.s
ch

M
O

T
-C

X
W

B
3

B
M

4
C

B

A
T

-C
P

U

B
M

4

M
O

T
-M

M
O

T
-Z

M
I

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

C
o

m
p

u
te

r 
b

o
x

 2
X

 w
a

g
o

n

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

p
a

 b
u

s

p
d

 b
u

s
p

d
 b

u
s

p
a

 b
u

s

X
4

P
u

m
p

 m
o

t 
H

i

P
u

m
p

 m
o

t 
L

o

X
4

A
u

x
in

/A
u

x
o

u
t

A
 m

o
to

r 
H

i

A
 m

o
to

r 
L

o

P
h

a
s

e
 D

1

A
 m

o
to

r 
H

i

A
 m

o
to

r 
L

o

P
h

a
s

e
 A

1

P
h

a
s

e
 A

2

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

P
h

a
s

e
 D

2

A
u

x
in

/A
u

x
o

u
t

H
F

i 
m

o
to

r 
H

i

H
F

i 
e

n
c

 A

H
F

i 
e

n
c

 B

H
F

i 
m

o
to

r 
L

o

C
 m

o
to

r 
H

i

C
 m

o
to

r 
L

o

C
 e

n
c

 A

C
 e

n
c

 B

F
i 

m
o

to
r 

H
i

F
i 

m
o

to
r 

L
o

F
i 

e
n

c
 A

F
i 

e
n

c
 B

P
u

m
p

 m
o

t 
H

i

P
u

m
p

 m
o

t 
L

o

Z
:A

m
o

to
r 

H
i

Z
:A

m
o

to
r 

L
o

Z
:e

n
c

 D
1

Z
:e

n
c

 D
2

3
P

T
1

P
u

m
p

 m
o

t 
H

i

P
u

m
p

 m
o

t 
L

o

C
:A

m
o

to
r 

H
i

C
:A

m
o

to
r 

L
o

C
:e

n
c

 A
2

C
:e

n
c

 A
1

C
:B

m
o

to
r 

H
i

C
:B

m
o

to
r 

L
o

C
:e

n
c

 B
1

C
:e

n
c

 B
2

A
u

x
in

/A
u

x
o

u
t

H
F

i 
m

o
to

r 
H

i

H
F

i 
e

n
c

 A

H
F

i 
e

n
c

 B

H
F

i 
m

o
to

r 
L

o

C
 m

o
to

r 
H

i

C
 m

o
to

r 
L

o

C
 e

n
c

 A

C
 e

n
c

 B

F
i 

m
o

to
r 

H
i

F
i 

m
o

to
r 

L
o

F
i 

e
n

c
 A

F
i 

e
n

c
 B

P
u

m
p

 m
o

t 
L

o

P
u

m
p

 m
o

t 
H

i

3
P

T
1

H
F

i

F
i

C

P
U

M
P

E
N

C

E
N

C

E
N

C

H
y

d
ra

 F
i 

H
i

H
y

d
ra

 F
i 

L
o

H
y

d
ra

 F
i 

e
n

c

H
y

d
ra

 F
i 

e
n

c

P
u

m
p

 m
o

t 
H

i

P
u

m
p

 m
o

t 
L

o

C
 m

o
to

r 
H

i

C
 m

o
to

r 
L

o

C
 e

n
c

o
d

e
r 

A

C
 e

n
c

o
d

e
r 

B

F
i 

m
o

to
r 

H
i

F
i 

m
o

to
r 

L
o

F
i 

e
n

c
o

d
e

r 
A

F
i 

e
n

c
o

d
e

r 
B

+
2

5
 V

V
a

c
u

u
m

 o
n

P
re

s
s

u
re

 o
n

X
T

P

X
T

P

U
b

e
/E

x
c

.s
ig

n
.

C
 d

ri
v

e

G
N

D

C
o

m
p

. 
L

o
w

C
e

n
te

ri
n

g
 e

le
c

tr
o

d
e

s

2

3 1

V
A

L
V

E

2

3 1

V
A

L
V

E

XXW2A cable

XXW1 cable

F
F

i 
1

.6
A

F
C

 1
.6

A

F
H

F
i 

1
.6

A

H
Y

D
B

H
F

i 
m

o
to

r 
H

i

H
F

i 
m

o
to

r 
L

o

H
F

i 
e

n
c

 A

H
F

i 
e

n
c

 B

H
F

i 
m

o
to

r 
H

i

H
F

i 
m

o
to

r 
L

o

H
F

i 
e

n
c

 A

H
F

i 
e

n
c

 B

XHYD cable

M
O

T
O

R

M
O

T
O

R

M
O

T
O

R

M
O

T
O

R

XIF4 cable

XTP cable

X
T

C
 c

a
b

le

C
M

B
2

C
 u

n
it

M
id

a
s

X
C

M
c

o
n

n
e

c
to

r

X
F

iM
2

c
o

n
n

e
c

to
r

X
V

S

X
V

S

O
p

ti
o

n
a

l 
H

y
d

ra
 u

n
it

V
a

c
u

u
m

 p
u

m
p

U
+

7
V

+
2

5
V

+
2

5
V

1
6
-M

a
r-

2
0
0
7

T
S



Schematics MY9 – MY12 – MY15 – MY19  MYDATA

17 - 6 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Y Movement And Conveyor (MOT Version, 400PT/500T)

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

1
4
-O

ct
-1

9
9
7

X
 m

o
v
e
m

e
n

t
0

0
0

4
5 Z
G
-0
4
0
-0
0
0
4
C

H
S

H
S

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

C
:\t

m
p
\X

m
o
ve

.s
ch

E
M

B

X
M

E
B

B
N

B
 (

X
)

B
N

B
 (

X
)

N
R

E
G

X
W

B
3

B
M

4
C

B
A

T
-C

P
U

B
M

4

M
O

T
-X

S
F

B

S
A

F
E

T
Y

 R
E

L
A

Y
S

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

X
 m

o
to

r 
H

i

D
R

IV
E

M
O

T
O

R
H

I

A
 m

o
to

r 
H

i

A
 m

o
to

r 
L

o

A
u

x
o

u
t 

5

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

P
h

a
s

e
 A

1

P
h

a
s

e
 A

2

X
 m

o
to

r 
H

i

X
 m

o
to

r 
L

o

X
e

n
c

 A
 i

n
v

X
e

n
c

o
d

e
r 

B

W
M

 h
i

X
e

n
c

o
d

e
r 

/A

X
e

n
c

o
d

e
r 

B

B
O

O
E

N
A

P
A

IB
2

X
M

L
O

A

X
D

R
IV

E

X
b

o
o

s
te

r 
e

n
a

X
 m

o
to

r 
L

o

X
M

 t
ra

n
s

d

M
O

T
O

R
H

I

X
M

 t
ra

n
s

d

X
6

E
L

M
O

 b
o

x

E
L

M
O

H
a

ll
 A

..
C

re
s

e
t

P
h

a
s

e
 A

..
C

X
_
re

la
y

g
re

a
s

e

X
M

X
O

-X
6

 c
a

b
le

a
/b

[5
..

0
]

X
P

A
IB

X
 m

o
to

r 
L

o

X
 m

o
to

r 
L

o

M
O

T
O

R
L

O

X
X

W
2

B

X
_
re

la
y

C
o

m
p

u
te

r 
b

o
x

 2

X
 w

a
g

o
n

P
h

a
s

e
 A

..
C

X
_
b

ra
k

e

a
/b

[5
..

0
]

e
o

u
t

e
o

u
t

X
W

 t
ra

n
s

d

X
W

 t
ra

n
s

d

X
M

X
O

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

X
X

W
E

c
o

n
n

e
c

to
r

E
N

C

X
W

M
O

T
O

R

X
M

O
T

O
R

E
N

C

H
A

L
L

 E
N

C
O

D
E

R

X
e

n
c

o
d

e
r 

A
X

e
n

c
o

d
e

r 
A

X
e

n
c

o
d

e
r 

/B
X

e
n

c
 B

 i
n

v

X
X

W
M

c
o

n
n

e
c

to
r

X
 b

ra
k

e

E
L

M
O

 i
n

h

g
re

a
s

e

H
a

ll
 A

..
C

X
X

W
2

A
 +

 B
 c

a
b

le

X
 b

ra
k

e

g
re

a
s

e

c
o

n
tr

o
l

W
M

 r
e

t

e
in

H
a

ll
 A

..
C

X
P

M
O

T
O

R
H

I

X
P

P
h

a
s

e
 A

..
C

X
M

 A
..

C

e
in

X
M

 E
N

C
 /

B

X
M

 E
N

C
 /

A

X
P

A
IB

X
M

 E
N

C
 B

X
M

 E
N

C
 A

XPAIB cable

XXWM cable

X
B

O
F

 c
a

b
le

X
D

R
IV

E

B
O

O
E

N
A

X
W

M
 E

N
C

 /
B

X
W

M
 E

N
C

 /
A

X
W

M
 E

N
C

 B

X
W

M
 E

N
C

 A

XBOP cable

G
N

D

X
T

P
R

X
X

W
M

 h
i

M
O

T
O

R
L

O

X
B

B
c

o
n

n
e

c
to

r

X
X

W
M

c
o

n
n

e
c

to
r

X
B

O
P

c
o

n
n

e
c

to
r

X
T

P
R

c
o

n
n

e
c

to
r

B
O

O
E

N
A

X
B

O
F

c
o

n
n

e
c

to
r

XBNB cable

XBNB cable

XPTR cable

G
N

D

X
G

P
c

o
n

n
e

c
to

r

X
G

P
c

o
n

n
e

c
to

r

X
X

B
E

c
o

n
n

e
c

to
r

+
2

5
V

W
M

 h
i

W
M

 r
e

t

W
M

 h
i

W
M

 r
e

t

P
h

a
s

e
 A

..
C

P
h

a
s

e
 A

e
o

u
t

e
in

e
o

u
t

e
in

re
s

e
t

E
L

M
O

 i
n

h

E
N

C

X
M

 E
N

C
O

D
E

R

P
h

a
s

e
 B

C

B
o

o
s

te
r 

u
n

it

X
 b

e
lt

 m
o

to
r

X
X

W
2

B
X

W
M

E

X
X

B
M

 c
a

b
le

X
X

B
E

 c
a

b
le

X
W

M
E

 c
a

b
le

X
X

W
2

B
 c

a
b

le

X
X

W
2

A
 c

a
b

le

X
M

B
R

 c
a

b
le

K
4

re
s

e
t

E
L

M
O

 i
n

h

X
_
b

ra
k

e

E
L

M
O

 i
n

h

re
s

e
t

g
re

a
s

e

X
_
re

la
y

G
R

E
A

S
E

 P
U

M
P

 M
O

T
O

R

D
R

IV
E

T
P

1
9

 =
 0

,1
8

D
R

IV
E

B
O

O
E

N
A

M
O

T
O

R
 H

I

M
O

T
O

R
H

I

X
M

H
IA

C
o

n
n

e
c

to
r

XP cable

Ω

X
M

R
 c

a
b

le

1
6
-M

a
r-

2
0
0
7

T
S



MYDATA MY9 – MY12 – MY15 – MY19  Schematics

P-040-0070-EN – Service Manual Rev. 0000  2008-06 17 - 7

Y Movement And Conveyor (CAN Version, T3 – T6)

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

1
4
-O

ct
-1

9
9
7

Y
 m

o
v
e
m

e
n

t 
a
n

d
 c

o
n

v
e
y
o

r
0

0
0

4
6 Z
G
-0
4
0
-0
0
0
4
C

N
vR

N
vR

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

(M
O

T
 v

e
rs

io
n

, 
4
0
0
P

T
/5

0
0
T

)

C
:\t

m
p
\Y

m
o
ve

.s
ch

S
L

S
2

Y
C

B
M

4
C

B

A
T

-C
P

U

B
M

4

M
O

T
-Y

M
O

T
-M

B
o

o
s

te
r2

 (
Y

)

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

A
U

X
IN

0
-1

,4
-5

A
U

X
O

U
T

 2
-5

B
 m

o
to

r 
H

i

A
U

X
O

U
T

2
-5

In
p

u
t

O
u

tp
u

t

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

A
u

x
o

u
t 

0

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

P
h

a
s

e
 A

1

P
h

a
s

e
 A

2

P
h

a
s

e
 A

1

B
 m

o
to

r 
H

i

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

B
 m

o
to

r 
L

o

P
h

a
s

e
 A

2

A
 m

o
to

r 
H

i

A
 m

o
to

r 
H

i

P
h

a
s

e
 B

2

A
U

X
IN

0
-1

,4
-5

P
h

a
s

e
 B

1

A
 m

o
to

r 
L

o

P
h

a
s

e
 A

2

L
o

a
d

 r
e

s

E
n

a
b

le

P
h

a
s

e
 A

1

A
 m

o
to

r 
L

o

Y
W

B
2

Y
M

 e
n

c
. 

A

Y
 m

o
to

r 
L

o

Y
 m

o
to

r 
H

i

A
U

X
U

O
T

2
-5

A
U

X
IN

0
-1

,4
-5

A
u

x
o

u
t 

0

Y
W

 t
ra

n
s

d

Y
W

 t
ra

n
s

d

Y
 m

o
to

r 
H

i

M
a

g
 f

ri
c

t 
H

i

Y
M

 m
o

to
r 

H
i

B
 m

o
to

r 
L

o

Y
M

 m
o

to
r 

L
o

Y
M

 e
n

c
. 

B

Y
M

 m
o

to
r 

H
i

A
U

X
IN

0
-1

,4
-5

A
U

X
O

U
T

2
-5

M
a

g
 f

ri
c

t 
H

i

Y
C

 m
o

t 
tr

a
n

s
d

M
a

g
 f

ri
c

t 
H

i

Y
C

 m
o

t 
tr

a
n

s
d

C
o

m
p

u
te

r 
b

o
x

 2
O

p
ti

o
n

a
l 

C
o

n
v

e
y

o
r

(E
m

_
p

re
s

s
)'

In
p

u
t

O
u

tp
u

t

L
o

a
d

 r
e

s

E
n

a
b

le

(E
m

_
p

re
s

s
)'

+
5

V

Y
 m

o
to

r 
L

o

Y
 m

o
t 

tr
a

n
s

d

Y
 m

o
t 

tr
a

n
s

d

Y
M

 m
o

to
r 

L
o

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

A
 m

o
to

r 
H

i

A
 m

o
to

r 
L

o

P
h

a
s

e
 A

1

P
h

a
s

e
 A

2

B
 m

o
to

r 
H

i

M
a

g
 m

a
in

 H
i

M
a

g
 m

a
in

 L
o

G
L

 m
o

t 
tr

a
n

s
d

G
L

 m
o

t 
tr

a
n

s
d

G
P

 m
o

t 
tr

a
n

s
d

B
 m

o
to

r 
L

o

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

M
a

g
 f

ri
c

t 
H

i

M
a

g
 f

ri
c

t 
L

o

G
P

 m
o

t 
tr

a
n

s
d

A
 m

o
to

r 
H

i

A
 m

o
to

r 
L

o

M
a

g
 f

ri
c

t 
L

o

G
P

 m
o

t 
tr

a
n

s
d

G
P

 m
o

t 
tr

a
n

s
d

Y
 m

o
to

r 
H

i

Y
 m

o
to

r 
L

o

Y
 m

o
t 

tr
a

n
s

d

Y
 m

o
t 

tr
a

n
s

d

Y
M

 m
o

to
r 

H
i

Y
M

 m
o

to
r 

L
o

Y
W

 t
ra

n
s

d
Y

W
 t

ra
n

s
d

E
N

C

R
IG

H
T

E
N

C

E
N

C

Y

W
ID

T
H

L
E

F
T

C
O

N
V

E
Y

O
R

F
Y

 4
.0

A

Y
M

 m
o

to
r 

H
i

Y
M

 m
o

to
r 

L
o

Y
M

 e
n

c
. 

A

Y
M

 e
n

c
. 

B

Y
 m

o
to

r 
H

i

Y
 m

o
to

r 
L

o

Y
 e

n
c

. 
A

Y
 e

n
c

. 
B

Y
 e

n
c

. 
A

Y
 e

n
c

. 
B

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

P
U

L
S

E
 G

E
N

E
R

A
T

O
R

+
5

 V

+
5

 V

G
N

D

G
N

D

L
O

A
D

 E
N

C
O

D
E

R

E
N

D
 E

N
C

O
D

E
R

X
S

L
S

X
F

S

H
O

L
D

 /
 R

E
L

E
A

S
E

 I
N

F
O

W
ID

T
H

 A
D

J
U

S
T

Y
M

Y
 w

a
g

o
n

XYF cableXMF cable

F
Y

M
 1

.6
A

(E
m

_
p

re
s

s
)'

(E
m

_
p

re
s

s
)'

F
ro

m
 P

A
IB

 t
h

ro
u

g
h

s
e

v
e

ra
l 

b
o

a
rd

s
u

s
e

 s
c

h
e

m
a

ti
c

S
A

F
E

T
Y

 S
Y

S
T

E
M

T
ra

y
 w

a
g

o
n

 m
a

g
a

z
in

e

X
Y

M
-B

 c
a

b
le

M
O

T
O

R

M
O

T
O

R

M
O

T
O

R

M
O

T
O

R

M
O

T
O

R
M

O
T

O
R

S
U

P
P

O
R

T
S

U
P

P
O

R
T

XYBO cable

Y
 e

n
c

. 
/A

Y
 e

n
c

. 
/A

Y
 e

n
c

. 
/B

Y
 e

n
c

. 
/B

Y
W

 t
ra

n
s

d
Y

W
 t

ra
n

s
d

C
O

M
M

A
N

D

X
Y

E
-A

::
3

X
Y

E
-B

::
3

X
Y

E
-A

::
1

X
Y

E
-B

::
1

E
n
d
 s

w
itc

h
, r

e
a
r

E
n
d
 s

w
itc

h
, f

ro
n
t

1
k

Y
 w

a
g

o
n

 e
n

d
 s

w

+
5

V

Y
 w

a
g

o
n

 e
n

d
 s

w

Y
 w

a
g

o
n

 e
n

d
 s

w
A

u
x

in
 5

G
N

D

Ω

0
R

5
6

, 
6

W

G
N

D
1
6
-M

a
r-

2
0
0
7

T
S



Schematics MY9 – MY12 – MY15 – MY19  MYDATA

17 - 8 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Z/HZ Movement And Force Sensor

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

2
9
-A

p
ri
l-
2
0
0
5

Y
 m

o
v
e
m

e
n

t 
a
n

d
 c

o
n

v
e
y
o

r
0

0
0

4
7 Z
G
-0
4
0
-0
0
0
4
C

H
Ö

H
Ö

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
 s

e
ri

e
s

1
3

(
)

(C
A

N
 v

e
rs

io
n

, 
T

3
-T

6
)

C
:\t

m
p
\Y

m
o
ve

 (
C

A
N

).
sc

h

P
ri

m
a

Y
M

B
2

Y
C

B
2

Y
M

 E
le

c
tr

o
n

ic
 C

a
b

in
e

t 
2

O
p

ti
o

n
a

l 
in

te
rn

a
l 

C
o

n
v

e
y

o
r

M
Y

C
A

N
 

C
B

C
A

N

E
V

E
N

T

C
A

N

E
V

E
N

T

M
Y

C
A

N
IN

C
M

O
T

A
D

C
IN

3
A

D
C

IN
3

A
D

C
IN

3

Y
C

B
3

C
A

N

E
V

E
N

T

F
a

n
-

T
x

R
x

T
x

R
x

X
S

E
R

C
o

m
m

a
n

d

X
A

M
P

C
o

m
m

a
n

d

Y
 C

h
a

in
 B

o
x

Y
 E

n
c

 A
Y

 E
n

c
 A

X
E

N
C

A
M

P

I/
O

Y
 E

n
c

 A

I/
O

Y
 E

n
c

 B

Y
 E

n
c

 Z

Y
 E

n
c

 A

Y
 E

n
c

 B

Y
 E

n
c

 Z

F
a

n
-

X
C

H
A

IN
3

X
C

H
A

IN
2

C
A

N

E
V

E
N

T

I/
O

S
M

E
M

A
 I

N

S
M

E
M

A
 O

U
T

Y
 E

n
c

 A

Y
 E

n
c

 B

Y
 E

n
c

 Z

F
a

n
-

V
 Y

 m
o

to
r

V
 Y

 m
o

to
r

X
T

R
P

S
w

 o
u

t+

S
w

 i
n

+

V
 P

ri
m

a
V

 P
ri

m
a

X
P

O
W

Y
M

 E
n

c
 A

C
M

O
T

A
D

C
IN

3

I/
O

Y
 E

n
c

 E

Y
C

B
1

M
o

to
r 

P
h

 A
B

C
M

o
to

r 
P

h
a

s
e

s
 A

B
C

M
Y

C
A

N
O

U
T

Y
 E

n
c

 X
Y

 E
n

c
 X

Y
 E

n
c

 X

Y
 E

n
c

 E
Y

 E
n

c
 E

Y
 E

n
c

 B
Y

 E
n

c
 B

X
C

H
A

IN
2

 c
a

b
le

X
C

H
A

IN
1

 c
a

b
le

X
C

H
A

IN
3

 c
a

b
le

Y
 W

a
g

o
n

E
n

c
 s

ig
n

a
ls

F
a

n
-

F
a

n
s

E
N

C

Y
 m

o
to

r 
E

n
c

O
p

ti
o

n
a

l 
T

W
M

Y
 fa

n
 2

L
IN

E
A

R
 M

O
T

O
R

Y
 m

o
to

r

X
S

M
E

M
A

_
IN

X
S

M
E

M
A

_
O

U
T

X
F

H

X
T

W
M

X
IO

X
M

Y
C

A
N

IN
, 

X
M

Y
C

A
N

O
U

T

Y
 fa

n
 1

E
n

c
 s

ig
n

a
ls

 A
,B

Y
M

 E
n

c
 B

X
M

Y
C

A
N

 c
a

b
le

S
1

 m
o

to
r 

H
i

X2 cable

V
 Y

 m
o

to
rX
M

A
IN

S

S
1

 m
o

to
r 

L
o

S
w

it
c

h

X
S

W
1

, 
(X

S
W

2
)

X
R

H

X
S

T
O

P

X
M

Y
C

A
N

O
U

T

X
M

Y
C

A
N

IN

S
w

+
, 

S
w

-

P
C

B
 r

e
le

a
se

 b
u
tt
o
n

B
o
a
rd

 ja
m

 s
ig

n
a
l r

ig
h
t

R
X

R

T
X

R

B
o
a
rd

 e
d
g
e
 s

e
n
so

r 
rig

h
t

T
X

R

R
X

R

X
IO

R
e

p
ly

R
e

p
ly

T
W

M
m

o
to

r

E
N

C

T
W

M
 m

o
to

r 
E

n
c

Y
M

 m
o

to
r 

L
o

Y
M

 m
o

to
r 

H
i

C
A

N
 r

e
t

E
V

E
N

T
 r

e
t

C
A

N
 r

e
t

E
V

E
N

T
 r

e
t

XYM-B cable

R
E

L
A

Y
1

E
-s

to
p
+

E
-s

to
p
-

M
Y

C
A

N

E
-s

to
p
+

E
-s

to
p
-

M
Y

C
A

N

E
n

c
 s

ig
n

a
ls

 A
,B

S
2

 m
o

to
r 

H
i

S
2

 m
o

to
r 

L
o

E
n

c
 s

ig
n

a
ls

 A
,B

W
 m

o
to

r 
H

i
W

 m
o

to
r 

L
o

E
n

c
 s

ig
n

a
ls

 A
,B

T
 m

o
to

r 
H

i
T

 m
o

to
r 

L
o

E
N

C

T
 m

o
to

r 
E

n
c

C
B

m
o
to

r 
T

E
N

C

W
 m

o
to

r 
E

n
c

C
B

m
o
to

r 
W

E
N

C

S
1
 m

o
to

r 
E

n
c

C
B

m
o
to

r 
S

1

E
N

C

S
2
 m

o
to

r 
E

n
c

C
B

m
o
to

r 
S

2

X
T

E
, 

X
T

M

X
W

E
, 

X
W

M

X
S

1
E

, 
X

S
1

M

X
S

2
E

, 
X

S
2

M

S
w

 i
n

-

S
w

 o
u

t-

E
-s

to
p

+

E
-s

to
p

-

E
-s

to
p

+

E
-s

to
p

-

E
-s

to
p

+

E
-s

to
p

-
E

-s
to

p
-

E
-s

to
p

+

B
o
a
rd

 e
d
g
e
 s

e
n
so

r 
le

ft

T
X

L

R
X

L

P
lu

g
g
e
d

B
o
a
rd

 ja
m

 s
ig

n
a
l l

e
ft

R
X

L

T
X

L

+
2
4
V

+
4
8
V R
E

L
A

Y
1

E
-s

to
p
+

E
-s

to
p
-

M
Y

C
A

N

F
ro

n
t h

o
o
d

R
e
a
r 

h
o
o
d

R
E

L
A

Y
2

R
ig

h
t 

su
p
p
o
rt

 m
o
to

r

L
e
ft

 s
u
p
p
o
rt

 m
o
to

r

W
id

th
 m

o
to

r

C
o
n
ve

yo
r 

m
o
to

r

+
2
4
V

230V AC OUTLET

1
6
-M

a
r-

2
0
0
7

T
S



MYDATA MY9 – MY12 – MY15 – MY19  Schematics

P-040-0070-EN – Service Manual Rev. 0000  2008-06 17 - 9

Magazines And Glue Station (MOT Version)

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

1
4
-O

ct
-1

9
9
7

Z
/H

Z
 m

o
v
e
m

e
n

t
0

0
0

4
8 Z
G
-0
4
0
-0
0
0
4
C

H
S

H
S

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

a
n

d
 f

o
rc

e
 s

e
n

s
o

r

C
:\
tm

p
\Z

h
zm

o
ve

.s
ch

F
M

B

X
W

B
3

B
M

4
C

B

A
T

-C
P

U

T
F

T

T
F

D

B
M

4

M
O

T
-Z

M
O

T
-C

B
o

o
s

te
r2

 (
Z

)

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

A
U

X
O

U
T

 5

A
U

X
O

U
T

 4

L
o

w
e

r 
Z

-l
o

c
k

U
p

p
e

r 
Z

-l
o

c
k

In
p

u
t

O
u

tp
u

t

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

A
u

x
o

u
t 

5

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

P
h

a
s

e
 A

1

P
h

a
s

e
 A

2

L
o

w
e

r 
Z

-l
o

c
k

U
p

p
e

r 
Z

-l
o

c
k

Z
 m

o
to

r 
H

i

Z
 m

o
to

r 
L

o

H
Z

 m
o

to
r 

H
i

H
Z

 m
o

to
r 

L
o

Z
 e

n
c

o
d

e
r 

A

Z
 e

n
c

o
d

e
r 

B

H
Z

 e
n

c
o

d
e

r 
A

Z
:B

 m
o

to
r 

H
i

Z
:B

 m
o

to
r 

L
o

Z
:e

n
c

o
d

e
r 

B
1

Z
:e

n
c

o
d

e
r 

B
2

Z
:e

n
c

o
d

e
r 

A
1

Z
 h

o
ld

/S
_
la

tc
h

L
o

a
d

 r
e

s

L
o

w
e

r 
Z

 l
o

c
k

U
p

p
e

r 
Z

 l
o

c
k

E
n

a
b

le

Z
:e

n
c

o
d

e
r 

A
2

H
Z

 e
n

c
o

d
e

r 
B

3
P

T
1

X
T

P

H
Z

/Z

X
T

P

-5
 V

T
x

1
/R

x
1

F
o

rc
e

U
p

p
e

r 
Z

-l
o

c
k

L
o

w
e

r 
Z

-l
o

c
k

Z
 m

o
to

r 
H

i

P
re

s
s

/T
a

c
t

Z
 m

o
to

r 
L

o

Z
 h

o
ld

/S
_
la

tc
h

T
a

c
h

o

T
x

/R
x

 M
O

T
Z

A
U

X
 I

N
/O

U
T

A
U

X
 I

N
/O

U
T

O
p

ti
o

n
a

l 
H

y
d

ra
 u

n
it

M
id

a
s

H
Y

D
B

H
Z

 m
o

to
r 

H
i

H
Z

 m
o

to
r 

L
o

H
Z

 e
n

c
o

d
e

r 
A

H
Z

 e
n

c
o

d
e

r 
B

H
Z

 m
o

to
r 

H
i

H
Z

 m
o

to
r 

L
o

H
Z

 e
n

c
o

d
e

r 
A

H
Z

 e
n

c
o

d
e

r 
B

XTF cable

XHYD cable

XTP cable

XXW1 cableXXW2A

H
Z

/Z

T
x

/R
x

 M
O

T
Z

T
x

/R
x

 M
O

T
Z

T
x

/R
x

 M
O

T
Z

3
P

T
1

P
re

s
s

/T
a

c
t

D
if

f 
e

x
t

D
if

f 
e

x
t

G
N

D

L
E

D
 c

u
rr

e
n

t

-5
 V

F
o

rc
e

G
N

D

L
E

D
 c

u
rr

e
n

t

L
o

w
e

r 
Z

-l
o

c
k

U
p

p
e

r 
Z

-l
o

c
k

Z
 m

o
to

r 
H

i

Z
 m

o
to

r 
L

o

Z
 E

N
C

 A

Z
 E

N
C

 B

H
Z

 E
N

C
 A

Z
 h

o
ld

/S
_
la

tc
h

H
Z

 E
N

C
 B

T
x

/R
x

 M
O

T
Z

3
P

T
1

P
re

s
s

/T
a

c
t

C
o

m
p

u
te

r 
b

o
x

 2
X

 w
a

g
o

n

(E
m

_
p

re
s

s
)'

In
p

u
t

O
u

tp
u

t

L
o

a
d

 r
e

s

E
n

a
b

le

(E
m

_
p

re
s

s
)'

+
5

V

+
5

V

Z
 t

ra
n

s
d

 A
 

1
,5

k

Z
 t

ra
n

s
d

 B

H
Z

 t
ra

n
s

d
 A

 

H
Z

 t
ra

n
s

d
 B

 

Hydralink

T
T

L
/R

S
4

8
5

H
y

d
ra

li
n

k

H
y

d
ra

li
n

k

H
y

d
ra

li
n

k

v
a

c
u

u
m

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

X
Z

M
c

o
n

n
e

c
to

r

X
Z

H
c

o
n

n
e

c
to

r

X
H

Y
D

c
o

n
n

e
c

to
r

X
T

P
c

o
n

n
e

c
to

r

E
M

IT
T

E
R

C
O

L
L

E
C

T
O

R

C
A

T
H

O
D

E

A
N

O
D

E

E
M

IT
T

E
R

C
O

L
L

E
C

T
O

R

C
A

T
H

O
D

E

A
N

O
D

E

F
o

rc
e

F
o

rc
e

X
F

iM
2

c
o

n
n

e
c

to
r

X
T

F
c

o
n

n
e

c
to

r

XFMB cable

Z H
Z

h
o

ld

E
N

C

Z
M

O
T

O
R

H
Z

M
O

T
O

R

E
N

C

H
Z

 E
N

C
O

D
E

R

F
Z

 2
.0

A

Ω

XZBO cable

1
R

, 
6

W

G
N

D

1
6
-M

a
r-

2
0
0
7

T
S



Schematics MY9 – MY12 – MY15 – MY19  MYDATA

17 - 10 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Magazines And Glue Station (CAN Version)

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

2
6
-N

o
v-

1
9
9
7

M
a
g

a
z
in

e
s
 a

n
d

 g
lu

e
 s

ta
ti

o
n

0
0

0
4

9 Z
G
-0
4
0
-0
0
0
4
C

N
vR

N
vR

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

(M
O

T
 v

e
rs

io
n

)

C
:\
tm

p
\M

a
g
g
lu

e
.s

ch

T
M

C

M
S

A
T

C
P

U

M
O

T
-M

M
I

T
C

2

V
C

G
C

p
a

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

p
d

 b
u

s

X
IF

4

X
IF

4

M
a

g
. 

C
o

m
m

a
n

d

R
e

e
l 

S
e

le
c

t

M
a

g
. 

R
e

p
ly

R
E

E
L

 c
o

m

P
U

S
H

U
P

 c
o

m

M
a

g
 a

d
d

re
s

s

A
 m

o
to

r 
H

i

A
 m

o
to

r 
L

o

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

M
a

g
. 

R
e

p
ly

M
a

g
. 

C
o

m
m

a
n

d

R
e

e
l 

S
e

le
c

t

M
a

g
. 

P
o

s
it

io
n

M
a

g
 s

e
le

c
t

M
a

g
. 

R
e

p
ly

M
a

g
. 

C
o

m
m

a
n

d

M
a

g
. 

P
o

s
it

io
n

M
a

g
 s

e
le

c
t

R
E

E
L

 c
o

m

M
 m

o
to

r 
H

i

M
 m

o
to

r 
L

o

F
 m

o
to

r 
H

i

F
 m

o
to

r 
L

o

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

M
 m

o
to

r 
H

i

M
 m

o
to

r 
L

o

P
U

S
H

U
P

 c
o

m
.

M
 m

o
t 

H
i

M
 m

o
t 

L
o

F
 m

o
t 

H
i

F
 m

o
t 

L
o

A
u

x
o

u
t 

1
-5

A
u

x
in

 0
,1

,4
,5

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

G
P

 m
o

to
r 

H
i

G
P

 m
o

to
r 

L
o

G
P

 p
h

a
s

e
1

G
P

 p
h

a
s

e
2

A
 m

o
to

r 
H

i

A
 m

o
to

r 
L

o

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

A
 m

o
to

r 
H

i

A
 m

o
to

r 
L

o

B
 m

o
to

r 
H

i

B
 m

o
to

r 
L

o

A
u

x
in

 0
,1

,4
,5

A
u

x
o

u
t 

1
-5

R
e

e
l 

S
e

le
c

t

R
e

e
l 

1
-1

6

R
E

E
L

 c
o

m
m

o
n

B
M

3

B
M

4
B

M
4

C
B

p
a

 b
u

s

p
d

 b
u

s

p
d

 b
u

s

p
a

 b
u

s

M
a

g
 m

a
in

 H
i

M
a

g
 m

a
in

 L
o

M
a

g
 f

ri
c

t 
H

i

M
a

g
 f

ri
c

t 
L

o

G
P

 m
o

t 
tr

a
n

s
d

B
P

 m
o

t 
tr

a
n

s
d

G
C

 1
2

-1
6

G
C

 5
-8

M
 s

e
le

c
t

R
e

e
l 

s
e

le
c

t

M
 c

o
m

m
a

n
d

M
 r

e
p

ly

R
e

e
l 

c
o

m

P
U

S
H

U
P

 c
o

m

M
a

g
 f

ri
c

t 
L

o

M
a

g
 f

ri
c

t 
H

i

M
a

g
 m

a
in

 L
o

M
a

g
 m

a
in

 H
i

M
a

g
 m

a
in

 H
i

M
a

g
 m

a
i 

L
o

M
a

g
 f

ri
c

t 
H

i

M
a

g
 f

ri
c

t 
L

o

G
P

 m
o

t 
tr

a
n

s
d

G
P

 m
o

t 
tr

a
n

s
d

G
C

 1
2

-1
6

G
C

 5
-8

M
 s

e
le

c
t

R
e

e
l 

s
e

le
c

t

M
 c

o
m

m
a

n
d

M
 r

e
p

ly

R
e

e
l 

c
o

m

P
U

S
H

U
P

 c
o

m

F
 m

o
to

r 
H

i

F
 m

o
to

r 
L

o

M
 m

o
to

r 
H

i

M
 m

o
to

r 
L

o

M
IB

B

M
a

g
 f

ri
c

t 
H

i

M
a

g
 f

ri
c

t 
L

o

X
M

IF
_
S

L
O

T

X
M

IF
1

X
M

IF
2

X
M

IF

X
M

F

C
o

m
p

u
te

rb
o

x

E
N

C

M
 m

o
to

r 
L

o

M
 m

o
to

r 
h

i

2
2

0
V

2
2

0
V

X
V

1
1

X
V

6

X
V

1

P
o

s
 s

e
n

s

S
to

p
 s

e
n

s

M
A

IN

M
O

T
O

R

F
R

IC
T

IO
N

M
O

T
O

RG
L

U
E

 P
O

T

M
O

T
O

R

M
a

g
 p

o
s

H
E

X
 0

-F

V
ib

ra
to

r

V
ib

ra
to

r

V
ib

ra
to

ro
p

ti
o

n
a

l 
g

lu
e

 s
ta

ti
o

n

o
p

ti
o

n
a

l 
v

ib
ra

to
r 

m
a

g
a

z
in

e

o
p

ti
o

n
a

l 
ta

p
e

 m
a

g
a

z
in

e

M
IB

B

X
M

IF
_
S

L
O

T

X
M

IF
1

X
M

IF
2

M
a

g
 p

o
s

H
E

X
 0

-F

XMIBOX cable

XMIF2 cable

X
M

IB
B

 c
a

b
le

XMIF2 cable

X
M

F
 c

a
b

le

M
IB

B

X
M

IF
_
S

L
O

T

X
M

IF
1

X
M

IF
2

M
a

g
 p

o
s

H
E

X
 0

-F

X
M

IB
B

 c
a

b
le

XMIBB cable

XMIF2 cable

XIF4 cbl

G
N

D
G

N
D

IO A
D

3

o
p

ti
o

n
a

l 
T

E
X

M
IB

B

X
M

IF
_
S

L
O

T

X
M

IF
1

X
M

IF
2

M
a

g
 p

o
s

H
E

X
 0

-F

T
E

X
Y

B

X
M

IF
2

 c
a

b
le

Y
1

M
O

T
O

R

Y
2

M
O

T
O

R

T
Z

M
O

T
O

R

R
x

T
x

M
O

T
-M

X
M

IB
B

 c
a

b
le

R
x

T
x

M
O

T
-M

R
x

T
x

B
P

R
x

T
x

B
P

/M

1
6
-M

a
r-

2
0
0
7

T
S



MYDATA MY9 – MY12 – MY15 – MY19  Schematics

P-040-0070-EN – Service Manual Rev. 0000  2008-06 17 - 11

Vision System

A
p

p
ro

v
e
d

D
e
s
ig

n
e
d

D
ra

w
n

D
a
te

S
ig

n
.

T
it

le

D
o

c
u

m
e
n

t 
n

u
m

b
e
r

S
h

e
e
t

R
e
v
is

io
n

P
a
rt

 o
f

This document is our property. It must not be copied and its contents must not be imparted

to third persons without our written permission. Infringement of the above will be prosecuted.

1
6
-M

a
r-

2
0
0
7

1
0
-M

a
y-

2
0
0
5

M
a
g

a
z
in

e
s
 a

n
d

 g
lu

e
 s

ta
ti

o
n

0
0

0
4

1
0 Z
G
-0
4
0
-0
0
0
4
C

H
Ö

H
Ö

S
u

b
s
y
s
te

m
 d

e
s
ig

n
 M

Y
-s

e
ri

e
s

1
3

(
)

(C
A

N
 v

e
rs

io
n

)

C
:\
tm

p
\M

a
g
g
lu

e
 (

C
A

N
).

sc
h

M
C

B

C
M

O
T

M
Y

C
A

N

X
M

Y
C

A
N

IN
, 

X
M

Y
C

A
N

O
U

T

IOA
D

3

IO A
D

3

X
IO

X
IO

M
a

g
 p

o
s

it
io

n

X
M

I

X
G

L
U

E

T
M

C

M
S

T
C

2

V
C

G
C M

a
g

. 
R

e
p

ly

M
a

g
. 

C
o

m
m

a
n

d

R
e

e
l 

S
e

le
c

t

M
a

g
. 

P
o

s
it

io
n

M
a

g
 s

e
le

c
t

M
a

g
. 

R
e

p
ly

M
a

g
. 

C
o

m
m

a
n

d

M
a

g
. 

P
o

s
it

io
n

M
a

g
 s

e
le

c
t

R
E

E
L

 c
o

m

M
 m

o
to

r 
H

i

M
 m

o
to

r 
L

o

F
 m

o
to

r 
H

i

F
 m

o
to

r 
L

o

M
 m

o
to

r 
H

i

M
 m

o
to

r 
L

o

P
U

S
H

U
P

 c
o

m

M
 m

o
t 

H
i

M
 m

o
t 

L
o

F
 m

o
t 

H
i

F
 m

o
t 

L
o

A
u

x
o

u
t 

1
-5

A
u

x
in

 0
,1

,4
,5

G
P

 m
o

to
r 

H
i

G
P

 m
o

to
r 

L
o

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

G
P

 m
o

to
r 

H
i

G
P

 m
o

to
r 

L
o

G
P

 p
h

a
s

e
1

G
P

 p
h

a
s

e
2

R
e

e
l 

S
e

le
c

t

R
e

e
l 

1
-1

6

R
E

E
L

 c
o

m
m

o
n

M
IB

B

X
M

IF
_
S

L
O

T

X
M

IF
1

X
M

IF
2

E
N

C

M
 m

o
to

r 
L

o

M
 m

o
to

r 
H

i

2
2

0
V

2
2

0
V

X
V

1
1

X
V

6

X
V

1

P
o

s
 s

e
n

s

S
to

p
 s

e
n

s

M
A

IN

M
O

T
O

R

F
R

IC
T

IO
N

M
O

T
O

RG
L

U
E

 P
O

T

M
O

T
O

R

M
a

g
 p

o
s

H
E

X
 0

-F

V
ib

ra
to

r

V
ib

ra
to

r

V
ib

ra
to

ro
p

ti
o

n
a

l 
g

lu
e

 s
ta

ti
o

n

o
p

ti
o

n
a

l 
v

ib
ra

to
r 

m
a

g
a

z
in

e

o
p

ti
o

n
a

l 
ta

p
e

 m
a

g
a

z
in

e

M
IB

B

X
M

IF
_
S

L
O

T

X
M

IF
1

X
M

IF
2

M
a

g
 p

o
s

H
E

X
 0

-F

XMIB cable

XMIF2 cable

X
M

IB
 c

a
b

le

XMIF2 cable

X
M

F
 c

a
b

le

M
IB

B

X
M

IF
_
S

L
O

T

X
M

IF
1

X
M

IF
2

M
a

g
 p

o
s

H
E

X
 0

-F

X
M

IB
 c

a
b

le

XMIB cable

XMIF2 cable

G
N

D
G

N
D

A
u

x
o

u
t 

1
-5

A
u

x
in

 0
,1

,4
,5

G
P

 m
o

to
r 

H
i

G
P

 m
o

to
r 

L
o

P
h

a
s

e
 B

1

P
h

a
s

e
 B

2

M
a

g
 s

e
le

c
t

M
a

g
. 

R
e

p
ly

M
a

g
. 

C
o

m
m

a
n

d

M
 m

o
to

r 
L

o

M
 m

o
to

r 
H

i

R
E

E
L

 c
o

m

P
U

S
H

U
P

 c
o

m

R
e

e
l 

S
e

le
c

t

R
x

T
x

M
O

T
-M

F
 m

o
to

r 
H

i

F
 m

o
to

r 
L

o

o
p

ti
o

n
a

l 
T

E
X

M
IB

B

X
M

IF
_
S

L
O

T

X
M

IF
1

X
M

IF
2

M
a

g
 p

o
s

H
E

X
 0

-F

X
M

IB
 C

A
B

L
E

T
E

X
Y

B
X

M
IF

2
 c

a
b

le
Y

1
M

O
T

O
R

Y
2

M
O

T
O

R

T
Z

M
O

T
O

R

R
x

T
x

M
O

T
-M

M
a

g
a

z
in

e
 C

o
n

tr
o

l 
U

n
it

1
6
-M

a
r-

2
0
0
7

T
S



Schematics MY9 – MY12 – MY15 – MY19  MYDATA

17 - 12 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Linescan Vision System
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Peripherals
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18. Maintenance
This document informs about preventive maintenance for the MY9 – MY12 – 
MY15 – MY19 machine types. This maintenance should be performed at 
stated intervals. The warranty on the machine and parts applies only if these 
instructions are followed.

 WARNING! Before commencing any maintenance, press an emergency stop 
button down or turn the power off.

Maintenance intervals

– The intervals for daily maintenance are fixed and should be performed 
by the machine operator. The daily maintenance is also described in 
the Operator’s manual.

– The maintenance intervals specified at 160 hours running time and 
2000 hours running time are dependent on the usage of the machine. 
These times are based on an eight hour working day, seven days a 
week. This type of maintenance should only be performed by an 
authorized maintenance engineer.

 CAUTION! The maintenance intervals apply to a clean environment and an 
indoor temperature of maximum 25 °C. If operated in a dusty environment, or 
higher temperature, it is strongly recommended to perform cleaning and 
lubrication after half the stated time intervals.

Cleaning optics

– If the optical surface is very dusty or dirty, remove the dust and dirt 
using a spray can with clean air intended for optics. Other air may 
contain particles and grease from air pumps and valves which may be 
harmful to the optics.

– Clean optics by folding a clean lint-free cloth to the width of the 
optics. Apply a small amount of isopropyl alcohol, and gently pass 
the cloth over the surface. Ensure there is no film left on the surface 
after the use of alcohol. An alternative is to use pre-moistened 
cleaning towlettes, especially developed for cleaning of optics.

Lubricants

Unless otherwise stated, use Shell Tellus oil, Omega 28 or OKS 270 grease. 
Oil and grease should be applied just to give just a thin film.

 Do not lubricate Z-fi mount heads with Omega 28.

Information about Material Safety are found on http://www.mydata.com.

Spare parts

Part numbers for spare parts are found on the MYDATA web site:
http://www.mydata.com. User name and password may be needed.
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Daily Maintenance

Equipment

– Lint-free cotton wool buds.

– Isopropyl alcohol.

– Lint-free cloths.

– Collecting container for rejected components.

– Vacuum cleaner or short-bristled brush.

Tool Bank

Cameras

Centering Unit

Component Handling
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Tool Bank

Single mount head tools

– Pick up the tools from the tool bank to inspect them.

– Wipe off any solder paste and glue from the tip of the mount tools 
carefully with a cloth slightly wet in alcohol. Be careful not to damage 
the springs in spring-loaded tools.

– Inspect the tool tips. Replace damaged tools and tool tips. Part 
numbers are found in the Spare Parts Catalog.

– Wipe off the glue tools carefully with a cloth slightly wet in alcohol.

 Be careful to put the tools back in their original position in the toolbank.

Single head tool bank

– Wipe off the tool bank with a cloth slightly wet in alcohol. Take extra 
care to wipe off the tools verification points.

– Wipe off the glue tool verification points.

– Clean under the glue tool bank where the tools are kept.

HYDRA tool bank

– Wipe off any solder paste and glue from the tool bank with a cloth 
slightly wet in alcohol.

Glue station (when used)

– Wipe off the Glue station´s verification points.
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Centering Unit

Centering jaws

– Clean the centering jaws and Linescan reference background using a 
cotton wool bud slightly wet in alcohol, see Figure 18-1.

– Clean the Linscan reference background using a lint-free cloth 
slightly wet in alcohol, see Figure 18-1.

Component Handling

Machine board

– Remove loose components and pieces of component tape from the 
machine, internal conveyors, TEX, slot positions and the magazines 
with a vacuum cleaner or brush.

– Inspect the magazine connectors and remove any components and 
component tape with a vacuum cleaner or brush.

– Make sure that the connectors are not damaged.

– Empty the reject bins.

Figure 18-1.  Centering jaws.

Reference 
background

Figure 18-2.  Magazine connectors.
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Cameras

HYDRA camera glass

– Remove dropped components from the camera glass by pulling the 
knob at the front of the HYDRA camera box, see Figure 18-3.

Linescan camera glass

– Remove dropped components from the Linescan camera glass by 
withdrawing it at the front of the camera box, see Figure 18-4.

 Be careful not push the camera glass too far back when re-inserting it in the 
Linescan camera.

Figure 18-3.  Knobs of HYDRA camera 1 and 2.

HYDRA 
camera 1

HYDRA 
camera 2

Figure 18-4.  Pulling Linescan camera glass.
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Weekly Maintenance

Equipment

– Shell Tellus oil for lubrication.

– OKS 270 grease, optionally Omega 28 grease.

– Z-fi mountheads shall not be lubricated with Omega 28.

– Isopropyl alcohol.

– Lint-free cloths.

– Lint-free cotton wool buds.

– Collecting container for rejected components.

– Vacuum cleaner or short-bristled brush.

Preparation

Make a backup of TPSys.

Refer to the TPSys software manual about backing up data and parameters.

Mount Heads

Centering Unit

Tool Bank

Cameras

Board and Component Handling
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Tool Bank

Single mount head tools

– Check spring-loaded tools by gently pressing the tubes to the end 
position. When the tubes are released, make sure they return to the 
original positions. Be careful not to overload the springs.

– Lubricate metal colored spring-loaded tools with a drop of Shell 
Tellus oil, see Figure 18-5.

 Do not lubricate any tools with a black housing.

– Inspect O-rings for cracks or abrasions. Replace if necessary. Part 
numbers are found in the Spare Parts Catalog.

– Clean and lubricate the single mount-head tool O-rings with grease. 
Apply only a thin layer of grease on the O-rings. With OKS 270 
grease the O-rings should be lubricated once a week. With Omega 28 
grease the O-rings should be lubricated once a month or every 
160 hours. Do not use Omega 28 if you have a Z-fi mount head.

Figure 18-5.  Spring loaded tools lubrication.

Figure 18-6.  Cracks and abrasion on O-ring.
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Cameras

DVS/SVS camera

– Empty the DVS/SVS camera dump bin.

Linescan camera

– Remove the Linescan camera glass by withdrawing it at the front of 
the camera box, see Figure 18-8.

– Clean the Linescan camera optics.

Instructions on how to clean optics are found on page 18-1.

Figure 18-7.  DVS/SVS camera dump bin.

Figure 18-8.  Removing Linescan camera glass.
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HYDRA camera

– Open the bin lid at the rear of the HYDRA camera 1 or on the side of 
HYDRA camera 2 and empty the bins. Remove dropped components 
from the camera body, preferably with a vacuum cleaner.

Centering Unit

Centering unit

– Inspect the electrodes and the termination wires. Are the electrodes 
pitted (that is full of dents after components), worn, or the wires are 
damaged, the centering jaws must be replaced and calibrated. Refer to 
the machine manual for details. Part numbers are found in the Spare 
Parts Catalog.

– Wipe the mechanical centering unit axles with a lint-free cloth and 
lubricate them with Shell Tellus oil. Make sure that the Linescan 
reference background is not contaminated with oil. If so, wipe of the 
Linescan background with a lint-free cloth slightly soaked with 
alcohol.

Figure 18-9.  HYDRA camera dump bins.

HYDRA 
camera 2

HYDRA 
camera 1

Figure 18-10.  Centering unit electrodes and axles.
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Mount Heads

Single mount head

– Clean dirt and dust out with a cotton wool bud from the inside of the 
tool head. Be careful not to damage the force sensor inside the tool 
head. Lubricate the inside of the tool head by inserting and removing 
a greased tool manually, see Figure 18-11.

– Wipe off old grease and dirt from the Z rack with a cloth and apply a 
new thin layer of OKS 270 grease, see Figure 18-11.

Figure 18-11.  Single mount head, Z rack and tool head position.

Z rack

Tool head
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HYDRA unit

– Wipe of the reference background on the HYDRA unit with a cloth.

– HYDRA 2B: Lubricate the HYDRA Z shaft with Shell Tellus oil. 
(HYDRA 2D is lubricated at the yearly service).

HYDRA tools

Remove the tools manually. Instructions on how to remove tools are found the 
in Operator´s Manual.

– Remove the H01 (white tools) and inspect their tips for cracks and 
dents under a magnifier or pocket lens. Replace damaged tools if 
necessary.

– Remove the H04 (blue tools) and inspect the rubber tips under a 
magnifier or pocket lens for cracks or abrasions. Replace tip if 
necessary.

– Remove the H06 (green tools) and inspect their tips for cracks and 
dents under a magnifier or pocket lens. Replace tool if necessary.

– Remove the H02 (yellow tools) every other week and inspect their 
tips for cracks and dents under a magnifier or pocket lens. Replace if 
necessary.

– Part numbers are found in the Spare Parts Catalog.

 Check the rubber tip container for expiry date. Do not use expired rubber tips.

Figure 18-12.  Z-shaft points of lubrication and reference background.

Reference background
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Board and Component Handling

Y wagon

– Wipe off the Y-wagon linear bushing rods with a cloth slightly oiled 
with Shell Tellus oil.

 Note: This step only applies to models with white Y-wagon unit.

Tray Wagon Magazine (when used)

– Wipe off the Tray Magazine rod with a cloth slightly oiled with Shell 
Tellus oil.

Other

Warning signs

– Inspect the Warning signs. Clean or replace if necessary.

Figure 18-13.  Y-wagon rods.

Figure 18-14.  Tray Wagon Magazine rod.
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160 Hours Maintenance

 These maintenance tasks shall only be performed by an authorized 
maintenance engineer.

1. Inspect the X-wagon ribbon XXW1 and XXW2 cables.

– Check the two blue X-wagon ribbon cables located on top of the 
X beam. Replace damaged or worn cables, see separate repair guide.

2. Dual vision camera optical outer mirror.

– If an dual vision centering camera is used, then clean the outer mirror 
(at the arrow in Figure 18-16) accessible without opening the camera 
cabinet.

Figure 18-15.  Flexible cables.

Figure 18-16.  Dual vision camera outer mirror.

XXWW2XXWW1
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3. Clean the HYDRA Theta belt.

– Clean the Theta belt at the motor shaft using a cotton wool bud 
slightly wet in alcohol, see Figure 18-17. Move the belt by gently 
dragging the belt spring as shown by the arrow.

4. Clean the HYDRA camera glass.

Figure 18-17.  HYDRA Theta belt.

Figure 18-18.  Camera glass, HYDRA camera 1 and 2.

HYDRA 
camera 1

HYDRA 
camera 2
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5. Lubricate the front and rear of the HYDRA Z rack with OKS 270 grease.

6. Check the HYDRA vacuum system as described in the machine manual.

7. Check the Standard vacuum system.

– Inspect the vacuum hoses and test the vacuum system as described in 
the machine manual.

– Replace the vacuum filter at every other service. Part numbers are 
found in the Spare Parts Catalog.

Figure 18-19.  HYDRA Z rack.

Figure 18-20.  Vacuum filter.
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8. Clean or replace the fan filters.

– Clean thoroughly (using a vacuum cleaner) the two fan filters at the 
rear of the machine. If the filters are clogged they must be replaced. 
Part numbers are found in the Spare Parts Catalog.

9. Check the grease pump.

– Make sure the indicator lamp on the grease pump is lit by using the 
Check X-Wagon Grease Pump procedure as described in the machine 
manual.

Figure 18-21.  Fan filter.
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Yearly or 2000 Hours Maintenance

 This preventive maintenance shall only be carried out by authorized 
MYDATA service engineers. There is a specific instruction for the yearly 
maintenance that has to be followed.

Please contact your MYDATA Service Department to arrange for a visit by a 
MYDATA field service engineer.

This service will affect for example:

– The HYDRA ATE.

– The single and HYDRA mount heads.

– The X system.

– The internal conveyor system.
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Maintenance Tables

This section shows the previous described maintenance as tables that can be 
copied and used as service protocols.

Daily

Place Maintenance action Completed

Tool Bank Single mount head tools

– Inspect the tools and tip. Wipe off and replace tips/tools 
if necessary.

Single head tool bank

– Wipe off any solder paste and glue from the toolbank.

HYDRA tool bank

– Wipe off any solder paste or glue from the HYDRA tool 
bank.

Glue station (when used)

– Wipe off the glue tools, tool bank, and verification 
points.

– Clean under the tool bank.

Centering Unit Centering jaws

– Clean the centering jaws and Linescan reference 
background.

Component Handling Machine board

– Remove loose components/component tape.

– Inspect the magazine connectors and remove loose 
components/component tape.

– Empty the reject bins.

Cameras HYDRA camera glass

– Remove components from HYDRA camera glass.

Linescan camera glass

– Remove components from Line scan camera glass.
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Weekly

Place Maintenance action Completed

Preparation Make a backup of TPSys.

Tool Bank Single mount head tools

– Lubricate metal colored Single mount-head tools.

– Inspect and lubricate Single mount-head tool´s O-rings.

Cameras DVS/SVS camera

– Empty the camera dump bin

Linescan camera

– Clean Linescan camera optics.

HYDRA camera

– Empty the HYDRA 1 or 2 dump bin.

Centering Unit Centering unit

– Inspect the mechanical centering unit electrodes.

– Clean and lubricate the mechanical unit axles.

– Clean the Line-scan reference background if necessary.

Mount Heads Single mount head

– Clean and lubricate inside of tool mount head.

– Clean and lubricate Single-mount head Z rack.

HYDRA unit

– Wipe off reference background.

– HYDRA 2B ONLY: Lubricate HYDRA Z shaft.

HYDRA tools

– Remove tools manually and inspect them for wear and/
or damage.

Board and Component 
Handling

Y wagon

– Clean and lubricate the Y-wagon rods.

Tray Wagon Magazine (when used)

– Clean and lubricate the Tray Wagon Magazine rod.

Other Warning signs

– Inspect the Warning signs. Replace if necessary.
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160 Hours Maintenance

 This preventive maintenance shall only be carried out by authorized 
MYDATA service engineers. There is a specific instruction for the yearly 
maintenance that has to be followed.

Yearly or 2000 Hours Maintenance

 This preventive maintenance shall only be carried out by authorized 
MYDATA service engineers. There is a specific instruction for the yearly 
maintenance that has to be followed.

Interval Maintenance actions Completed

Monthly or 160 hours. 1. Inspect the X-wagon ribbon XXW1 and XXW2 cables.

2. Dual vision camera optical outer mirror.

3. Clean the HYDRA Theta belt.

4. Clean the HYDRA camera glass.

5. Lubricate the front and rear of the HYDRA Z rack with 
OKS 270 grease.

6. Check the HYDRA vacuum system as described in the 
machine manual.

7. Check the Standard vacuum system.

8. Clean or replace the fan filters.

9. Check the grease pump.

Interval Maintenance actions Completed

Yearly or 2000 hours. Please contact your MYDATA Service Department to arrange 
for a visit by a MYDATA field service engineer.
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Appendix A - Service Program Reference Guide
The Service Program is a collection of various basic service tools selectable 
from a main menu (see Figure A-1).

There is also an Extended Service Program that is basically the same program 
as the Service Program, but some of the sub menus have more options than the 
Service Program.

The Extended Service Program contains procedures that should only be 
carried out by an authorized MYDATA service engineer

Starting the Service Program

• If you are currently running TPSys, then you can select Exit > Exit To 
Service in the menu.

• ... or select the Restart TPSys option in the Exit menu and press <Space> to 
get the startup menu. In the startup menu, select the Service option.

The Service Program main window is shown in Figure A-1.

Figure A-1.   Service program main menu

 Messages 

Board Motor Magazine Vacuum Conveyor Camera Utility Exit
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Main Menu Options

Described below are some of the options and commands that are available 
from the main menu.

 Any dimmed alternatives in the shown menus are not applicable to the current 
machine configuration.

Board

To control the Servo computer boards of the various movements of the 
machine, including:

– Show status.

– Load or reset motor controller boards.

Motor

To control the various axes of the machine, including:

– Initiate motors and read position or range.

– Control locks and latches for single and HYDRA mount heads.

– Toggle the Y wagon's position.

– Measure frictions.

– Calibrate the force sensor.

Magazine

To control tape and vibrator magazines, including:

– Step, poll and test magazines or removable feeders.

– Test the MagLink used by the TEX Tray Exchanger.

Vacuum

To control the vacuum pump and the valves for vacuum and air pressure 
for the single mount head tool and the HYDRA mount tools. The vacuum 
and force sensors can also be shown from this option.

Conveyor

To control the Y-wagon conveyor features.

Camera

To control the various illumination units and cameras.

Utility

To control and indicate:

– Voltages.

– PAIB board.

– Warning lamps.

– Perform TEX installation.

– Show about information boxes.

Exit

To exit the Service Program.
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Board

This menu contains options regarding the various boards (CanIC board - MotZ 
board) that control the movements of the machine. Selecting one of the boards 
opens a submenu with options that may vary, depending on selected board.

 Any dimmed alternatives in the shown menus are not applicable to the current 
machine configuration.

The following submenu options are available:

– Show status.

– Reset.

– Load.

– Sensors.

Show status

Displays motor controller load status and servo identification. The 
information in this box may vary, depending on selected board.

Reset

Performs a hardware reset of the selected board.

Load

Loads the displayed servo program to the selected board.

Sensors

This option is applicable to the CanIC board only. Selecting this option 
opens the Conveyor board edge sensors dialog box, which displays 
information about the internal conveyors board edge sensors.

Show status of all boards

Displays motor controller load status and servo identification for all the 
boards. Unloaded boards, if any, can also be loaded by confirming this 
option in the dialog box. If you do not want to load unloaded boards, press 
the <Esc> key.

Load all boards

Loads all servo files.
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Motor

This menu contains options regarding the motors (C motor to Tray wagon 
motor) that control the various axes of the machine. Selecting one of the 
motors (C motor to Tray wagon motor) opens a submenu with options that 
may vary, depending on selected motor.

 Any dimmed alternatives in the shown menus are not applicable to the current 
machine configuration.

The following submenu options are available for the selected motor.

– Initiate or Initiate motor.

– Read range.

– Read position.

– Stand by.

– Locks.

– Latches.

– Measure friction.

– Calibrate force sensor.

– Measure cog play.

Initiate or Initiate motor

This option is applicable to all motor functions. This option makes a 
hardware initiation, i.e. moves to the mechanical stop and resets the 
position counter.

 If Z-axis and/or Hydra Z is not initiated then the system will ask if you want 
to initiate Y motor anyway. Before proceeding, check that there is no risk for 
collision between Z-axis and/or Hydra Z and Y axis.

Read range

This option displays the selected motor's range.

Read position

This option displays the current position. To get the position value for a 
desired position, press <Enter> and the current position is shown.

Stand by

This option is applicable to the X-motor function only. It can be used if 
the X motor has been stopped in a position where the servo and X motor 
keep regulating continuously. This situation causes an disturbing noise 
from the X-wagon motor. Using this command stops the regulation and 
thus the noise. The stand-by mode ceases automatically at the next 
X wagon move command.
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Locks

This option is applicable to the Z-motor function only. It controls the 
magnet locks for the Z axis. The locks can be individually controlled. The 
locks are controlled by the MOT-C board.

Latches

This option is applicable to the HYDRA Z-motor function only. The 
option provides a way to control the mount tool latches, one latch for each 
of the eight mount tools. Selecting this alternative displays the dialog 
shown in Figure A-2.

Dialog box HZ motor latches 

Latches to set

Each HYDRA mount tool that has its latch set will follow the vertical 
movement of the Z mechanism. The latches are set by selecting the 
Yes option for the desired tool numbers. Tools with the No option will 
not move.

Soft setting

Changing the state of the latches can be made softly (slowly). This 
setting enables/disables this feature.

Latch

Highlight this option and press <Enter> to carry out settings made. 
To toggle between Yes and No press <Space>.

Measure friction

This option measures the friction, and it is applicable to all the movement 
axes except the X axis. 

Depending on the selected motors control system MOT-board or CAN-
board, the available options may differ somewhat. When measuring 
friction on CAN- controlled motors, a dialog box is shown with the 
following information:

Dialog box Measure friction

Depending on the selected motor, the available options differ 
somewhat. When measuring friction on the X motor, Y motor or Tray 
wagon motor the dialog box shown in Figure A-3 is displayed.

Figure A-2.  HZ motor latches.

Figure A-3.  Measure friction for X motor or Y motor.
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Measuring speed

Speed value while measuring friction.

Start position

Value that indicates where on the unit the friction measurement area 
starts.

End position

Value that indicates where on the unit the friction measurement area 
ends.

Measure friction

Start the measuring procedure.

View result

Opens the information box that shows the friction measurement 
result.

Print result

Print the measurement result on a printer.

Save result on floppy

Save the measurement data on a floppy disk.

Rename result file

Rename the measurement data file.

View other measurements

View results from previous measurements. The friction result is 
presented as a histogram, with the position intervals to the left and the 
actual force required to move the unit is represented by ‘X’s to the 
right in the figure. A summary of the friction result is shown above 
the histogram.

Measure cog play

This procedure is used to measure the cog play for the X-wagon 
cogwheel.

Calibrate force sensor

This option is used to calibrate the tool indicator used for single mount 
head spring-loaded tools.

Gluepot motor

This option is used to start and stop the glue pot rotation motor.

Show/Hide motor positions

Selecting this option opens and closes an information box that shows the 
positions for the motors used in the system.
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Show/Hide force/vacuum sensors

Selecting this option opens and closes an information box that shows the 
vacuum and the tool indicator values for standard mount tool and 
HYDRA mount tool. The force and vacuum indication features are 
controlled by the MOT-Z board.

Vacuum

The vacuum in the mount tool shown as a value between 0 and 255. See 
the vacuum section on page A-11.

Force

Tool indicator value. Normal value is approximately 180 for released tool 
and 0 - 20 when the tool nozzle is pressed in.

HYDRA mount tool information box

Vacuum

Z – Standard mount tool vacuum.

The vacuum in the mount tool shown as a value between 0 and 255. 
See the vacuum section on page A-11.

H – HYDRA unit vacuum.

A value between 30 and 75 is shown for no vacuum. A value 
between 190 and 220 is shown for full vacuum. See the vacuum 
section on page A-11.

Force

Z – Standard mount tool indicator value.

Normal value is approximately 180 for released tool and 0 - 20 when 
the tool nozzle is pressed in.

Tool 1-8 – HYDRA tools indicator value.

The Tool 1-8 lines in the figure apply, individually, to the eight 
HYDRA mount tools.

Hit

Indicates, individually for the eight HYDRA mount tools, if the nozzles 
have ‘hit’ components, i.e. are pressed in somewhat (indicated Yes) or not 
(No). You can test the function by gently pressing the nozzles upwards.
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Show/Hide safety switches

   
Displays the status of the emergency stop buttons and the light beams of 
the X-wagon optical safety system as follows:

Emergency button

No

The emergency stop buttons are not pressed. The machine is operable.

Yes

At least one of the emergency stop buttons are pressed down.The machine 
is not operable.

Light curtain

No

The light beams of the X-wagon optical safety system are not blocked 
(green LED lit on the optical safety unit). The machine is operable.

Yes

The light beams are blocked (red LED lit). The machine is not operable.

This function is controlled by the MOT-X board.

 Both the emergency stop buttons have to be pressed down to release the 
X wagon and make it possible to move it manually.
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Magazine

Step, polling and test commands can be given to a desired magazine by 
selecting the Magazine menu.

 Any dimmed alternatives in the shown menus are not applicable to the current 
machine configuration.

All magazine functions are controlled by the CanM board.

Step magazines

Sends a component advancement command to the magazine.

This command can be used to obtain component advancements without 
picking a component after each advancement.

Select the desired magazine by entering the magazine position in the 
Select slot dialog box.

After selecting the desired magazine, you can choose to make 
advancement steps on multiple feeders or on a single feeder.

If you select Yes a multiple feeder dialog box is shown. If you select No a 
single feeder dialog box is shown. They show the following data:

Dialog box feeder(s)

Feeders/Feeder

You can choose feeder by pressing <Space> (multiple feeders) or 
enter the desired feeder number (single feeder).

Feeds wanted

Enter the desired number of feeds to be performed.

Steps per feed

Enter the desired number of steps per feed to be performed on each 
feeder.

Step

Starts the step command.

Steps done

Counts the number of steps done.

Poll

Polls those magazines which are inserted in the machine. The polling 
result is displayed on the monitor. If the text in the Buttoned out column 
is No the magazine is in operation (the green LED on the magazine is lit 
with a steady light). If the text is Yes the system does not pick from the 
magazine (the green LED is either flashing or off). If it is neither of these 
but '---' the magazine type has no release button.

If you press the <F1> key, then the type and serial numbers are displayed 
as octal numbers. Another press on the <F1> key toggles back to decimal 
presentation.
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Test

Selecting this option opens a submenu where it is possible to perform a 
number of tests on a magazine.

This option tests continuously major functions of the selected magazine.

Select the desired magazine by entering the magazine position in the 
Select slot dialog box. A continuously updated test result for the selected 
magazine is shown with the following data:

Dialog box test 

Test result

Passed – A communication test completed successfully.

Off – The test was not successfully completed.

Button

No – The release button on the magazine is released.

Yes – The release button on the magazine is pressed in.

LED’s

Off – Both of the LEDs are temporarily off.

Yellow – The Yellow LED only is temporarily lit.

Green flash – The Green flash LED only is temporarily lit.

Yellow flash – Yellow flash of the LEDs are temporarily lit.

Off – The LED test was not successfully completed.

The Button and Lamps status shall reflect the visible states of these 
functions on the magazine.

Poll removable feeders

Polls magazines that are equipped with removable feeders if any.

Select the desired magazine by entering the magazine position in the 
Select slot dialog box. The polling result is displayed on the monitor.

The serial numbers are presented both by decimal and by hexadecimal 
notation in the information box.
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Vacuum

The vacuum pump and the valves for pressure and vacuum can be controlled 
with the options in the Vacuum menu.

 Any dimmed alternatives in the shown menus are not applicable to the current 
machine configuration.

Show/Hide force/vacuum sensors
Opens and closes an information box that shows the vacuum and the tool 
indicator values.

This menu option is the same as the Show/Hide force/vacuum sensors 
option in the Motor menu described in Show/Hide force/vacuum sensors 
on page A-7).

Z vacuum

Opens the vacuum control dialog box for the standard mount tool.

You can control the vacuum pump, the vacuum valve and the pressure 
valve by moving the cursor to the desired option and pressing <Enter>.

To be able to see the vacuum level in the standard mount tool, open the 
vacuum sensor measuring box by selecting the Show/Hide vacuum/force 
sensors option. The vacuum in the standard mount tool is shown as a 
value between 0 and 255. A value between 0 and 30 should be shown for 
no vacuum, that is when the vacuum/pressure pump is off.

A value above 170 should be shown for full vacuum, that is when the 
pump is on, the vacuum valve is open, and the pressure valve is closed.

HYDRA vacuum 

Opens a vacuum control dialog box for the HYDRA unit.

You can control the vacuum pump and the pressure valve by moving the 
cursor to the desired option and pressing <Enter>.

The vacuum valves are controlled by moving the cursor to the desired tool 
number, pressing <Space> for an Open or Close action, moving the cursor 
to the Set option, and pressing <Enter>.

To be able to see the vacuum levels in the HYDRA mount tools, open the 
vacuum sensor measuring box by selecting the Show/Hide vacuum/force 
sensors option.

The vacuum in the HYDRA unit is shown as a value between 0 and 255.

A value between 30 and 75 should be shown for no vacuum, that is when 
the vacuum/pressure pump is off.

A value between 190 and 220 should be shown for full vacuum, that is 
when the pump is on, the vacuum valve for the particular nozzle is open, 
and the pressure valve for the same nozzle is closed.

The vacuum system is controlled by the MOT-Z board.
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Conveyor

From the Conveyor menu, you can control a number of conveyor features.

 Any dimmed alternatives in the shown menus are not applicable to the current 
machine configuration.

Selecting one of the motors (Width motor, Hold motor or Transport motor) 
opens a popup menu with options that may vary, depending on selected 
motors.

The options Transport motor and Hold motor is only applicable for CAN-
controlled conveyors.

The following submenu options are available for the (Width motor, Hold 
motor or Transport motor):

– Initiate.

– Read range.

– Read position.

– Move, Movego.

– Toggle axis.

– Measure friction.

Initiate

To initiate the different conveyor motors, ensure that the conveyor path is 
empty (no PCB in the path) and select the Initiate option in the popup 
menu.

Since the MOT-controlled conveyors only have a Width motor, this 
option initiates the whole MOT-controlled conveyor.

Select Yes in the dialog box to perform the motor initiation.

Read range

This option displays the selected motor's range.

Confirm the Read command by pressing <Enter>. The Min and Max 
positions of the selected range are shown in the box.

Read position

This option displays the current position. To get the position for a desired 
position, move to the position when the Read Conveyor width box is 
shown. Then, confirm the Read command by pressing <Enter>. The 
current position is shown.

Move, Movego

These options are advanced movement commands that can be used by 
service engineers to perform various test and service procedures. These 
commands are not covered in this manual.

 CAUTION! Due to the risk of damaging the machine, do not run the Movement 
commands without a full understanding of their function.
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Toggle axis

This option toggles the conveyor axis position, that is moves the conveyor 
axis between its end positions.

This command will move the selected conveyor axis to the opposite end 
of its travel. If the axis is not at either end, it will move to the end furthest 
from its current position.

Measure friction

This option measures the friction, and it is only applicable to the CAN-
controlled conveyor. By selecting this option in the Conveyor submenu, a 
popup box is shown with the following data.

Dialog box Measure friction

Measuring speed

Speed value while measuring friction.

Start position

Value that indicates where on the Conveyor the friction measurement 
area starts.

End position

Value that indicates where on the Conveyor the friction measurement 
area ends.

Measure friction

Start the measuring procedure.

View result

Opens the information box Conveyor Width Axis Friction 
Measurement Result. The friction result is presented as a histogram, 
with the position intervals to the left and the actual force required to 
move the Conveyor Width Axis is represented by ‘X’s to the right in 
the figure. A summary of the friction result is shown above the 
histogram in the information box.

Print result

Print the measurement result on a printer.

Save result on floppy

Save the measurement data on a floppy disk.

Rename result file

Rename the measurement data file.

View other measurements

View results from previous measurements.

Figure A-4.  Measure friction on conveyor motors.
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Load/unload board

By selecting the Load/unload board option in the Conveyor menu a load/
unload menu is shown with the following data:

You can load, unload, grab, and release the board by selecting the desired 
option from the menu and pressing <Enter>.

The CAN-controlled conveyor only has the Grab and Release option in 
the load/unload menu.

Sensor status

This option is only applicable for MOT-controlled conveyors.

A number of sensors can be used in the conveyor path. The status of these 
sensors can be shown by selecting the Sensor status option in the 
Conveyor menu.

Yes

A board is currently present at the sensor position. You can test this 
option by putting a finger in front of the sensor.

No

There is no board at the sensor position, or the particular sensor is not 
used.

End

Not used.

End-of-fast

Not used.

Support up

Indicates that the board is in its upper position.

Support down

Indicates that the board is in its lower position.

Width home

Indicates the home position of the internal Y-wagon conveyor width.

Elevator home

Not used.

Front/left presence

The front or left (depending on the conveyor direction) end position 
of the internal conveyor path of the Y wagon.

Right button

Indicates that the right and center buttons are pressed simultaneously.

Left button

Indicates that the left and center buttons are pressed simultaneously.

Rear/right presence

The rear or right (depending on the conveyor direction) end position 
of the internal conveyor path of the Y wagon.
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SMEMA outputs

To be able to test the conveyor system, the SMEMA output from the 
machine can be manipulated by the operator. This is performed by first 
selecting the SMEMA outputs option in the Conveyor menu.

You can set channel 1 and channel 2 to be busy or available by selecting 
the desired option from the menu and pressing <Enter>.

Show/Hide SMEMA inputs

The SMEMA input signal from the prior conveyor system can be shown 
or hidden by selecting the Show/Hide SMEMA inputs option in the 
Conveyor menu.

Match conveyor speed

With this option you can match the conveyor speeds in a dialog box. If the 
internal conveyor speed is changed a popup is displayed after pressing 
OK, asking if the parameters 92:0013 and/or 92:0023 should be set to the 
entered value.
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Camera

The Camera menu controls the positioning camera on the X wagon, the optical 
centering vision camera, the HYDRA vision camera, and Linescan camera.

 Any dimmed alternatives in the shown menus are not applicable to the current 
machine configuration.

When a camera is selected you will get a pop-up window where you can turn 
on or off the camera. Depending of selected camera you will also be able to 
select which lighting to use for a particular camera.

X-wagon camera 1

Turns on/off the X-wagon camera.

Optical centering camera 1 to Optical centering camera 4

Turns on/off the installed optical centering camera(s). The system can 
utilize   up to four different optical centering cameras.

HYDRA camera

Turns on/off the HYDRA centering camera, if any. 

Linescan camera 1 or Linescan camera 2

Turns on/off the Linescan camera(s).

All cameras off

Turns off all the cameras.

Show LSAD status

Selecting this option opens an information box that shows the current 
status of the Linescan cameras LSAD board in the machine.
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Utility

From the Utility menu, you can control the following features:

Show line voltages

Displays the internal system voltages in an information box.

This function is controlled by the MOT-M board.

Test PAIB board

This option is used to show status for a number of various features in the 
machine.

By selecting Yes in the shown dialog box, the selected servo file will be 
loaded to the MOT-X board.

A new window is opened, showing the following information:

Emergency button

Yes

At least one of the emergency stop buttons are pressed down.

No

None of the emergency stop buttons are pressed down.

Limits exceeded

Not used.

Door open

Yes

At least one machine door is open.

No

All the machine doors are closed.

X-wagon fan fail

Yes

The X wagon fan is not working.

No

The X wagon fan is working.

ELMO disabled

Yes

The ELMO booster unit is off.

No

The ELMO booster unit is on.



MY9 – MY12 – MY15 – MY19  MYDATA

A - 18 Rev. 0000  2008-06 P-040-0070-EN – Service Manual

Belt motor hot

Yes

The X wagon belt motor is too hot.

No

The X wagon belt motor is not too hot.

Motor relay on

Select Yes or No and press <Enter> to activate or deactivate the X 
wagon motor relay.

ELMO on

Select Yes or No and press <Enter> to switch the ELMO booster on 
or off.

Grease pump on

Select Yes or No and press <Enter> to switch the X wagon grease 
pump on or off.

Limit check on

Not used.

Set PAIB port

Select Enter and press <Enter> to set the choice made in the lower 
part of the box.

About machine

This option shows the machine type, the machine serial number, and the 
machine name:

– Model: MY19

– Serial: 190001

– Name: MY19-Machine

About HYDB board

This option shows the following HYDRA information in an information 
box.

– Version

– Type

– Supply voltage.

– Motor temperature.
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Warning lamps

This option is used to test the lamps in the signal tower. Each lamp can be 
set to On, Off or Blink. This test does not affect the lamp configuration 
setting.

TEX installation

This option is used to initially install the TEX Tray Exchanger, which has 
to be carried out by MYDATA service personnel.

Harddisk status

Selecting this option opens an information box that shows the current 
status of the hard disks used in the machine (see Figure A-6).

Figure A-5.  TEX Tray Exchanger.

Figure A-6.  Harddisk status.
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Appendix B – About the Documentation
The documentation of the MYDATA component placement machines 
comprises the following parts:

• Operator’s manual.

• Programming manual.

• Service manual.

• Software manual.

• Spare parts catalog.

The document structure in Figure B-1 shows the intended user for each 
document.

These documents and some supplementary software products are described on 
the following pages.

Figure B-1.  Document structure.
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Operator's Manual
An operator’s manual is available for the MY9–MY19 type of MYDATA pick 
and place machines.

This manual is provided with each machine.

The operator’s manual is available in the same languages as the TPSys 
software.

The operator’s manual contains information to assist the operator to start and 
operate the system, load components and handle magazines and trays.

Information about safety, daily maintenance, HYDRA, TEX, and Tray Wagon 
Magazine operation is also included in the operator's manual.

Programming Manual
A programming manual is available for TPSys version 2.6 that covers all 
MYDATA pick and place machine types running TPSys version 2.6.

This manual is provided with each machine.

The programming manual is not available in the same languages as the TPSys 
software, but in the majority of these languages.

The programming manual contains basic information about the machine 
movements, such as coordinates, fiducial marks, angles, centering, 
verification, how to program boards, create mount lists, and complete 
component and package lists.

Information about pre-programmed packages, HYDRA, TEX, and Tray 
Wagon Magazine programming is also included in the programming manual.

Service Manual
A service manual is available for the MY9–MY19 type of MYDATA pick and 
place machines.

This manual is provided with each machine.

The service manual is available on a CD in English only. A hard copy can be 
ordered from MYDATA.

The service manual contains descriptions, service instructions, and calibration 
guidelines for the machine.

Information about safety, maintenance, and common optional devices and 
systems are also included in the service manual.

MYDATAMYDATAFor a fast changing world

MYDATAMYDATAFor a fast changing world



MYDATA MY9 – MY12 – MY15 – MY19  

P-040-0070-EN – Service Manual Rev. 0000  2008-06 B - 3

Software Manual
A software manual is available for TPSys version 2.6 that covers all 
MYDATA pick and place machines running TPSys version 2.6.

This manual is provided with each machine.

The software manual is available on a CD in English and Japanese. A hard 
copy can be ordered from MYDATA.

The software manual contains a system overview, Linux description, import/
export information, back up/restore instructions, and network communication.

The software manual contains also a message reference guide, containing 
TPSys messages with descriptions.

Spare Parts Catalog
A spare parts catalog, containing information, figures and part numbers on the 
most common spare and consumable parts, is available from MYDATA.

The spare parts catalog is available in English only.
Spare Parts
For MYDATA SMD Placement Machines

MYDATAMYDATAFor a fast changing world
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Supplementary Software

MYDATA provides supplementary software that facilitates the programming 
work in TPSys.

This software may be mentioned somewhere in this manual but it will not be 
described here. Refer to the manual for the respective product.

CAD Conversion

CAD Conversion is a software package used to convert CAD files containing 
placement data to TPSys in order to use the data for component placing.

The CAD Conversion software package includes a comprehensive 
CADConversion, User’s Manual.

MYPlan

MYPlan is a Windows-based software developed for scheduling board 
assemblies in MYDATA placement machines. The purpose of the software is 
to provide the operator with appropriate loading instructions to increase the 
placement machine performance. MYPlan calculates the best possible 
solution to place the components under certain circumstances.

The MYPlan software package includes a comprehensive MYPlan, User’s 
Manual.

MYLabel

MYLabel keeps track of component carriers (tapes, sticks) used in production 
by using barcodes. MYLabel uses an identification barcode linked to a 
database with component names, quantities, and batch information. The 
database also contains component information, such as stock location and 
owner.

The MYLabel software package includes a comprehensive MYLabel, User’s 
Manual.

CAD Conversion

TPSysCAD

MYPlan

MYLabelMYLabel
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